APPLE MACINTOSH
User's Handbook

The only manual you'll ever need—
from the moment you plug in your computer
through set-up, operation, and maintenance

Weber Systems, Inc. Staff
Contents

Introduction and Acknowledgements 9

1. Overview of the Mac 11
   Introduction 11. Why is the Mac Different? 12. History of
   the Mac 15. The Typical Mac System 16. System Unit 16.
   Internal Circuitry 18. The Mac Microprocessor 18. Mac
   Memory 19. The Video Display 19. Disks and Disk Drives
   20. The Keyboard 22. The Mouse 23. The Imagewriter
   Printer 24. Optional Disk Drive 25. The Numeric Key Pad
   26. Macintosh Communications 26. Macintosh Software
   27.

2. Installation 31
   Unpacking 32. Installing Main Console 33. Installing the
   Keyboard 33. Installing the Mouse 34. Installing the
   Imagewriter Printer 36. The Numeric Keypad 40. Optional
   Second Disk Drive 40. Apple Modem 40.
3. Using the Finder


4. Disk Operations


5. Exploring MacWrite

6. Exploring MacPaint


7. More on MacPaint


8. Macintosh Communications

9. Troubleshooting and Operation Hints


Appendix A — ASCII Codes 311
Appendix B — Warning Boxes 313
Index 319
Macintosh™ User's Handbook is meant to serve as a tutorial as well as an on-going reference guide to the operation of the Apple® Macintosh. All of the Mac's many features are discussed including:

- Installation
- The Finder™
- Disks and Disk Drives
- The Font Mover™
- Disk Copy
- MacWrite™
- MacPaint™
- Communications
- MacTerminal™
- Troubleshooting

A number of examples are included with the text to illustrate the topics being discussed. Terms that may be unfamiliar to the reader will be presented in bold in the text. These terms will be defined in subsequent paragraphs.

Chapter one of this book is meant to serve as an introduction to the Macintosh. The chapter begins with a comparison of the Macintosh with the IBM® PC. Next appears a history of the Mac. The remainder of the chapter consists of a discussion
of the hardware and software comprising the the typical Mac system.

Chapter two is designed to provide step by step instructions to the installation of the system. This includes some of the optional peripheral equipment available for the Mac.

Chapter three describes the startup and use of the Mac’s visual operating system. The Desktop and the Finder are described in detail. This chapter lays the basic foundation for the operation of the entire Mac system.

Chapter four contains an in depth discussion of the Mac’s disks and disk drive. This chapter reviews the various techniques which will optimize the Mac’s data resources.

Chapters five, six, and seven discuss two important applications for the Mac, MacWrite and MacPaint. Each chapter uses one or more examples which the operator may use for hands-on learning.

Chapter eight is a discussion of Macintosh communications. It describes the means by which the operator may use the MacTerminal application to link the Mac to other information sources.

Chapter nine is designed to aid the operator in interpreting abnormal situations with the Mac. It also discusses more advanced operating techniques.

We have included two appendices in this book. Appendix A is listing of the ASCII codes which the Mac recognizes. Appendix B is a list of Warning boxes which the operator might encounter during normal operation. Interpretations accompany each box to help identify the conditions which might cause the warning.

We gratefully acknowledge Alain Rossman and Steve Hoyt of Apple’s Macintosh department for their help in obtaining technical information and software for us in a timely manner. We also thank the ComputerLand store in Mayfield Heights, Ohio for their patient assistance.
Overview of the Mac

Introduction

The Macintosh™ personal computer has been heralded by many individuals inside and outside of the personal computer industry as the most important development in the computer industry in the past several years. The Apple Computer Corporation is describing the machine as the forerunner of a new generation of personal computers. Many experts, however, have maintained that although the Mac is indeed different, it is not a forerunner of a new wave of personal computing. They maintain that the new devices incorporated in the Mac such as the mouse, the Desktop, and pull-down menus, are not significant productivity aids.
As to the ultimate answer, you will have to decide whether the Mac suits your needs better than more conventional computers such as the IBM PC®, Compaq® portable, Kaypro®, etc. In this chapter, as well as throughout much of the remainder of this book, we will attempt to provide an objective, unbiased view of the Mac. For those of you familiar with the more traditional personal computers, the difference between the Mac and these will be immediately apparent. For those of you not familiar with traditional computers, we have provided a brief discussion which contrasts the Mac and the IBM PC.

We will not attempt to carry this discussion through the remainder of this book. Therefore, if your purpose in reading this book is to gain information to help in making a purchase decision between the Mac and a traditional computer, we recommend that you do additional research on those traditional computers. We will attempt to provide the necessary information on the Mac.

Why is the Mac Different?

In order to operate conventional personal computers, the user must master that computer's operating system. An operating system can be defined as a group of programs which manage the overall operation of the computer.

The most popular personal computer operating systems to date have been MS-DOS® and CP/M®. Both of these could be described as literate operating systems. In this context, literate means the ability to read and write with comprehension. With a literate operating system, the user must have the ability to encode an operation into a written command. That command must be entered into the computer via the keyboard. After it has been entered, the computer will display the command. Here the user will generally read the command, checking it for accuracy. Once he or she is certain that the command
has been accurately entered, the user will execute the command. In many instances, the operating system then responds with its own written messages which must be answered by the user. In effect, a series of written messages controls the operation of the computer.

The Mac also has an operating system known as the **Finder™**. However, the Finder is a **visual** rather than a literate operating system. With the Finder, commands are entered by moving a pointer to a symbol or message on the Mac’s screen. Although some learning is required to master the Finder, this process is far easier than sifting through thick manuals filled with complex commands.

The difference between the Mac’s visual environment and a literate environment can best be illustrated with an example. Suppose that you owned an IBM PC computer, and you wanted to create a second copy of a text file named LETTER1.TXT on drive A with a new name. The following steps would be required to create that file and to check the disk to verify that fact:

1. Insert a diskette in drive A which contains the necessary DOS startup files and LETTER1.TXT.
2. Power on the IBM PC.
3. Enter the following command:  
   
   COPY LETTER1.TXT LETTER2.TXT
4. Enter DIR. The various files, including LETTER2.TXT, contained on the disk will be displayed.
To create a copy of a text* file on the Mac, the following steps would be required:

1. Power on the Mac.
2. Insert a startup disk containing LETTER1.TXT in the Mac’s drive. We will assume this disk was named Example Disk.
3. Open the Example Disk icon on the Desktop by moving the pointer to it and double-clicking the mouse button. Example Disk’s window will appear. The LETTER1.TXT document icon will be displayed in that window.
4. Select LETTER1.TXT by moving the pointer to it and clicking the mouse button.
5. Move the pointer to the File menu and pull down that menu. Indicate Duplicate by clicking the mouse button. A new icon named Copy of LETTER1.TXT will appear in the window.

Notice that approximately the same number of steps were required to perform the copy operation on both computers. Although the comparative number of steps required will vary according to the operation being performed, in our opinion, this copying operation was a fairly representative test.

As pointed out in this example, the major differences between the Mac and a conventional computer such as the IBM PC consist of how a task is accomplished. The IBM PC copying operation required the formulation and entry of a specific literate command:

```
COPY LETTER1.TXT LETTER2.TXT
```
On the other hand, with the Mac, the copying operation was performed by moving the pointer to various icons and file menus on the Desktop and selecting the desired items by clicking the mouse button.

The end-user must, of course, make the final decision as to which environment, visual or literate, he or she prefers. The probability is great, however, that the first-time computer user will find the Mac’s visual system easier to master than the IBM PC’s literate system.

**History of the Mac**

The concepts behind the Macintosh’s visual interface were initially developed at the Xerox Corporation’s Palo Alto Research Center. Xerox actually brought a machine to market in 1981 that incorporated these ideas, the Xerox Star®. However, the Star was not a large commercial success probably due to the fact that its cost was beyond the means of the average personal computer consumer.

In 1983, Apple® introduced the original Lisa™ model. The Lisa includes a visual interface similar to that used on the Mac. The original Lisa was subsequently modified and reintroduced in the spring of 1984 as the Lisa 2.

The main difference between the Mac and its predecessors, the Xerox Star and the Apple Lisa, is price. The Mac was the first personal computer introduced with a visual interface and with a price tag under $3000. The Mac’s relatively low price coupled with its efficient design and visual interface have resulted in it being a success in the marketplace.
The Typical Mac System

A typical Mac system might consist of the following items:

- System unit
- Keyboard
- Mouse
- Printer
- Extra disk drive
- Numeric keypad
- Modem
- System disk
- Language disk(s)
- Applications software disk(s)

The minimum requirements for a working Mac system consist of the following items:

- System unit
- Keyboard
- Mouse
- System disk
- Applications software disk

These are depicted in figure 1.1

In the following sections, we will describe the components of the basic Mac system as well as the devices and software that you will most likely wish to add to it.

SYSTEM UNIT

The system unit, as depicted in figure 1.2, is the heart of the Mac. It contains the Mac's electronic circuitry, a built-in disk drive for storing information, and a built-in 9 inch, high resolution monitor for displaying information.
Figure 1.1. Basic Mac system

Figure 1.2. Mac system unit (front view): a, monitor; b, disk drive; c, keyboard plug. (Rear view): a, on/off b, power cord plug; c, serial data ports
The system unit is surprisingly compact. It only requires a 10 inch by 10 inch desk or tabletop area and is only 13 1/2 inches high. With a weight of less than 23 pounds, the system is light as well as compact.

INTERNAL CIRCUITRY

Two circuit boards are installed inside the system unit. One board contains all of the Mac’s analog circuitry while the other board contains all of its digital circuitry.

Most personal computers contain four or more boards. By using only two boards, the Mac’s manufacturing cost was reduced and its reliability increased.

THE MAC MICROPROCESSOR

The heart of the Mac is the 68000 microprocessor. A microprocessor can be defined as a single chip which contains the logic of a central processing unit as well as any additional logic that must complement the CPU. The central processing unit, or CPU, is the heart of any computer. The CPU controls all of the other computer components.

Microprocessor logic is based upon the bit. A bit (or binary digit) is the basis of all information storage within the computer. A bit consists of a simple switch that can lie in either of the two binary states, on or off. Bits are often separated into groups of eight. These groups of eight bits are known as bytes. A byte is required to represent a single character (i.e. letter, number, or symbol). Generally, bytes are processed by the computer in groups of two.

The Motorola 68000 can process 32 bits internally at one time. This makes it more powerful than other microprocessors generally used in personal computers which, as a rule, can only process 16 or 8 bits internally.
Although the more powerful Lisa computer system uses the same microprocessor, the Mac processes data faster using a 7.83 MHz* clock as opposed to the Lisa’s 5 MHz clock.

**MAC MEMORY**

The Mac contains 128K of RAM memory and 64K of ROM memory. ROM stands for Read-Only Memory. ROM will hold the data stored in it permanently. If the power to the Mac is shut off, the information stored in ROM will remain there.

RAM stands for Random Access Memory. Any data stored in RAM will be lost when the Mac’s power is shut off.

**THE VIDEO DISPLAY**

In order to relay information back to the user, the Mac features a nine inch, high resolution cathode ray tube (CRT) display. Its high resolution is due to its 512 x 342 picture elements (pixels) giving a total of 175,104 individual dots on the screen. That works out to about 80 pixels per inch. The data for the display is stored in about 22K of the available RAM.

Instead of recognizing letters or words on the screen, the Mac displays information on a pixel by pixel basis relying on the application software to provide the proper lettering information. This helps reduce both the hardware and software needed for the CRT.

The display is black and white as opposed to the green or amber and black found on many other computers. Although there is some thought that the green or amber displays are easier on the eyes, the Mac’s high resolution screen is very easy to work with and causes no discernible eyestrain.

* 1 MHZ clock generates 1 million clock pulses per second.
DISKS AND DISK DRIVES

The disk drive is one of the most important parts of a computer. Disk drives allow the storage of large amounts of data. This data is actually stored on a disk (or diskette) which is read from or written to within the drive. The 3½ inch disk currently used with the Mac can store about 400,000 (or 400K) characters of data on one of its sides. Eventually, the disks used with the Mac will be expanded giving a total capacity of 800K. This is about 6½ times as much data as can be stored on 128K of RAM.

Unlike RAM storage, when information is stored on a disk, the information is not lost when the computer is turned off. In other words, disks offer a permanent means of storing data. Disk storage is not as permanent as ROM data storage, however, since a computer can alter the data on a disk whereas a ROM cannot be altered without destroying it.*

A disk stores data in a magnetic form much like data is stored on magnetic tape. The main difference between storage on a magnetic tape and storage on a disk is that the disk allows data to be accessed more quickly.

The disk drive contains a device known as a read/write head, which is used to read and write information. The computer can move the head to any position desired on the disk surface. This is in contrast to magnetic tape, where data is read from or written onto the tape in consecutive order.

Consider the difference between an audio cassette tape and a phonograph record. In order to locate a song on the cassette, you must wind through the tape to the appropriate place. With magnetic tape, the computer must wind through the tape until it finds the information it needs. This is known as sequential access. On the other hand, with the phonograph record, you simply jump ahead to the desired position. Similarly, with a magnetic disk, the computer just advances

* With the exception of PROM's (programmable ROM).
Overview of the Mac

21
directly to the desired spot to access information. This is called random access.

The Mac uses a floppy disk drive. A second type of disk drive known as the Winchester fixed disk is also available on many personal computers. Winchester disk drives are designed so that from six to twelve times more data can be stored on their surface than on a standard floppy diskette. Fixed disks are more durable than floppy disks because they are made of a hard, inflexible material. Winchester disks must be kept very clean as they are extremely vulnerable to dust, dirt, and smoke.

Since they must be kept so clean, Winchester disks must be sealed inside of the disk drive. This means that Winchester disks cannot be changed unless they are installed in sealed cartridges.

Floppy disk systems are often used in conjunction with Winchester disks to allow for back-up storage. A Winchester drive is shown in figure 1.3.

Figure 1.3. Winchester disk system
Apple does not offer a Winchester drive with the Mac*. However, Apple has announced that their new Lisa 2** models will be offered with 5MB*** and 10MB of fixed disk storage. If you desire additional disk storage, you should examine the Lisa 2/5 (5MB) and Lisa 2/10 (10MB). Also, independent vendors such as Tecmar have announced Winchester disk add-ons for the Mac.

**THE KEYBOARD**

The keyboard unit consists of a standard, 58 key, full travel, typewriter style keyboard. The keyboard unit is connected to the main console via a coiled, telephone style cord. This feature allows the keyboard to be moved to a convenient location within five feet of the Mac without moving the entire computer.

The keyboard operates in much the same way as a normal typewriter keyboard. It features all the standard keys with some minor additions. These additions serve to help operate special functions on the Mac. In place of the Shift Lock key provided on most typewriters, the Mac keyboard has a key labeled Caps Lock. This key operates as a shift for the letters on the keyboard giving capital letters, but for all other characters, it has no effect. In order to type the alternate characters, you must press the Shift key.

The Command (@), Option, and Enter keys are located to the left and right of the space bar. Their functions are explained in detail on page 47 of chapter 3 and page 143 of chapter 5.

---

* This may, however, be a future development.

** At the time of this writing, Apple has announced that the Lisa 2 series will be compatible with the Macintosh.

*** MB is an abbreviation for megabyte. 1MB is equal to 1 million bytes.
THE MOUSE

The mouse, as shown in figure 1.4, is a combination pointing device and signaling device. The mouse can be used as a pointing device by sliding it over the work surface. The mouse operates using a small rubber ball which rotates within its socket as the mouse moves across the table. The ball turns two rotating vanes which interrupt light beams. These light beams operate light sensitive transistors which send signals to the Mac through the attached electrical connection. The pointer on the Mac's screen will move relative to the movement of the mouse on the work surface. This is depicted in figure 1.5.

The mouse can be used as a signaling device by clicking the mouse button. The mouse is generally used as a signaling device when some piece of information is being selected. This process will be discussed in chapter 3.

**Figure 1.4.** The Macintosh mouse. *a*, mouse button
THE IMAGEWRITER PRINTER

The Imagewriter® printer is a serial interface, dot matrix type printer designed for use with the Apple Lisa and Apple Macintosh computers. Serial interface devices receive each bit of data sequentially instead of byte by byte as with parallel devices. This method of data transfer allows a simpler design for the computer while sacrificing little in terms of speed. The printer has its own microprocessor as well as 1K byte of memory so that it can accept part of the computing burden from the computer.

The dot matrix printing technique operates in the following manner. The print head on the Imagewriter contains a series of dot points which operate much like pencil points. These dots are arranged in a matrix 16 wide by 9 high. When printing, the printer begins each line by placing the print head

Figure 1.5. Using the mouse as a pointing device
over the beginning of the line and striking the page through the typewriter ribbon. When the operation is complete, the print head moves on to the next position on the page. Each time a dot passes over a position to be printed, the pencil point shoots out and strikes the paper.

The Imagewriter was designed to print one character within the print head space, but the Mac uses it differently treating each dot on the print head as if it were a pixel on the screen. This way, the printer can print lettering of any size.

Another design feature of the Imagewriter is its ability to accommodate both single sheet and tractor-fed paper. This allows the user to print letters on his or her company's letterhead or to print long reports without constantly inserting paper.

**OPTIONAL DISK DRIVE**

The Mac features two serial ports on its back panel which can be used to connect the Mac to various peripheral devices. One of those optional devices is the optional disk drive. The disk drive available from Apple is constructed like the internal disk drive provided on the basic unit. It uses a serial data bus as does the printer.

The advantage to having an extra disk drive connected to your Mac is that it allows easier data handling when two disks are involved in an operation. This happens quite often since more than two-thirds of a disk can be taken up by the operating system, applications software, and other essential files leaving little space for text files.

Most Mac applications create text files which can occupy a sizable amount of space. Since the Mac's internal memory is relatively small*, it must refer to the disks often when performing various operations. When two disks are involved, these

* We are assuming 128K. This may be expanded at some future date.
operations can require as many as ten disk swaps. This can cause undo wear and tear on the disks causing them to age prematurely. In fact, we feel that the optional second disk drive is essential to normal operation of the Mac.

**THE NUMERIC KEY PAD**

Another optional unit available for the Mac is the numeric key pad. It plugs directly into the keyboard. The numeric key pad allows easier entry of pure numeric data into a text file. This option features a standard numeric key pattern along with direction arrows for maneuvering about a document. It can substitute for the keyboard when using Macintosh applications.

**MACINTOSH COMMUNICATIONS**

In order to connect the Mac to other data processing machines through phone lines, Apple has provided for the addition of an optional modem. Modems are available in 300 baud* and 300/1200 baud models. Although Apple distributes the standard modem for the Mac, other companies manufacture compatible modems as well.

A software package called MacTerminal is due to be released in mid 1984 which will allow the Mac to use the modem to communicate. The program will feature automatic dialing and answering and will operate with touch-tone and rotary dial systems. Communications will be possible with other computers as well as many of the various data services which operate around the world.

* One baud is about one bit per second data transfer.
MACINTOSH SOFTWARE

The types of files stored on a diskette is a potentially confusing issue. It is important to realize the differences among the three types of files: system files, application files, and documents. The system files are a set of programs that manage the overall operation of the computer. The tasks involved in this system management include:

- System startup
- System file maintenance
- User disk file maintenance
- Application opening routines
- Peripheral device control

Whenever the computer is powered on, a diskette that contains the system files (usually called a system diskette) must be inserted in the disk drive. A diskette that does not contain these files will not be able to start up the system.

System programs are executed automatically by the computer system. As a result, it is not necessary for an operator to understand exactly how the system programs are used or what they are used for. The computer manipulates these programs as necessary, only when they are needed.

The second category of files is called application files or simply applications. These types of files are used to perform specific functions with the computer. Applications differ from system programs in the fact that an application cannot be used unless the system programs are already active. Also, applications are only executed when the operator requests them. Unlike system programs, applications are not directly under the control of the computer. Word processors, graphics programs, games, and financial record programs are all examples of applications.

BASIC, Pascal, FORTRAN, and C are examples of high-level programming languages. A high-level programming language enables its user to write a program using near-English
terminology. This contrasts to low-level assembly and machine languages in which numbers and mnemonics are used to communicate instructions to the microprocessor. At the time of writing of this book, no high-level programming languages were available from Apple* for use on the Mac. Apple is presently in the process of writing two such programs, Macintosh BASIC, and Macintosh Pascal. These languages will differ from those normally used in that they will rely heavily upon the visual interface concept of the Mac.

The final category of files is documents. These types of files do not contain programs, so they are never executed in the sense that a system or application file is executed. Instead, documents contain information that an application program needs in order to execute properly. For example, the MacWrite™ word processor is considered an application, but a file that contains a memo or letter is considered a document. Similarly, the MacPaint™ graphics program is considered an application, but a file that contains a specific illustration is called a document.

In light of the different types of files, the operation of the computer can be summarized as follows. When the computer is powered on, be sure that a set of system programs is available to start up the system and maintain its operation. Next, activate an application program that performs the desired task. Finally, access the document that contains the information to be processed. Some applications do not require the use of documents, so this step is not always necessary. If a new document is to be created, it is not necessary to load an existing document. Each application that uses documents contains provisions for creating new documents.

The icons used to represent the commonly used types of files are depicted in figure 1.8.

* Microsoft Corp. has released a version of BASIC for the Mac.
Figure 1.8. Icons. a, Diskette; b, Folder; c, System; d, MacWrite applications; e, MacWrite document; f, MacPaint applications; g, MacPaint document
Installation

Introduction

Now that we have looked at the Mac computer system, we are ready to set up the physical components or hardware. To start with we will assume that you have purchased a basic Mac system. We will, therefore, discuss the optional units, the second disk drive and the numeric key pad, only in minor detail.

Assembly of the Mac requires only a few minutes. Even the first time computer user can easily assemble the system. It is nearly impossible to improperly connect the cables on the Mac. Most plugs fit only in their appropriate sockets. The owner should, however, be careful not to drop any of the Mac’s parts. Although they are designed to be quite durable, they will not tolerate excessive abuse. Be especially careful of the main system console. The CRT display located inside the console will explode if it is broken.
Installation

The installation of the Mac is simple and straightforward. Since the basic system has only three components, it only takes a few minutes to make the proper connections between the devices. This section provides instructions for the installation of the main Mac components as well as the Imagewriter printer.

CHOOSING A LOCATION

The installation of a computer system begins with the selection of a suitable location for the equipment. The computer system must be located on a firm surface near an electrical outlet. The equipment should be located in an area where the computer will not be exposed to any sort of hazard. A computer system should never be exposed to dust, intense heat or humidity, intense cold, or direct sunlight. The electronic components within the computer generate a moderate amount of heat during normal operation. Therefore, do not place the computer at a location where ventilation is restricted.

A computer system should not share an electrical outlet with heavy equipment or be powered by an outlet controlled by a wall switch. These types of situations often cause electrical disturbances that can seriously disrupt the operation of the system.

UNPACKING

Proceed with the installation of the system by unpacking the components. All of the following parts should be included with the system. If all of these parts cannot be located, contact your dealer as soon as possible.
Installation

• Main console
• Keyboard unit
• Mouse
• Keyboard cable
• Power cord
• Manual

INSTALLING MAIN CONSOLE

Place the main console on a desk or tabletop near an electrical outlet. Remove the power cord from its box and insert the end into the receptacle in the back of the main console. The appropriate receptacle has the marking of a wave (〜) to symbolize a standard A.C. power supply. Insert the other end in a three conductor, grounded outlet. The Mac may be operated on 50 or 60 Hz voltages from 105 to 125 VAC. The Mac is intended to be operated with a grounded electrical system ONLY! If a three conductor outlet is not available, use an appropriate adapter and be sure that the ground wire is properly connected.

INSTALLING THE KEYBOARD

Choose a suitable location for the keyboard near the main console. The keyboard should be located close enough to the main console so the video display can be easily viewed while working at the keyboard. Use the coiled, telephone style cord to connect the keyboard to the console. This cord allows the keyboard to be moved anywhere within about five feet of the console. Figure 2.1 depicts the proper installation of the keyboard.
Figure 2.1. Keyboard installation

Although the coiled cord is similar to a telephone handset cord, never use an ordinary telephone cord with the Mac keyboard unit.

INSTALLING THE MOUSE

Installation of the mouse is simple and straightforward. Begin by selecting a clean, flat, smooth surface where the mouse can be easily manipulated. Avoid using the mouse in areas where dust or dirt accumulate. The installation of the mouse is depicted in figure 2.2.
As with all computer equipment, protect the mouse from excessive heat, cold, moisture, or sunlight. It is usually a good practice not to eat or drink in the vicinity of the computer system.

The plug on the end of the mouse cord is accommodated by the receptacle in the lower left corner of the main console back panel. The receptacle is denoted by a small picture of the mouse. Hold the plug with the Apple logo facing upward and press the plug into the receptacle. The plug is supplied with two screws to securely fasten the plug into position. The screws have large knobs attached that allow these to be tightened without the use of any tools.
INSTALLING THE IMAGEWRITER PRINTER

The ImageWriter printer, like the main console, requires a three conductor, grounded electrical outlet. Once again, be sure that the equipment is properly grounded before using it. The power cord plugs directly into the back of the printer at the lower right-hand side. The receptacle is labeled with a wave (~) to indicate a standard electrical outlet.

The larger connector on the printer interface cable supplied with the printer should be connected to the receptacle on the lower left side of the back of the printer. The receptacle is similar to the mouse connectors, but about twice as large. Be sure that the plug is properly aligned with the receptacle before forcing the plug into position. An improperly aligned connection can damage the plug as well as the receptacle. Tighten the fastening screws to secure the connection.

The smaller plug on the printer cable should be connected to the main computer console. The appropriate receptacle is labeled with a picture of a printer. Once again, observe the proper alignment of the connectors and tighten the fastening screws to secure the connection.

The proper installation of the printer is outlined in detail in the printer manual. Follow these instructions carefully and review the installation with the following guidelines.

Be sure that all packing material has been removed from the printer. The printer is carefully packaged at the factory to protect it during shipping. However, all packing material must be removed to ensure proper operation of the printer. It is usually a good practice to save the packing materials in case the printer needs to be shipped or stored in the future.

Before operating the printer, the ribbon cartridge must be properly installed. The ribbon cartridge snaps into place on the carriage assembly. Figure 2.3 shows the proper installation of a ribbon cartridge. Note that the ribbon must be aligned in front of the print head.
The tension on the ribbon can be adjusted by rotating the ribbon advance knob clockwise. Do not attempt to rotate the knob in the other direction. Also, be sure that both of the cartridge fasteners are in place before attempting to operate the printer.

The Imagewriter printer can be operated with two types of paper. The first type of paper is called pin feed or tractor feed. This type of paper has holes along the edges that allow the paper to be pulled through the printer by sprockets. Many types of paper, labels, invoices, and other types of forms are available in pin feed format. The Imagewriter can also be used with standard paper and forms. The printer has a friction feed system that allows paper to be pulled through by pinching it between two rollers. This type of paper feed is similar to that used in most typewriters.
The release lever to the left of the platen determines which type of paper feed system is to be used. Figure 2.4 shows the location of the release lever. When the lever is forward, the friction feed system is engaged. When the lever is back, the friction feed system is disengaged, and the pin feed system can be used exclusively.

The locations for the sprockets of the pin feed system can be adjusted to accommodate paper or forms with any width between 4 and 10½ inches. The back cover panel of the printer encloses the pin feed mechanism. To move the sprockets, remove the cover and locate the white release levers (see figure 2.5). Pushing the levers toward the back of the printer releases the sprockets and allows them to be moved. Once the correct configuration has been established, lock the sprockets in place by pushing the release levers forward.

The sprockets are equipped with paper clamps that keep the paper securely in position. These clamps can be released by simply lifting upward on the inside edge of the clamp. The clamps can be secured once again by pressing downward until they snap into position.

The friction feed system is used in the same manner as a typical typewriter. When the paper release lever is forward, simply insert a sheet of paper behind the platen and use the paper advance knob on the side of the printer to advance the paper to an appropriate position. The paper release lever can be used to allow the paper to be straightened after it has been inserted into the printer.
Figure 2.4. Paper release lever

Figure 2.5. Pin feed mechanism. *a*, sprockets; *b*, sprocket release levers; *c*, paper clamp
THE NUMERIC KEYPAD

The optional numeric keypad is installed in a manner similar to the keyboard. Follow the directions accompanying the unit. Connect the unit to the Mac. Then connect the keyboard to the numeric keypad. The keyboard should operate normally. The keypad will substitute for the keyboard when entering numbers.

OPTIONAL SECOND DISK DRIVE

To install the optional second disk drive, locate the serial interface connection on the back of the Mac. It is identified by the small image of a disk drive etched into the plastic directly above the socket. Find the cable which should have accompanied the disk drive and press the end of the cable with the large knobs into the socket. As with all other Mac connections, be certain that the connector pins are correctly aligned before attempting to insert the plug. The large knobs on the plug, like those on the mouse cable, are designed for ease of installation.

There is no need for a separate power connection for the disk drive. The Mac will control the unit completely and supply its power. To operate the second disk drive, simply insert a disk into it. The Mac will recognize the disk and its origin. The unit will aid greatly in multi-disk operations. When using the unit as a data disk for applications, be certain that the disk is inserted before trying to call on it. If it is not in place, the Mac will assume that the disk is to go into the main disk drive, and it will eject the applications disk.

APPLE MODEM

The Apple modem is used to establish communications with other data processing units through telephone lines. Unpack the modem and place it near the Mac. Locate the
cables which came with the unit. There should be a power cable, a serial interface cable with 9-pin connectors, and a modular telephone cable.

Be sure that the Mac is turned off. The modem should be turned off if it has been plugged in. If not, plug it into a grounded electrical outlet. If you use the Mac, the printer, and the modem, you will need to find three separate outlets in order to utilize all three units at once. If you use a multi-plug adapter, be certain that it is a good quality unit and provides a secure ground. Do not overload the circuit. The power requirements for all Macintosh units are listed on the rear panels of those units. Although they do not require very much power, they may overload the circuit when placed on the same receptacle as other appliances. The Mac alone uses about as much power as a 60 watt light bulb.

Locate the serial modem connection on the rear panel of the Macintosh. It is identified by an image of a telephone handset etched into the plastic. Insert one end of the data cable into the Mac’s receptacle. As always, be careful of the pin alignment. Insert the other end into the serial port on the rear panel of the modem. Use a screw driver to tighten the lock-down screws on the connectors. Under a special configuration, the modem may be connected to the printer serial port. Details regarding this appear on page 272 of chapter 8.

There are several possibilities for the connection with the telephone line. If you plan to connect the modem in conjunction with an existing telephone, simply unplug the modular cable for that phone and plug it into one of the modular sockets on the modem’s rear panel. Then connect the telephone to the remaining modular socket using the telephone cable accompanying the modem. The modem unit is designed to allow the telephone to rest upon it. See figure 2.6 for the proper connections with this configuration.
Figure 2.6. Connecting the modem with a telephone.

The telephone in the above described procedure is optional. Its connection is simply for the operator’s convenience. It does not play a part in the modem’s operation. You may connect the modem to the wall receptacle using any approved modular style telephone cord. In any case, the modem can be permanently attached to the telephone system. When not in use, the modem will act like a telephone extension which is hung up. It should not interfere with normal telephone business.

If you utilize another type of modem, follow the installation instructions which came with that unit. The general procedure remains the same. The modem will require a separate power connection, a data connection with the Mac, and a telephone connection. Some modems come with a power converter which changes the standard outlet voltage to a voltage specified for that modem. These non-Apple modems may require special cable adapters to interface with the Mac.
Using the Finder

Introduction

In chapter 1, we gained an overview of the Mac and its peripherals. In chapter 2, we installed the Mac. We are now ready to learn how to use the Mac. We will begin learning the Mac by exploring the System Disk.* The System Disk is provided with the Mac and is used to start-up the Mac. By copying some of the contents of the System Disk to other diskettes, these diskettes can also be used to start-up the Mac. Diskettes which can be used to start-up the Mac are known as start-up diskettes. We will explain how to create start-up diskettes in chapter 4.

* We will use the terms disk and diskette interchangeably in this book.
Power-On

The first step in exploring the System Diskette is to power on the Mac. This is accomplished by pressing the power switch located on the rear of the system unit to the I or On position. The power switch is shown in figure 1.2. When the Mac is powered on, the screen will appear as depicted in figure 3.1. The flashing question mark (?) is meant as a reminder to the operator that a diskette should be installed. Since we are going to explore the System Disk, let's locate and insert that disk.

The System Diskette, as any other Mac diskette, has a rectangular metal bar on its top side and an identical metal bar and a metal ring on its bottom side. The metal ring is actually a part of the disk surface. It protrudes through an opening in the plastic cover which protects the diskette surface. The 3½ inch diskettes used with the Mac are pictured in figure 1.1.

Figure 3.1. Mac display screen upon power on
Diskettes should be inserted into the disk drive with the top side (the side without the metal ring in the center) facing up. The edge with the rectangular metal bar should be inserted into the disk drive. If you are inserting the disk properly, you should notice a small arrow on the disk surface to the left of the metal bar. This arrow should be pointing towards the Mac's disk drive. The proper procedure for inserting a disk into a Mac disk drive is shown in figure 3.2.

Figure 3.2. Inserting the System Diskette

Once we have inserted the System Disk, the Mac will begin emitting a series of sounds and the image on the screen will turn into a smiling face.

A series of screen displays will then appear. The first will include the message "Welcome to Macintosh." This display will be replaced by that depicted in figure 3.3. The menu portion will appear first, followed by the System Disk and Trash icons.
An icon is a graphic symbol used by the Mac to represent either a physical object or a non-physical concept. In our initial display, the System Disk icon represents a physical object. The Trash icon represents a concept -- in this case, an imaginary location in which to dispense of information which is no longer needed.

The display depicted in figure 3.3 is known as the Desktop. The Desktop is the Mac's work area. The Desktop consists of the white menu bar and the gray desk surface. The Mac's desk surface can be used as would an actual desk. Objects can be placed on the desk surface, moved about the desk surface, and removed from the desk surface. We will see how to work with the Desktop later in this chapter.
The Keyboard

The Mac keyboard resembles a typewriter keyboard in most respects. All letters, numbers, and special characters appear in their usual places. The term “Caps Lock” replaces the usual “Shift Lock” but performs the same function for alphabetic characters. The exceptions are the keys surrounding the space bar:

- Option
- Command (⌘)
- Enter

The Command key is used in conjunction with specified characters as a substitute for the mouse. Many of the menu options appear accompanied by the Command symbol and a letter. Pressing the key while typing the letter will cause the same result as selection with the mouse.

The Enter key is used in special cases to enter computer instructions while using certain Mac applications. In most cases it has no effect.

The Option key helps expand the scope of the keyboard to include many commonly used scientific, foreign, and punctuation characters, in addition to many special symbols not included on the regular keyboard. The Key Caps option allows the operator to display these symbols for review. The Option and Option with Shift characters appear in figure 3.4 and 3.5. Some characters may not be available with all fonts.
Figure 3.4. Optional characters

Figure 3.5. Optional characters (with shift)
Ejecting the System Diskette

Now that we know how to insert the System Diskette, let's learn how to eject it. There are two methods for doing so. One way is by pressing the Command key simultaneously with the E key. The Command key is located to the immediate left of the space bar. Its key top is inscribed with the symbol `⌘`.

In order to learn the second method of ejecting a diskette, we will first need to understand how to use the mouse. The mouse controls the arrow shaped pointer on the Desktop surface. The pointer can be moved by sliding the mouse across the working surface. Try sliding the mouse to the left. The pointer should also move to the left. If the mouse is slid to the right, the pointer will also move to the right. Notice that the pointer cannot be moved off of the Desktop surface.

Move the mouse so that the pointer is positioned on the word “File” in the menu bar. Be certain the tip of the arrow is positioned in the white margin near the word “File.” Then press the mouse button. The Desktop surface should appear as shown in figure 3.6. Notice that the contents of the File menu are displayed on the Desktop. The procedure we have just undertaken is known as pulling down the File menu.

While pressing the mouse button, move the mouse so that the arrow is pointing to Eject in the File menu. Then release the mouse button. The System Disk will be ejected.

Notice that certain menu selections are displayed in black while others are displayed in gray. Only those in black can be chosen. We will discuss this in more detail later in this chapter.

If you pull down a menu and subsequently decide not to select an item from it, you can exit this situation either by moving the pointer outside of the area containing the selections and releasing the mouse button or by moving the pointer back to File in the menu bar and releasing the mouse button.
You may have run out of room to maneuver your mouse in the last exercise. You can solve this problem by picking up the mouse and moving it to a new location on your working surface. Notice that when you pick up the mouse and move it, the arrow on the Desktop remains in the same position.

Icons

So far we have examined only two icons, the System Disk icon and the Trash icon. Five general types of icons are used by the Mac. These are:

- Disk icons
- Applications program icons
- Document icons
- Folder icons
- Mini-Mac icons
The symbols for these icons are depicted in figure 3.7.

Disk icons are used to represent the contents of a disk. The System Disk icon is an example. Applications program icons are used to represent an applications program used by the Mac. The Font Mover™ icon is an example. Document icons are used to store documents created by applications programs. We will encounter documents when we begin using MacWrite and MacPaint. Folder icons can be used to store applications programs and/or documents. A special folder, the System Folder, is used to hold system programs that the Mac requires in order to operate. These systems programs are represented with the Mini-Mac icon.

![Figure 3.7. Icon symbols](image)

Figure 3.7. Icon symbols

**SELECTING AN ICON**

Selecting an icon can be defined as designating it for some subsequent action. No action can be undertaken with an icon unless it has first been selected.
The icons currently selected are displayed in black on the Desktop surface. Notice from the Desktop that the System Disk icon is selected. An icon can be deselected by moving the pointer outside the icon and pressing the mouse button. Try this. The Desktop should resemble that shown in figure 3.8.

To select an icon, move the pointer onto that icon and press the mouse button. Experiment by selecting and deselecting the Trash icon.

Two or more icons can be selected simultaneously. This is accomplished by using the mouse to surround the icons to be selected with a rectangle. This procedure is best learned with an example. Assuming both the System Disk and Trash icons have been deselected, move the pointer just above and to the left of the System Disk icon. Press the mouse button and hold it down. Move the pointer to the right until it is positioned just beyond the System Disk icon.

Notice that a line is displayed on the screen which traces the pointer's path. Move the pointer down along the screen's right edge until it is located just beneath the Trash icon. Notice that a rectangle is drawn on the Desktop surrounding both icons. This is depicted in figure 3.9. Finally, release the mouse button. Both the System Disk and Trash icons will have been selected.

* Several icons can be selected simultaneously.
Figure 3.8. Desktop with System Disk icon deselected

Figure 3.9. Selecting two or more icons
MOVING AN ICON

As we mentioned earlier, icons can be moved about the Desktop, just as objects can be moved about an actual desk. To move an icon, position the pointer within the icon and press the mouse button. While holding the mouse button, move the pointer about the Desktop surface. Notice that an outline of the icon moves with the pointer. This is depicted in figure 3.10. When the mouse button is released, the icon will move from its original position to the position indicated by the outline. The procedure just described is known as dragging the icon.

Figure 3.10. Moving an icon on the desktop
OPENING AND CLOSING AN ICON

Generally, when an icon is opened, its contents are displayed on the Desktop in a rectangle known as a window. A window is depicted in figure 3.11. The window contents are known collectively as the icon's directory. The term directory is also used with many standard computer operating systems to describe a listing of the files resident on a diskette.

An icon can be opened in two different ways. We will describe each method. We'll term the first method "File menu open," as it involves using the Open selection in the File menu. The first step is to select the icon to be opened. For our purposes, we will select the System Disk icon. Then, position the pointer to File in the white menu bar above the Desktop.

![Image of System Disk icon with a window]

Figure 3.11. Opening the System Disk icon
Press the mouse button. The File menu will be displayed just as it was when we wanted to eject the System Disk. Move the pointer to Open in the File menu, and release the mouse button. An outline will leap out of the icon and fill the left side of the screen as a window.

Notice that the System Disk icon is no longer black, but is hollow. This indicates that it is open.

Now that we have opened the System Disk icon, let's close it. There are two methods for closing an icon. We will term the method described here as “File menu close,” as we will again be using the File menu. The method is simple. Pull down the File menu, indicate Close, and release the mouse button. The window will disappear from the screen and leap back into the System Disk icon.

Now that the System Disk icon has been closed, it can be reopened using the second method for opening an icon. Since this method involves clicking the mouse button, we will term it “Clicking an icon open.” Clicking can be defined as pressing and releasing the mouse button.

First, let's de-select the System Disk icon by moving the pointer outside it and clicking the mouse button. Next, move the pointer inside of the System Disk icon and press the mouse button twice. This is known as double clicking. If nothing happened, you probably did not press the button quickly enough the second time. Try again. The Desktop should resemble figure 3.11.

Close the System Disk icon using the File menu close method. Notice that the System Disk icon is selected. Position the pointer on the System Disk icon and click the mouse button twice. Again, the System Disk icon will be opened.

We are now ready to learn the second method for closing an icon. In this method, the pointer is moved to a small square in the window's title bar known as the close box. This is shown in figure 3.12. When the pointer is positioned within the close box, click the mouse button. The window will jump back into the System Disk icon.
CHANGING AN ICON'S NAME

An icon must be selected in order to change its name. To change the selected icon's name, position the pointer to the location where the changes are to be made. Notice that the pointer changes from an arrow the symbol, \( \chi \). This symbol indicates that text can be entered at the indicated position on the Desktop.

If the mouse button is pressed, a blinking vertical bar will appear underneath the \( \chi \). This bar represents the **insertion point**, which can be defined as the point where keyboard entries will be added to text. Next, move the mouse so as to remove the \( \chi \) pointer. Text can now be added via the keyboard. Existing text can be erased by positioning the blinking insertion point after the character to be removed and pressing the Backspace key.

The Edit menu commands can also be used to change an icon's name. These will be discussed later in this chapter.

![System Disk icon window](image-url)

**Figure 3.12.** System Disk icon window
Windows

As evidenced in the last section, when an icon is opened, a window is often displayed on the Desktop. As we saw earlier, a window can be used to view the contents of an icon. Windows can be moved around the Desktop, their contents can be edited or scrolled through, and their size can be changed. We will discuss these various operations using the window created by opening the System Disk icon. This window is depicted in figures 3.11 and 3.12.

EXAMINING THE WINDOW

Examine the illustration of a window in figure 3.12. The bar along the top of the window is known as the title bar. The title bar includes the close box, the title of the icon which the window is referencing, and an optional group of six parallel horizontal lines.

We will refer to these as active window lines. They indicate which window is active. The Mac allows more than one window to be displayed on the Desktop at the same time. When more than one window is displayed, the Mac needs to know which one the user is working with. This window is known as the active window. When an icon is opened, it automatically becomes the active window. We will discuss the procedure for changing a window’s status to active later in this chapter.

The bar immediately below the title bar displays information pertaining to the icon. In the System Disk icon example, we see that two items are stored in the icon; these items occupy 235K of disk space; and 164K of disk space is available.

The main portion of the window is used to display the icons stored in the icon that is open. From our example, we can see that the System Folder, Empty Folder, and Font Mover icons are stored in the System Disk icon.
The size box is located at the bottom right-hand corner of the window. As will be shown later in this chapter, the size box can be used to change the window's size. This has no bearing on the quantity of information which can be stored in a window's directory.

The shaded bars with arrows at either end located on the bottom and right-hand side of the window are used to scroll through the window. In many instances, especially when working with document files, all of the information contained in an icon cannot be displayed in a window. The scroll bars allow the window to display different portions of the icon.

**CHANGING THE ACTIVE WINDOW**

As we can see from figure 3.11, when the System Disk icon is opened, its window is initially active. Notice that the active window lines are displayed in the System Disk window's title bar. Let's open the System Folder and Empty Folder icons as well. Our Desktop will resemble that depicted in figure 3.13.

Since the Empty Folder icon was opened last, it is currently active. We can change the active window by moving the pointer inside of the window we wish to be active and clicking the mouse button. Move the pointer inside the System Folder window and click the mouse button. As shown in figure 3.14, the System Folder window is now active.
Figure 3.13. Desktop with System Disk, System Folder, and Empty Folder icons open

Figure 3.14. Desktop with System Folder window active
Notice from figures 3.13 and 3.14, that the active window is frontmost on the Desktop. If we close the active window, the next window behind the frontmost window will become the active window.*

Try this by opening the following icons in order:

- System Disk
- System Folder
- Trash

The Desktop will resemble that depicted in figure 3.15.

By closing these icons in the following order,

- Trash
- System Folder

we can see that the window behind the frontmost window is made active when the frontmost window is closed.

* This is true in most cases.
MOVING THE WINDOW

A window can be moved around the Desktop by following these steps:

- Position the pointer within the window's title bar.
- Press the mouse button.
- Move the mouse. An outline of the window will follow.
- Release the mouse button. The window will jump inside the outline.

CHANGING THE WINDOW'S SIZE

The size box at the window's lower right-hand corner is used to change its size. The procedure for changing the window's size is as follows:

- Position the pointer inside the size box.
- Press the mouse button.
- Expand or contract the outline of the window by moving the mouse.
- Release the mouse button. The expanded or contracted window will jump into the outline.

SCROLLING

Scrolling can be defined as moving a document or a directory within the window so that its different areas can be examined. The scroll bar along the bottom and right-hand side of the window can be used to scroll. The small white box along the scroll bar represents the current portion being displayed.

To illustrate the use of the scroll bar, open the System Disk and System Folder icons. Then, rearrange the Note Pad, Clipboard, and Scrapbook icons so that they are directly beneath the System, Finder, and Imagewriter icons, respectively. Finally, use the size box to reduce the size of the System
Folder window. The Desktop should resemble that depicted in figure 3.16.

The Mac allows three methods of scrolling. We will refer to these as:

- Scroll by line
- Scroll by window
- Dragging the scroll box

In the scroll by line method, scrolling can be accomplished slowly, line-by-line, by clicking the mouse button. The pointer should be positioned within the scroll arrow which indicates the direction in which the scrolling is to occur. As the mouse button is pressed, the information displayed in the window will be scrolled in the direction indicated. Figure 3.17 illustrates the scroll by line method.

![Figure 3.16. Initial Desktop prior to scrolling](image-url)
Figure 3.17. Scroll by line
In the scroll by window method, the window can be scrolled to the end of the document or directory. The pointer should be positioned in the gray area on the scroll bar.

If the pointer is being positioned on the scroll bar at the bottom of the window, and it is positioned to the left of the scroll box, scrolling will occur to the left edge of the document or directory. Positioning the pointer to the right of the scroll box results in scrolling to the right edge.

If the pointer is being positioned on the scroll bar at the right-hand edge of the window, and it is positioned above the scroll box, scrolling will occur to the top edge of the directory or document. Positioning the pointer below the scroll box results in scrolling to the bottom of the directory or document. An example of scrolling by window is shown in figure 3.18.

![Scrolling by window](image)

**Figure 3.18.** Scrolling by window
Figure 3.18 (cont.) Scrolling by window

Dragging the scroll box allows the user to scroll to a specific portion of the document or directory. In this method, the scroll bar represents the length of the directory or document. By moving the scroll box to the middle of the scroll bar, the middle portion of the document will be displayed. The scroll box is positioned by dragging it with the pointer. An example of dragging the scroll box is contained in figure 3.19.
Using the Finder 67

Figure 3.19. Dragging the scroll box
Menus

So far, we have learned quite a bit about the Desktop displayed when the System Disk is inserted. We have learned about icons and windows, and we briefly examined the File menu. We will conclude our examination of the System Disk and the Desktop by examining the various menu options available in the menu bar.

APPLE MENU

The Apple menu is indicated by the ® symbol in the menu bar. The Apple menu can be pulled down by pointing to the ® and pressing the mouse button. The Apple menu will appear as shown in figure 3.20.

The first Apple menu selection, About the Finder, can be used to display the version number of the Finder. The remaining menu selections indicate the various Desktop Accessories. These will be explained in the final portion of this chapter.

Figure 3.20. Apple menu
FILE MENU

We have already seen how the File menu can be pulled down and Open and Close selected from it to open and close icons. Now, we are ready to examine the other File menu commands.

First of all, notice that certain menu commands are highlighted, while others are dimmed. The highlighted commands can be selected, while the dimmed commands cannot be selected. The various combinations of dimmed and highlighted commands will be determined by the icon(s) currently highlighted. If the icons selected disallow certain menu commands, these will be dimmed. For example, if the Desktop appears as depicted in figure 3.21, the only File menu commands available will be:

- Open
- Get Info
- Eject

The reason why only these commands can be selected is that the other commands will not apply when the Desktop is configured as shown in figure 3.21.

The System Disk icon cannot be duplicated. The icon cannot be put back. It cannot be closed, as it has not yet been opened. Finally, the System Disk cannot be printed. Therefore, the Duplicate, Put Back, Close, Close All, and Print commands do not apply in this situation and are dimmed.
As discussed earlier, the File menu's Open and Close commands are used to open and close an icon. Duplicate causes a copy of the selected icons to be placed on the disk currently in use. The duplicated icons are assigned the same name as the original with the prefix "Copy of."

For example, suppose that the Desktop appeared as shown at the top of figure 3.22. Notice that the document icon, Memo 4-28, has been selected. If Duplicate is executed, this icon will be duplicated as shown at the bottom of figure 3.22.

Figure 3.21. Desktop with System Disk icon selected
Desktop before execution of Duplicate command

Desktop after execution of Duplicate command

Figure 3.22. Duplicate command
The Get Info command causes a window to be opened for the selected icon which displays the following information:

- Type (disk, application, document, folder)
- Size
- Where it is located
- Application which created it (document only)
- Date created
- Date last changed
- Locked or unlocked (applies to disk only but is always shown)

The Get Info window for the Memo 4-28 document icon is displayed in figure 3.23.

The Put Back command is used to return any selected documents, applications, or folders to the disk or folder from which they came. We will use the following example to illustrate Put Back usage.

![Get Info window](image)

**Figure 3.23.** Get Info window
Figure 3.24. Original Desktop configuration

Suppose that the Desktop resembled that shown in figure 3.24. If the duplicated icons, Copy of Resume, Copy of Proposal, and Copy of Memo 4-28, were placed in the Empty Folder, and that folder was opened, the Desktop would resemble that depicted in figure 3.25.

If we next selected the three icons in the Empty Folder icon and executed the Put Back command, the Copy of Resume, Copy of Proposal, and Copy of Memo 4-28 document icons would be returned to the Misc Disk icon. This is shown in figures 3.26 and 3.27.
Figure 3.25. Desktop after icons copied to Empty Folder icon

Figure 3.26. Execution of the Put Back command
The Close All command closes all windows to their icons, one by one. Suppose that both the Empty Folder and Misc Disk windows were open as shown in figure 3.28, and the Close All command was executed as shown in figure 3.29. Both windows would be closed as shown in figure 3.30.
Figure 3.28. Desktop with Misc Disk and Empty Folder windows

Figure 3.29. Close All command execution
The Print command results in the contents of the selected document icon being output to the printer. Before a document is printed, the application under which it was created must be loaded. Therefore, that application must reside on a disk whose icon is represented on the Desktop. The same printing procedures required in the application must be observed when the Print command is executed.

Suppose that the Desktop appeared as shown in figure 3.31. If we selected Print from the File menu as shown in figure 3.32, the MacWrite print specifications will be displayed as shown in figure 3.33. The MacWrite print specifications appear because Memo 4-28 was created under MacWrite. After OK has been chosen in the MacWrite print specifications, the contents of Memo 4-28 will be output to the printer.
Figure 3.31. Original Desktop prior to Print command

Figure 3.32. Desktop when the Print command is selected
The final File menu command, Eject, is used to eject the selected disk or the disk represented by the active window. If the Desktop appeared as shown in figure 3.31, Misc Disk would be ejected. As shown in figure 3.34, once a disk has been ejected, both the disk's icons and icons contained in that disk will be dimmed on the Desktop as an indication that they cannot be accessed.
EDIT MENU

The selections available in the Edit menu allow editing of the following types of information:

- Names of icons
- Text portion of an information window*
- Text or pictures in a desk accessory

* An information window can be defined as the window displayed when the File menu's Get Info command is executed.
When the Edit menu is pulled down, the following Edit commands will be displayed:

- Undo
- Cut
- Copy
- Paste
- Clear
- Select All
- Show Clipboard

In order to illustrate usage of the Edit menu commands, we will undertake an actual exercise in editing. Since we are already familiar with the information window, let’s practice by editing the text portion of the information window for the Memo 4-28 document icon.

Suppose that Memo 4-28’s information window appeared as depicted in figure 3.35. Notice the blinking vertical bar in front of “This” in the text window. This is known as the insertion point. The insertion point marks the position where text will be inserted when keyboard entries are made.

Suppose we decided to delete the following phrase:

confusion regarding the observance of the

Our first step is to select the portion of the text to be deleted. Text is selected by positioning the insertion pointer to the beginning point, pressing the mouse button, and dragging across the text to the ending word. Once the text to be edited has been selected, the Desktop should resemble that shown in figure 3.36. If too much text was initially selected, the text can be cleared by moving the pointer outside the selected area and pressing the mouse button.
This memo relates to the confusion regarding the observance of the Memorial Day holiday. We'll be observing the holiday on Monday not Thursday.
The selected text can be removed by executing either the Cut or the Clear commands from the Edit menu.

The Cut command causes the selected information to be removed and placed on the Clipboard. Any information which had previously existed on the Clipboard will be replaced by the new copy. Figure 3.37 shows the Desktop after Cut has been executed. Notice that the selected text has been deleted. By executing the Show Clipboard command from the Edit menu, you will be able to verify that the selected text was placed on the Clipboard. The Clipboard is depicted in figure 3.38.

The Paste command can be used to place the information in the Clipboard back at the insertion point. Suppose that we had moved the insertion point to the end of the text in Memo 4-28's information window. If we then executed Paste from the Edit menu, the Desktop would appear as shown in figure 3.39.

![Figure 3.37. Desktop after execution of the Cut command](image-url)
Figure 3.38. Clipboard after execution of the Cut command

We can again delete the phrase, “confusion regarding the observance of”, using Clear. Before doing so, let’s first empty the Clipboard. Notice from figure 3.39, that the insertion point is at the end of the text, and no text is selected. Remember from our definition of Cut that execution of that command causes the selected text to replace the existing Clipboard contents. Since no text is currently selected, by executing Cut when the Desktop resembles that shown in figure 3.39, the Clipboard should be cleared. This procedure is depicted in figure 3.40.

Now, let’s remove the phrase, “confusion regarding the observance of”, without placing a copy on the Clipboard by selecting that text and executing the Clear command.

The Desktop will again appear as shown in figure 3.37 after Clear has been executed. By executing the Show Clipboard command, you can verify that the deleted phrase was not copied to the Clipboard.
This memo relates to the Memorial Day holiday. We'll be observing the holiday on Monday not Thursday. Confusion regarding the observance of the holiday.

Figure 3.39. Desktop after execution of the Paste command

The Copy command places a copy of the selected text on the Clipboard. Unlike Cut, the original information will not be removed. However, as was the case with Cut, execution of the Copy command results in previous Clipboard information being erased. To illustrate the use of Copy, let's select all of the text in Memo 4-28's information window and execute Copy as shown in figure 3.41. By executing the Show Clipboard command, you can verify that the text has been copied to the Clipboard.
This memo relates to the Memorial Day holiday. We'll be observing the holiday on Monday not Thursday. Confusion regarding the observance of the holiday accounts for 2K on disk.

Figure 3.40. The clipboard is cleared after Cut is executed with no text selected.
The Edit menu's Undo command causes the reversal of the editing operation last executed in a desk accessory. The Select All command causes all icons in the active window to be selected.
VIEW MENU

The View menu allows the directories of disks and folders to be displayed in a number of different formats. These formats include:

- Icon
- Name
- Date
- Size
- Kind

We have already seen how a disk or folder's directory can be displayed using icons arranged in a window. This method is depicted again in figure 3.42.

A folder or disk's directory can also be displayed by name. In this window, the names of the various icons included in the folder or disk will be displayed alphabetically by icon name. The directory window by name for the Misc Disk icon is depicted in figure 3.43.

Figure 3.42. Contents of Misc Disk displayed by icon
<table>
<thead>
<tr>
<th>Size</th>
<th>Name</th>
<th>Kind</th>
<th>Last Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>2K</td>
<td>Document</td>
<td>MacWrite document</td>
<td>Sat, Apr 28, 1984</td>
</tr>
<tr>
<td>6K</td>
<td>Empty Folder</td>
<td>folder</td>
<td>Tue, May 8, 1984</td>
</tr>
<tr>
<td>53K</td>
<td>MacWrite</td>
<td>application</td>
<td>Tue, Jan 24, 1984</td>
</tr>
<tr>
<td>2K</td>
<td>Memo 4-28</td>
<td>MacWrite document</td>
<td>Tue, May 8, 1984</td>
</tr>
<tr>
<td>2K</td>
<td>Proposal</td>
<td>MacWrite document</td>
<td>Sat, Apr 28, 1984</td>
</tr>
<tr>
<td>2K</td>
<td>Resume</td>
<td>MacWrite document</td>
<td>Sat, Apr 28, 1984</td>
</tr>
<tr>
<td>219K</td>
<td>System Folder</td>
<td>folder</td>
<td>Sat, Apr 21, 1984</td>
</tr>
</tbody>
</table>

**Figure 3.43.** Directory window by name for Misc Disk icon

The Date command displays the various icons in the order in which they were last modified. As shown in figure 3.44, the icon most recently modified is displayed first.

<table>
<thead>
<tr>
<th>Size</th>
<th>Name</th>
<th>Kind</th>
<th>Last Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>2K</td>
<td>Memo 4-28</td>
<td>MacWrite document</td>
<td>Tue, May 8, 1984</td>
</tr>
<tr>
<td>6K</td>
<td>Empty Folder</td>
<td>folder</td>
<td>Tue, May 8, 1984</td>
</tr>
<tr>
<td>2K</td>
<td>Document</td>
<td>MacWrite document</td>
<td>Sat, Apr 28, 1984</td>
</tr>
<tr>
<td>2K</td>
<td>Proposal</td>
<td>MacWrite document</td>
<td>Sat, Apr 28, 1984</td>
</tr>
<tr>
<td>2K</td>
<td>Resume</td>
<td>MacWrite document</td>
<td>Sat, Apr 28, 1984</td>
</tr>
<tr>
<td>219K</td>
<td>System Folder</td>
<td>folder</td>
<td>Sat, Apr 21, 1984</td>
</tr>
<tr>
<td>53K</td>
<td>MacWrite</td>
<td>application</td>
<td>Tue, Jan 24, 1984</td>
</tr>
</tbody>
</table>

**Figure 3.44.** Directory window by date for Misc Disk icon
The Size command displays the icons in the directory window according to size. As shown in figure 3.45, the largest items are listed first.

Figure 3.45. Directory window by size for Misc Disk icon

Figure 3.46. Directory window by kind for Misc Disk
The Kind command groups the items in the directory window by type; document, folder, or application. The directory window by kind is depicted in figure 3.46.

**SPECIAL MENU**

The Special menu contains the following commands:

- Clean Up
- Empty Trash
- Erase Disk

The Clean Up command can only be used when the By Icon option in the View menu is active. This command rearranges the icons in the active window into orderly rows and columns. Clean Up can also be used without a directory window being open to rearrange the Desktop.

The Empty Trash command can be used to erase any icons from the Trash icon.

The Erase Disk command can be used to erase the contents of a disk. Start-up disks cannot be erased.

**Desk Accessories**

As mentioned earlier, the various desk accessories can be accessed from the Apple menu. These can be accessed while the Desktop is active or while an applications program is in use.

As with any other window, the desk accessory window can be made active by clicking the mouse. It will automatically be active when chosen from the Apple menu. The accessory window can be moved by dragging its title bar with the mouse. An accessory window can be closed by clicking the close box or by indicating the Close command from the File menu. All desk accessories will automatically be closed when an application is opened or closed or when a document is opened.
SCRAPBOOK

The Scrapbook accessory provides an area in which frequently used text or pictures can be stored. Pictures and text which have been stored in the Scrapbook can later be copied back into a document. The procedure for storing pictures and text in the Scrapbook is provided in chapters 5 and 6.

The Scrapbook is depicted in figure 3.47. Notice the scroll bar at the bottom of the Scrapbook window. This allows the user to scroll through the Scrapbook’s available pages.

![Scrapbook window]

Use the Scrapbook to store a variety of text selections and pictures which may be transferred between applications. From the Edit menu, Cut or Copy an item from the Scrapbook, then Paste into an application document.

Figure 3.47. Scrapbook accessory
ALARM CLOCK

This portion of the Apple menu is used as a clock, alarm clock, and calendar. Unlike most other personal computers, the Mac’s clock is powered by a battery. Until the battery runs out, there is no need to set the system date or time. Selecting Alarm Clock from the menu reveals the clock portion. To view or set the date, time, or alarm, click the small flag symbol in the right corner of the box. The window appears as depicted in figure 3.48a. This displays the date set mode. Notice that the calendar symbol in the center is highlighted. Clicking the alarm clock on the right gives rise to figure 3.48b. This is the alarm set mode showing the alarm time and the set switch. Figure 3.48b shows the set switch in the up and set condition, while figure 3.48c shows it in the down and unset condition. The time set option appears in figure 3.48d.

In order to set the time, date, or alarm, position the pointer to the digits to be changed and click the mouse button. The indicated digits will be highlighted, the time will freeze, and arrows will be displayed as shown in figure 3.48e. Press the up arrow to increase the value of the highlighted digit. Press the down arrow to decrease the value. Click the mouse button outside the set area to set the new values. Alternately, select the digits, and then enter the new ones via the keyboard. Altering the time or date sets the time or date for the entire computer. With the alarm set, the Mac will beep once per day at the appropriate time.

The time or date can subsequently be copied and pasted to other documents. The procedure is described in chapter 5.
Figure 3.48. Alarm Clock accessory
NOTE PAD

The Note Pad provides an area where the Mac user can keep notes which are separate from the document being worked on. The Edit menu commands can be used to copy text to and from the Note Pad.

The Note Pad is depicted in figure 3.49. Notice the turned-out corner at the left edge of the page and the page number. The Note Pad contains eight separate pages. The current page number is displayed as shown in figure 3.49. You can turn to the previous page by clicking the area depicted in gray in figure 3.49. You can turn to the next page by clicking the turned-out corner.

Figure 3.49. Note Pad accessory
CALCULATOR

The Calculator accessory can be used like a standard desktop calculator. The Calculator results can be copied to a document or to another accessory. Also, numbers from a document or accessory can be copied to the Calculator’s display.

The calculator is operated either with the mouse or by typing the appropriate entries on the keyboard.

KEY CAPS

When the Key Caps accessory is selected, the window depicted in figure 3.50 will appear on the Desktop. When the Key Caps window is active, text entered via the Mac’s keyboard or by clicking the keytops in the window will appear in the blank line at the top of the window.

Figure 3.50. Key Caps accessory
CONTROL PANEL

The Control Panel accessory, as depicted in figure 3.51, allows the user to control the following settings on the Mac:

- Speaker volume
- Clock
- Command blinking
- Rate of repeating keys
- Keyboard touch
- Rate of insertion point blinking
- Mouse tracking
- Desktop pattern
- Double-click speed

The speaker volume setting controls the volume of tone emitted by the Mac's speaker. The setting can be dragged up (higher) or down (lower).

The clock can be used to set the Mac's system date and time. It operates exactly as did the Alarm Clock described earlier.

Figure 3.51. Control Panel accessory
Command blinking refers to the number of times a command blinks when it is chosen from a menu. This can be set to 0 (off), 1, 2, or 3 by clicking the mouse button.

Rate of repeating keys allows the Mac operator to change the rate at which a key will repeat when it is pressed. The higher the setting, the faster the keys repeat.

Keyboard touch refers to the length of time a key must be pressed before it begins repeating. A high setting causes the keys to repeat when pressed for only a short period of time. A low setting means that the keys will have to be pressed longer to repeat. A setting of 0 causes the repeating feature to be turned off.

Rate of insertion point blinking controls the rate at which the insertion pointer flashes.

Mouse tracking controls the distance the screen pointer will move relative to the speed with which the mouse is moved on the desk or table surface. A setting of 1 causes the pointer to move farther as the mouse is moved faster. A setting of 0 results in the pointer’s movement remaining independent of the mouse speed.

Desktop pattern allows the Mac operator to choose the background pattern to be used for the Desktop. The available patterns can be displayed by clicking the mouse in the white bar on top of the miniature window to the left. By clicking the right side of the bar, the next pattern will be displayed. Clicking the left side displays the previous pattern. When the desired pattern is displayed, move the pointer inside of the pattern and click the mouse button. The Desktop pattern will change to the selected pattern.

The double-click speed setting determines the speed with which the mouse button must be pressed in order for it to be interpreted as a double-click. The higher values require the button to be pressed quickly, while the lower values allow the button to be pressed more slowly.
PUZZLE

The final Apple menu selection, Puzzle, results in a puzzle game being displayed.
Introduction

In this chapter we will discuss the various operations which pertain to the Mac's disks and the data on them. The Apple Macintosh was designed to use custom-designed Sony 3½ inch micro floppy disks. At the time of this writing, the disks were single-sided meaning that they hold data on only one side of the disk. At some later date, they will be expanded to double-sided increasing the storage capacity from 400K to 800K.

The data ordering of the Mac disks differs from normal floppy disks in two important ways, the density of information placed on the disk surface and the disk rotation speed. Most
disks are structured by placing data in magnetic form following a series of concentric circles around the disk. These circles are called tracks and act much like the tracks around a phonograph record. The Mac's disks can hold 80 tpi (tracks per inch) as opposed to the 70 tpi for the standard Sony 3½ inch diskettes.

When loading data on a disk, most disk drives use one rotation speed and one data rate. Each track on the disk is divided into sectors each containing 512 characters. Since the rotation speed and the data rate are constant, the sectors near the edge of the disk are longer than those near the center of the disk. This essentially wastes disk space.

The Macintosh disk drive is designed to operate at variable speeds to allow it to record data on the disk with each sector having the same length. Rotation speeds range from 390-600 rpm. When operating near the rim of the disk, the drive turns at a slower speed. When near the center, it rotates faster.

Although this is a great help for the Mac in terms of data storage efficiency, it has the disadvantage that no other computer, with the exception of the Apple Lisa, can read the Mac's disks. Likewise, the Mac (or the Lisa) cannot read disks recorded on most other computer systems.

Since the Mac's drives have been extensively tested and since they require few adjustments, the disk drive should operate for an extended period of time without the need for repair.

Disk ejection is under the control of the Mac's software. Most other floppy disk drives allow the operator to remove the disk at any time. Placing the disk ejection under the Mac's control insures that the Mac will have the opportunity to update the disk before it is removed. Such updating might include Trash file removal, storage of display formatting, and proper file closure.

In this chapter, we will outline the commonly used disk operations required when working with the Mac. Although we will make reference to the applications available on the Mac,
extensive discussions of them shall appear in following chapters. We will learn to copy data from disk to disk. This will include both copying of the entire disk and individual disk file copying. We will also discuss the Font Mover application and see how it can be used to save disk space. In addition, we will discuss the procedure for saving data on disks and recovering data from faulty disks. The hierarchy of the Mac disks will also be discussed along with the various possible placements of files on more than one disk.

When discussing copying of various icons, we will use the terms “source” and “target.” The source refers to the disk or file which you want to copy from, while the target refers to the destination of the data.

**Disk Copying**

When working with a magnetic medium such as the Mac disks, it is always wise to have at least one copy of important data on another disk in case one disk becomes unreadable. The disk containing the second copy of the data is known as the **backup disk**. There are two methods for copying an entire disk’s data to another disk. The first is the normal procedure which requires no special software; the second is an alternate method using a special application.

**DISK INITIALIZATION**

When inserting a new disk or a disk whose software has been irreparably damaged, the Mac will display a message informing the operator that the disk is unreadable and asking the operator if he or she wants to initialize the disk. All disks used on any computer must be initialized. Many computer manuals refer to this operation as **formatting**.
When instructed to initialize a disk, the computer will begin by reading every sector on the disk to check it for damaged sectors and erase any old data. Then it will place on the disk the essential information it needs to recognize the disk. In the Mac's case this will include the disk's name which the operator enters during the process. It will also include a folder entitled Empty Folder. This folder will be the basis for all folders on the disk. To create a folder for documents or other files, select the Empty Folder icon and select Duplicate from the File menu. A Copy of Empty Folder will appear. The operator can rename the folder as desired.

**NORMAL DISK COPY**

In order to copy the contents of one disk to another, simply move the source disk's icon to the target disk's icon. Make sure that the pointer moves to within the target disk's icon. At this point, the Mac will respond with a message as shown in figure 4.1. The purpose of this message is to allow the operator to change his or her mind and not perform the operation if desired. Click OK or Cancel as the case may be and the Mac will begin the copy sequence. The copy sequence will be performed by the Mac in the following manner. The Mac will load a portion of the source disk's data into RAM. Then it will eject the disk and request the target disk. When the target disk is inserted, the Mac will transfer the data to the disk and then start the procedure over again until the data has been copied.

The operator should be prepared to remain at the computer for a few minutes. The Mac will request that the disk be switched ten or more times. When the operation is complete, the Mac will stop, and the Desktop will appear as before. Data in the source disk will also occupy the target disk. The names of all files, folders, and applications will remain as with the original. The name of the target will be unaffected.
THE DISK COPY APPLICATION

The second method of copying disks is to use the Disk Copy application. If you have purchased this application, it will greatly increase the speed with which the procedure is completed. The application operates by transferring the data in four large chunks of data. With only 128K of RAM available, each 100K chunk leaves only about 28K of extra memory. In chapter 1 we noted that the display requires 22K of RAM memory. As a result of the memory squeeze, the display will become garbled during the procedure.

To operate the application, open the Disk Copy icon. The application will commence and a window will appear apprising you of the memory and display conditions described above. Select OK from this window, and the Mac will continue with the procedure.

The instructions for the Disk Copy will appear in the lower part of the display. These will include requests for the source disk and the target disk. If the target disk is not initialized, the Mac will do so automatically. If the target disk contains existing data, the Mac will ask permission to erase the disk. Each instruction or request box will contain a Cancel option to terminate the disk copy if desired. When the disk
copy is completed, the target disk will be identical to the source
disk. With Disk Copy, the target copy’s disk name will be the
same as the source disk’s name.

No matter how you perform the data transfer procedure, it is more easily accomplished with the optional second disk
drive. To utilize this capability, simply insert both disks and
then use either of the previously described methods.

**DISK FILE COPY**

Now that we have a copy of the data disk, we can continue
to use the original disk to change or add to the information
upon it. When we have completed those changes, we will want
to save the documents we have added or changed and record
those changes on the backup disk. To do this we do not need to
copy the entire disk. We need only to copy the files we want
updated.

The procedure is similar to that used with disk copying. To
copy files, simply move the file icon or icons from the source
disk icon to the target disk icon. The Mac will indicate the files
remaining to be copied and will request disk switches until the
operation is complete. If you are transferring a folder, the
number of files remaining will equal the number of files within
the folder. If there are files of the same name already residing
on the target disk, the Mac will display a box asking if you want
those files replaced.

Be sure not to try to place the source disk’s copy of a folder
icon directly upon the target disk’s copy of that same folder’s
icon. The Mac will interpret this as an attempt to place one
directory within another directory of the same name. This action will
be disallowed.
The Font Mover Application

The Font Mover is an application which should be included on the Write/Paint diskette. Its purpose is to allow the operator to remove most of the font information from the System file. When it is not needed, the font information can be loaded into a special document and can be copied and held on a data disk.

To use the application, copy it onto the disk from which you want to remove the font information. For the purpose of our illustration, insert a startup disk featuring the Font Mover into the Mac. Open the application icon. The window shown in figure 4.2 will appear. To move a font into the Fonts file, select the font by clicking on the font name in the left column. The font name will become highlighted as shown in figure 4.3. The font name, point size, disk memory size, and a sample of the font will appear in the lower portion of the window. Now select Copy and the font will appear in the right column. Notice that the arrows surrounding the word Copy point in the direction the copy will occur. To select more than one font, position the pointer on the first font in the list and drag to the last font in the list. The selected font names will become highlighted as shown in figure 4.4. Only the total disk size of the selected fonts will appear in the lower part of the window. When Copy is selected, the highlighted fonts will appear in the right column.

To remove fonts from the System file, select the font or fonts in the left column and select Remove. The fonts will disappear from the System file list. Note that the fonts which appear with an asterisk cannot be removed from the System file as they are essential to the Mac’s operation. It would be unwise to remove a font from the System file without first transferring it to the Fonts file.

The Mac will repeat these instructions when you select the Help option from the Font Mover window. To exit the Font Mover application, select Quit. The changes you have specified will be recorded, and the application will rewrite the System
file and create a Fonts document.

To restore a font to the System file, use the same method as when moving a font to the Fonts file. Select the font to be moved, select Copy, and the font will appear on the System file. Note that no data transfer actually occurs until you Quit the application.

Figure 4.2. The Font Mover window

Figure 4.3. Selecting one font name
Now that you have reduced the size of the System file by removing unneeded information, you can move the Fonts document to another disk for safekeeping. To reenter the Font Mover application, open either the application icon or the Fonts document icon. The Font Mover window will appear with the Fonts file information listed in the right column and the System file information listed in the left column.

**SOME PRECAUTIONS**

There are a few precautions which you should take when using the Font Mover. Remember that the System file helps determine the overall operation of the computer. Do not interfere with the Mac while the file is being rewritten. This operation may take a minute or more. Be sure that you have a spare copy of the System file on hand in case the Font Mover incorrectly rewrites the file. As mentioned earlier, never remove a font from the System file without copying it to the Fonts file.
When using an application such as MacWrite which is described in the following chapter, the Font menu will display only those fonts which remain in the System file.

**Saving Data**

Even though the Mac’s disks hold more than comparable disks used with many other microcomputers, they still provide a limitation to the file storage options available to the operator. For this reason the operator should develop a strategy regarding the organization of information on the disks.

**DATA DISKS vs OPERATIONAL DISKS**

When utilizing the Mac’s applications to create and modify numerous documents on disk, the operator will soon find that one disk will not meet his or her needs. One solution to this problem is to determine one or more disks as data disks and keep one or two disks as operations disks.

The term data disk refers to the information which is contained on the disk. A data disk contains only data files. Data files are simply applications documents. A data disk has no startup capabilities. It does not contain the System or Finder icons or any other Mini-Mac icons which the System file uses in its normal operation. It also does not contain any of the Mac’s applications. These files can occupy the majority of the disk leaving little room for data files. Without the system information, a disk may hold 25 or more documents of various types and sizes.

Operational disks contain the system startup information. They include the System and Finder icons along with any other necessary Mini-Mac icons and the needed applications. Under some data handling methods, these disks may hold a few documents for a short period of time but the main source of
data is the data disk. An operations disk can hold only two or three documents at a time. Using the Font Mover to create extra disk space enables the operations disk to hold as many as four or five documents.

The remaining free space on a disk is a potentially confusing issue. Though a document may occupy only 10 or 12K of memory on the disk, the Mac may indicate insufficient disk space with as much as 50K or more of available free disk memory. This is due to the Mac’s needs and the organization of data on the disk.

You may define another class of disks as application disks. These disks hold the applications including those not presently in use. The applications occupy a large segment of the disk as do the system files.

Using this method of file organization, normal operation might proceed as follows. First load the operations disk to startup the Mac. Then load the applications disk and copy the necessary applications onto the operations disk. Finally, insert the data disk and copy the needed documents onto the operations disk.

When you have finished with one document or set of documents, copy them back onto the data disks and remove them from the operations disk. To remove a file from the disk, move its icon to the Trash icon. You may have to select Empty Trash from the Special menu to make room for the new files.

OTHER DATA HANDLING METHODS

Though it is always a good idea to maintain duplicates of each disk, it may happen that one disk appears to malfunction. As is so often the case, such a disk might be the only one with the updated version of a document.
The malfunctioning of a disk is usually not a physical issue. The Mac's disks are very sturdy and remain useful for a long time. The Mac might, however, damage the software on the disk through its normal disk operations. When this occurs, the Mac will most likely refuse the disk and display a system error message. When the message appears, the best option is to punch out the disk as described on page 300 of chapter 9, Troubleshooting and Operating Hints. Reinsert the startup disk and select Restart from the error message box. The Mac should restart normally.

If you try to restart the Mac with the bad disk, the error will probably recur. If the disk was not a startup disk, the Mac will refuse it. Inserting a system disk at this point might result in a lockup situation. That is, the Mac will do nothing and will not return the disk. To cause the disk to eject, you can punch it out, or you can turn off the Mac. Then turn the Mac back on and press the mouse button. After a few seconds, the disk should eject.

If the data disk software is damaged, the error will recur if the operator tries to reuse the disk. The procedure for accessing data on such a disk is outlined on pages 298-30 of chapter 9. We feel that the best method is to insert the disk and press and hold the Command and Option keys. This command forces the Mac to read the disk.

**USING THE OPTIONAL SECOND DISK DRIVE**

The optional second disk drive can make data handling much easier. Normal operations with a second drive available might proceed as follows. Turn on the Mac and insert the operational disk into the main disk drive. Then insert the applications disk into the optional disk drive and copy the applications, which are appropriate to the day's work, to the operational disk. Then eject the applications disk, insert the
data disk into the second drive, and copy the necessary file to the operational disk.

This last step is only a time saving measure. The Mac can manipulate the two disk drives to utilize both the data on the data disk and the operational disk to perform the required functions. This will take only a small amount of additional time.

Data copying with the second disk drive is simplified as well. Simply insert the source disk into one drive and the target into the other drive. Perform the data copying icon manipulations, and the Mac will handle the rest.

**Disk Hierarchy**

The Mac treats the disk icon on the Desktop differently than any other icon. This is primarily because the disk icon is the only one we have seen so far which represents some physical object. The other icons represent memory locations either on a disk or in the Mac’s internal memory. In this section we will discuss the importance that the Mac’s places upon each disk icon. With the Mac disks, the hierarchy is similar to the hierarchy within a kingdom. The Mac considers one disk to be the King, or **System disk**. All the others are the subjects, or **Alternate disks** as we will call them. As is so often the case in the world, we will see how a subject can overthrow the king or, in our terminology, how an Alternate disk can become the System disk. We will also see how an Alternate disk can be banished to the Trash icon.
SYSTEM AND ALTERNATE DISKS

In order for a disk to be a System disk, it must contain the system information. That is, it must contain the System and Finder icons. When the Mac is first turned on and a startup disk is inserted, that disk will become the System disk for the computer by default, since there is no other disk to command the Mac’s attention. We will assume that the startup disk features the MacWrite application. Try this on the Mac. Notice that the System disk icon appears at the top of the display directly above the Trash icon. We shall call this position the Controlling Slot. Its importance is to the System disk what a throne is to a king.

While no other disk is inserted into the Mac, the first disk will remain the System disk. No matter what operations we perform with the System disk, it will always remain in command. Let’s try some operations with the System disk icon. First, let’s try dragging it to the Trash icon. As with any good king, the System disk icon is safeguarded against disposal. The Mac may display a message indicating that the startup disk may not be thrown away. Let’s try selecting Erase Disk from the Special menu. Foiled again! A message appears disallowing the erasure. As long as the disk is the System disk, its system files may not be tampered with in any way. We may perform normal operations with the disk, utilize applications, create documents, and manipulate icons. We may not throw away the System or the Finder icons while the disk remains in charge.

Try moving the System disk icon about the Desktop. As long as we do not move it to the Trash, there is no objection. In this case the king remains the king even though he does not occupy the throne. The Mac still recognizes the disk as the System disk even though it does not occupy the Controlling Slot. Return the System disk to its original position and select Clean up from the Special menu.
CHANGING THE DISK HIERARCHY

Now we will complicate the scene. Either eject the System disk and insert a data disk, or insert a data disk into the second disk drive. This disk, like a proper subject of the king, can never be a pretender to the throne since it lacks the system information required of the System disk. The Mac considers it to be an Alternate disk. We may perform any needed alterations to this disk with no restrictions, as long as we are prepared to accept the consequences of altering its files. We may even erase this disk if desired. The Erase Disk command will cause the Mac to display a message asking the operator if he or she really intends to erase the information on the disk, but the action will not be disallowed.

One qualification to this is that no disk may be altered in any way as long as the red tab is moved away from the write protect hole in the disk casing. Figure 4.5 shows the red tab in the locked (a) and unlocked (b) positions.

![Figure 4.5. Disk write protect. a. Locked position; b. Unlocked position.](image)
Let's try another experiment with the Alternate disk. Try to drag its icon to the Trash icon. When the mouse is released, the icon outline will return to the disk icon. No disk presently in a disk drive may be discarded.

Now that we have finished with the data disk, eject it. Now try dragging the disk's icon to the Trash. The icon disappears. Open the Trash icon and you will see that the Alternate disk's icon does not appear there. The subject disk has been banished from the kingdom and can only return if it is reinserted into the disk drive. The portion of the Mac's RAM which enables it to recognize the Alternate disk has been erased. In effect, the Mac has forgotten about the disk.

Insert the disk into the Mac's disk drive. This disk should be a startup disk like the System disk, and it should feature the applications which we will need for operation. For our demonstration, insure that both the System and this latest disk contain the MacWrite application. The disk icon appears in the position immediately below the System disk.

This disk has the capacity to overthrow the king and occupy the Controlling Slot. For now, however, it acts as did the previous subject disk. You can erase the system information on the disk if you want. Such an attempt will cause the Mac to display a box asking you if you really want to delete system information. Selecting OK in this box will allow the action. Do not do so at this time.

There are two ways in which the System disk may be overthrown by another qualified disk. To demonstrate the first method, open the MacWrite icon residing in the newest disk. Any Mac application would serve our purposes in this instance. We will not operate MacWrite at this time, so do not be concerned as to its functions. When the MacWrite document has appeared, select Quit from the File menu. When the Desktop reappears, the second disk will now occupy the Controlling Slot, and the first disk will not appear. In effect, the newer disk has overthrown the older one and assumed the throne. The old king has been banished.
What probably happens when this procedure is performed is that the application is loaded into the Mac's RAM. Applications generally occupy a large portion of memory. The result is that the portion of the RAM which holds the disk recognizing information is written over by the application.

If we were to open a MacWrite document from the second disk while it was still an Alternate disk, the Mac would load the MacWrite application from the System disk. In this case the System disk would not be replaced. In fact the Alternate disk would be banished when we returned to the Desktop.

The second method of changing the disk hierarchy is to turn off the Mac. When that occurs, the RAM is erased. Now, when the Mac is turned on again, the first system disk to be inserted will assume the throne and become king.

**Data Placement Strategies**

Due to the limited size of our magnetic medium, we cannot indiscriminately load data, system files, and applications on any disk and expect smooth, efficient operation. Developing a sound data handling strategy will greatly aid the Mac's efficiency. In this section we will review some of the various data placement options and the advantages and disadvantages of each. The basis for our discussion will be, as before, the concept of operational disks, data disks, and applications disks.

**SINGLE DISK OPERATION**

In one of the previously discussed scenarios, we used the operational disk as the working disk. Under this organizational strategy, we place the needed applications upon the operations disk and use all other disks as holding areas for unused data files.
With this placement technique, you might start the day by inserting the operations disk into the Mac. If you need to use both MacWrite and MacPaint to create a document with both graphics and text, copy those applications onto the operations disk. Since both applications together occupy about 113K or 28% of the disk space, you may wish to use the Font Mover to remove unneeded fonts from the System file. Let us use this application to remove the following fonts and point sizes and place them onto a Fonts file:

- Athens 18
- Geneva 12, 14, 18, 24
- San Francisco 18
- Toronto 8, 12, 14, 18, 24
- Venice 14

The Fonts file for these fonts takes up about 53K of disk memory. Copy the Fonts onto one or two data disks, move the operations disk copy of the Fonts file to the Trash, and select Empty Trash. We have created 53K of extra disk memory on our operations disk. Under these conditions we have room for five or six documents with which we can work.

Now use the data disk to copy any needed documents onto the operations disk. We have set up a situation where all needed information now resides on one disk. The advantage to this is that we do not need to worry about working with two or three separate disks when operating the Mac. When opening an application, the data disk and applications disk will be erased from RAM. When using the computer, the needed files will all reside on one disk. We may create documents, edit other documents, and print them with no need to refer to other disks.

The disadvantages to this data handling method are mostly a matter of convenience. First, the operator may find it tedious to copy the document to the operations disk, then recopy updated versions back to the data disk. If the operator
must work with several large documents in succession, there may not be sufficient space on the disk for all the files. In addition, the operator may need the fonts which we removed from the System file. With the System file at normal size, sufficient room may not be available for the required documents.

**DOUBLE DISK OPERATIONS — USING THE DATA DISK AS A REFERENCE**

In response to the problems encountered with the previous data ordering method, the operator might consider using two disks in normal operation. When the Mac owner uses the optional second disk drive with the Mac, this provides no additional inconvenience. With this method, we will use one disk as the operational disk featuring the system information and the applications. The second disk will contain the data and will be the sole resource for documents.

To use this method, start up the Mac with a System disk. Then insert an applications disk and copy the needed applications to the System disk as you did in the previous section. Eject the applications disk and insert the data disk. Now, instead of copying the data onto the System disk, open the icon for the desired document. The Mac will eject the data disk and will accept the System disk again to load the Mac applications. Then the Mac will require one or more disk switching operations while the document is loaded into memory. Now, you may perform the modifications upon the document. We are assuming that the data disk is, as described earlier in this chapter, void of system information and cannot become the System disk. The disk hierarchy should not change.

The advantage to this technique is that the size and number of the documents is limited only by the available space
on the data disk. This can be many times the document handling capabilities of the System disk. You can work with any number of documents on the data disk as long as they all fit on that disk. This method is very convenient when you only need to review one or two documents and will be making few if any revisions to a document. It is also preferred if you are using the optional second disk drive. Another advantage is the expansion of available disk space. Since we need not copy and erase documents from various disks, we are not concerned about the limits on free space on the System disk.

The disadvantages to this method apply primarily to the single-disk-drive Mac user. The tedious task of repeatedly switching disks to load applications and documents and to save revisions makes this method intolerable if you plan to make repeated revisions to several documents. Be careful of the disk hierarchy when using applications under this data handling scheme. Creating a new document will banish the data disk and put the new document on the System disk.

Another possibility when using two disks is to place the applications on the data disk. There is little, if any, advantage to this since at least as many disk switches are required. This method also sacrifices a portion of the free disk space on the data disk with little increase in efficiency.

**USING THREE DISKS WITH A SINGLE DRIVE**  
(Not Recommended)

Adding a third disk in the operation of the Mac complicates the issue tenfold. Let us set up another scenario. Startup the Mac with a startup disk which does not contain the MacWrite application. If necessary, discard the application from the System disk. Be certain that you have a copy of MacWrite on another disk. Now set up a disk with MacWrite on it. This disk should not contain system startup information. Thirdly,
select a disk with data files on it. This disk should contain neither MacWrite nor system files.

We are setting up this example to show you what not to do when dealing with the Mac. Start up the Mac with the first disk, then insert the applications disk, and then insert the data disk. The Mac’s RAM now contains information from three different disks. Open a MacWrite document from the third disk. The result of this action is almost as bad as opening Pandora’s box. The Mac will swamp you with a tirade of disk switching requests. By the time you have loaded the document, you may have forgotten what you wanted to do with it.

The problem with this method is that when loading the application, the Mac requires free flowing communication between the system files and the applications file. Most of the disk swaps do not involve loading the document into the memory but are designed to initiate the application. In short, do not try to perform operations with three disks. Always insuire that the applications disk is also a system disk.

**FURTHER COMMENTS**

This chapter has concentrated on disk operations with the Mac. We have seen how to manage data in an orderly manner, and we have looked at one or two undesirable techniques as well. In general we would comment that the Mac makes disk handling a bit difficult because of its single-disk-drive design. The saving grace of the system is that the visual interface aides in the manipulation of data. The operator will probably find it most convenient to keep several disks dedicated as data disks and employ either the one disk or the two disk operational technique. In the following chapters, we will develop the two major applications which you can use with the Macintosh, MacWrite and MacPaint. We think that you will agree that they are efficient and easy to use.
Introduction

In previous chapters, our discussion of the Mac has been centered around the Desktop environment. Now we will learn how to operate MacWrite, Apple's optional word processor program for the Mac. MacWrite is ideal for composing, editing, and formatting almost any written correspondence from personal letters to formal business letters. We will include in this chapter a short selection in order to illustrate the options
available in MacWrite. A discussion of integrating MacWrite with MacPaint, the matching graphics program, will appear in some detail in chapter 6.

We will begin by originating a document. First we will specify:

- Margins
- Tabs
- Headers
- Footers

Next we will edit the text, save the work on disk, and print it. Then we will access a document already on disk, either on the existing disk or an alternate. A short discussion on text storage will follow. We will then end the chapter with a review of the menus peculiar to MacWrite.

**Originating a Document**

Let's start by creating a document. With the Mac set up ready to receive a disk, insert a disk featuring the MacWrite application. The standard MacWrite-MacPaint disk has this option prerecorded, or you may wish to use another disk with the application. If you are unsure whether a disk features MacWrite, simply check it by inserting the disk and opening its icon. The display window will show the MacWrite application icon if it is available. If not, eject the disk and try another.

Once the proper disk has been inserted, you can easily create a document by opening the MacWrite icon. After about 25 seconds, the screen will appear as shown in figure 5.1.
Notice that the window depicted in figure 5.1 resembles windows dealt with in earlier chapters. This window includes the usual features:

- Title bar (currently unnamed)
- Close box
- Active window lines
- Scroll bar
- Size box

A menu bar appears above the window. As you may have already noticed, the MacWrite window also includes a ruler with several icons. We will discuss this ruler later in this chapter.
The rest of the screen resembles a blank sheet of paper. For our purposes, we may think of it as such. What concerns us now is the flashing bar which appears in the upper left-hand corner. This is the insertion point referred to in previous sections. It indicates where characters will appear in the text.

Before continuing, let's write a short, one-page paper. When typing text, MacWrite automatically fits paragraphs between the margins, top and bottom, right and left, without the use of the Return key. In fact, use of this key will hinder the editor operation giving undesired results. The Return key need only be used to end a paragraph or skip lines. Type the following paragraph without hitting Return. If you make any mistakes, just press Backspace and keep typing.

When reviewing the merits of the book, *The Grapes of Wrath*, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of the world today while older adults tend to relate it to the depression era it describes.

Notice that as you type, the editor positions words between the two black triangles. These are known as margin markers. They will be discussed later. No word will appear outside the margin markers. Each line will contain only those words which can fit inside the margin markers. We define a word as any string of characters ending in a space. The text should now resemble that depicted in figure 5.2.
When reviewing the merits of the book, The Grapes of Wrath, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of the world today while older adults tend to relate it to the depression era it describes.

Figure 5.2. Typed report

Setting the Format

RULERS

If at some point you wish to take a break and later resume work at the same place, the only operation necessary is to close the MacWrite window. A dialogue box will appear as shown in figure 5.3. Select Yes if you wish to save the report and No to remove it. The Yes entry will prompt another box as shown in figure 5.4. Enter a name in the space provided. Be sure the name is not assigned to another document. You might record the name in writing for future reference. Select Save to end this procedure. Select Cancel if you change your mind.
Save changes before closing?

Yes

No

Cancel

Figure 5.3. First dialogue box

Save current document as

Chapter 5

Eject

$ave

Cancel

○ Entire Document ○ Text Only

Figure 5.4. Second dialogue box
If you can still access the MacWrite menus, reopen the document by selecting **Open** from the File menu. A box will appear with the names of all available MacWrite documents plus some options. Select the appropriate document along with Open from this box to open the document. To exit MacWrite, select **Quit** from the File menu. To return to the document, simply open its icon from the appropriate window or start over again by creating a new document.

Now that we have text to work with, we can go about formatting it to suit our needs. Most papers or reports will be much longer than the one included here. The MacWrite editor divides a document into pages. Limits on the number of pages depend on the complexity of the document, but the maximum is about ten pages. If the document is too long, the Mac will display warning boxes and may even refuse further entry. Large selections should be divided into shorter documents. We will now set the options available in the ruler box. You can just as easily do this before entering any text, but we will do it now in order to more readily see the results.

Picture the MacWrite ruler as an actual ruler placed on a sheet of paper. Measurement starts at 1 inch and extends to 7 1/4 inches, which will stretch to 8 1/4 inches using the size box. When printing text, the Mac uses the ruler as a reference for the printer.

Suppose you had to prepare this report with full justification, a 1 1/2 inch left margin, 1/2 inch paragraph indentation, and 2 inch right margin. The top and bottom margins will be discussed in the Header/Footer section.

We will start with the right margin. Using the mouse, position the pointer tip on the rightmost margin marker. Drag the arrow to 6 1/2 inches. The path taken between the two points is not important so long as the button remains pressed and is released only when the marker is properly positioned. The marker moves in 1/16 inch graduations. Assuming 8 1/2 inch wide paper, the report now has a 2 inch right margin. It may
take a bit of practice to properly select a margin pointer as the arrow must be precisely positioned to grab the marker.

Notice the, 1, symbol in the left portion of the ruler. This is actually two overlapped markers. Position the arrow over the symbol and try to move it. Most likely you grabbed a symbol which resembles this, 1. This is the indentation marker. This marker will position the first line in each paragraph. A paragraph is defined as any string of characters ending with a Return character. Although you cannot see the Return character, it plays a crucial role in text editing and formatting. Thus, just one line can denote a paragraph if it ends in a Return. Position the indentation marker on the 2 inch mark. As with right margin adjustment, the text conforms itself to the new criteria.

The remaining marker is the left margin marker. It is identical to the right margin marker and serves a similar function. Set the left margin at 1½ inches using the same method employed for the right. The result should resemble that depicted in figure 5.5.

Now we are ready to set the spacing and justification. Notice the three small blocks in the area beneath the ruler graduations between 2½ and 4 inches. These are the spacing blocks. The left, center, and right denote single, one-and-a-half, and double spacing, respectively. They are selection blocks similar to those already used.

To select an option, position the arrow on the appropriate block and press the mouse button. Notice the single-space block is inverted. In other words, it appears white on black as opposed to black on white. This indicates that it is set. This preset* will appear any time a document is originated and remains until the document is altered. Place the arrow on the center block and press the mouse button. The text now appears with 1½ line spacing as shown in figure 5.6.

* This is the setting the Mac will accomplish on its own.
When reviewing the merits of the book, *The Grapes of Wrath*, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of the world today while older adults tend to relate it to the depression era it describes.

**Figure 5.5.** Report with margins set

When reviewing the merits of the book, *The Grapes of Wrath*, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of the world today while older adults tend to relate it to the depression era it describes.

**Figure 5.6.** Report with 1½ line spacing
Now select the third block for double spacing. The result is shown in figure 5.7.

The screen is not large enough to display the entire text with double spacing. To view the entire text, simply scroll down the screen using one of the three methods described in chapter 3.

Now we can set the justification of the report format. Notice the four additional blocks to the right of the spacing blocks. These are the **justification blocks**. They operate in a manner identical to the spacing blocks, and represent left, center, right, and full justification, respectively. Left justification is preset as was the single-space block. It allows you to write in a normal fashion with all lines left justified. Select the second box. As the block depicts, each line is now centered between the margin markers. This feature is useful when formatting title pages. Select the right justification box. The display is now right justified. You may occasionally require right justification for special purposes such as poetry. Finally, select the full justification block. What you see now is the desired result for the assignment. All lines are fully justified to both margins. The completed version appears in figure 5.8.

Notice the two smaller blocks to the left of the spacing blocks. These hold pictures of the **regular and decimal tab markers**. The Mac operator may set up to ten tabs in 1/16 inch ruler graduations. To illustrate this function, let’s create a table for the report. Before entering the table, let’s set the tabs. For the moment, reset to single spacing. Now both the ruler and the end of the text appear on the screen. As you did with the margin markers, grab the place the tab marker at the 3 inch mark. Notice that the icon itself does not move, but a copy of it appears and moves with the arrow. When setting any new tab, a new icon copy will appear. If you decide not to set a tab or wish to erase one, simply move the marker away from the graduated line and release the mouse button. In a like manner, position a decimal tab at the 5 inch mark. To distinguish
When reviewing the merits of the book, The Grapes of Wrath, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of

Figure 5.7. Report with double line spacing

When reviewing the merits of the book, The Grapes of Wrath, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of

Figure 5.8. Report with full justification
between the two sorts of tab markers, the decimal marker has a decimal point in the center while the regular marker is blank. Notice that a regular tab appears preset at 5½ inches for the operator's convenience.

The blinking insertion point should appear at the end of the text. If not, position the edit bar to any point following the last sentence and press the mouse button. The bar should appear in the appropriate place. Hit Return twice. You have skipped one line in the text. Your screen now appears as in figure 5.9.

Enter the following keystrokes. Note the instructions enclosed in parentheses.

<table>
<thead>
<tr>
<th>(Tab)</th>
<th>Hard cover</th>
<th>(Tab)</th>
<th>$24.98</th>
<th>(Return)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Tab)</td>
<td>Soft cover</td>
<td>(Tab)</td>
<td>$5.99</td>
<td>(Return)</td>
</tr>
</tbody>
</table>

As shown in figure 5.10, the table is entered with the first column aligned to the first tab marker and the numbers' decimal points aligned to the second. Any number entered after tabbing to a decimal tab will align along the decimal points, so the Mac will backtype all characters before the point. This applies not only to numbers, but to any characters entered.

Finally, a tab cannot be placed outside of a margin marker. If you attempt to move a tab to within a 3/16 inch distance from a margin or beyond and release the mouse button, the tab will disappear. If you attempt the reverse with a margin marker, it will stop at a 3/16 inch distance and move no further.
When reviewing the merits of the book, The Grapes of Wrath, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of

Figure 5.9. Report with tab markers set

When reviewing the merits of the book, The Grapes of Wrath, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of the world today while older adults tend to relate it to the depression era it describes.

Hard cover $24.98
Soft cover $5.99

Figure 5.10. Report with table
INSERTING AND REMOVING RULERS

MacWrite allows the user the option of inserting rulers and thus altering format at any point in the text. To illustrate this, let’s create the same table we used when discussing tabs, only this time we will use rulers.

Place the edit bar behind the word “describes” at the paragraph’s end and press the mouse button. The insertion point now appears between the invisible return character and the ending period. Next, select Insert Ruler from the Format menu. What appears is a copy of the ruler. When inserting any number of rulers, each ruler always appears as a copy of the one immediately above it. In order to localize the effect of the ruler changes, we will insert another ruler after the table. Scroll the second ruler to the top of the window. Place the insertion point at the end of the text as described earlier, and select Insert Ruler again from the Format menu. Scroll to the top of the text and reset double spacing as per the assignment. In a like manner, scroll to the third ruler and set double spacing there as well.

You have now isolated the table format from the rest of the text. Position the edit bar before “Hard” and press the mouse button. Type Backspace to remove the tab character. Repeat for the second line. Remove the first tab marker from the table’s ruler and position the indentation marker at 3 inches. The table now appears as before. The advantage to this formatting method is that it is not necessary to hit the Tab key before beginning each entry. To illustrate, place the insertion point after “$5.99” and type:

(Return) Deluxe package (Tab) $31.50

The result should resemble figure 5.11.
You may have noticed that the last operation caused the numbers to jump around on the display. When you removed the tab character, the text adjusted so that the first tab character aligned with the first tab marker. Any subsequent tabs and markers would behave in a similar manner. When you removed the first tab marker, the numbers returned to their original position.

Often, while working with MacWrite, you may find the rulers distracting. You have the option of hiding the rulers from the display to more easily picture the final result. Select **Hide Rulers** from the format menu. Although the rulers are now invisible, their effect remains. If, at some point, you wish to review or change the ruler settings, you can easily redisplay the rulers. By pulling down the Format menu, you can see that the **Hide Rulers** option is now replaced by **Show Rulers**. Select this
option. Your report now appears as before. It will most likely scroll to the top of the text through the process, requiring a readjustment to the desired point. You may select Show or Hide Rulers as many times as desired with no effect on the final product.

**HEADERS AND FOOTERS**

We are now ready to discuss the top and bottom of the page. Setting the top format, the **Header**, and the bottom format, the **Footer**, is accomplished in a manner similar to the operations already performed. You may want to have certain information printed in the Header or Footer. MacWrite features this option as well.

Select **Show Header** from the Format menu. The result appears in figure 5.12.

What you see is a new window entitled Header featuring:

- Insertion point
- Ruler (assuming Show Rulers is chosen)
- Three new symbols

The insertion point blinks at the beginning of a page. This will represent the heading of each page in the text. Any symbols placed there will result in the editor positioning the prescribed characters in that spot on each page. We will discuss one exception, the **Title Page** option, a little later.

The first of the three blocks contains a number sign, #, and represents **page number**. A page number will appear at the indicated position on each page in the text. Using the mouse, place this icon in the upper right-hand corner of the page. Notice that the block cannot be placed below the line containing the insertion point. No icon may appear below the last line of the Header.
The page in the window behaves much as the MacWrite text page did except it is only seven lines long. The page can be extended to nearly a third of the page by altering the space blocks. Suppose we wish to skip three lines in the text before starting a page, and we wish to place the page number on the second line. By choosing Show Header, the editor will skip one line. To skip the three lines for the Header, hit Return twice.

Now that the insertion point is lower, you can replace the page number icon. Move it down one line. Let us further suppose that we want the heading, "Book Report: The Grapes of Wrath," to appear centered on the second line. Move the insertion point up one line by placing the edit bar one line above its present position and pressing the mouse button. Now type the heading listed above and reset to center justification. Do not type Return after the heading as a Return character is already present.

The two remaining icons represent date, \( \text{date} \), and time, \( \text{time} \). To illustrate their functions, position the date icon in the upper left-hand corner and the time icon directly below it. The icon position indicates the place where the first character of the time, date, or page number will appear. The Header window appears as in figure 5.13.
Position the arrow within the report text and press the mouse button. The text now appears with the new heading. Note that with the text double spaced, spacing begins before each new line. Therefore, four lines are actually skipped before the text is printed. There are 4½ lines per inch of paper. Each subsequent page in the report will have the Header repeated with the appropriate page number, time, and date inserted. The time will continually update while the document is open.

Now choose **Show Footer** from the Format menu. The display now appears as shown in figure 5.14.

The Footer acts in a manner identical to the Header except that it appears at the end of each page in the text. For the sake of brevity, we shall not elaborate further on Footers. For this example, you may fashion the Footer in any manner desired.

Unlike the Rulers, the display of the Header and Footer has an effect upon the report format. Choose **Hide Rulers** and **Hide Header** from the Format menu. The report now includes only the text. When printing the report with the Hide Header option, the Header also will not appear on the paper. The Footer utilizes the same rules. If you wish the Header or Footer to appear in the final report, you must select the **Show Header** and **Show Footer** options and then place their windows behind
the text by positioning the arrow within the text area and clicking the mouse. The Header and Footer windows remain in place. Shrinking the text sheet with the size box will reveal them. With the Header and Footer set behind the normal sized MacWrite text window, small gaps exist at the extreme right and left where you may carefully position the arrow and call the two windows forward one by one. If this is not successful and you wish to view or alter one, either alter the text window size or choose Hide Header (or Footer) followed by the reverse command. The appropriate window will appear. However, in order to alter the window beyond inserting characters or moving existing icons, the Show Rulers option must be selected. The text with completed Header appears in figure 5.15.

Often, when writing a paper, the author will not want the Header to appear on page one. MacWrite's Title Page command allows for this. As implied, this command will blank all characters appearing in the Header for page one. The editor merely skips the appropriate lines before printing the text. Select the Title Page option from the Format menu. Notice the adjustment in the text. Now pull down the Format menu again. The Title Page option appears with a check mark next to it indicating it is set.
When reviewing the merits of the book, The Grapes of Wrath, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, school children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of the world today while older adults tend to relate it to the

Figure 5.15. Completed Header with text

Editing

To this point, we have discussed entering and formatting a report. These discussions have entailed a small amount of alteration to the content of the text. To accomplish this we have moved the insertion point about the document and removed some characters using the Backspace key. These functions, although necessary to accomplish the examples thus far, properly belong under the heading of editing functions. To that end, we will elaborate and expand on the editing functions previously learned.

Before proceeding, let's determine a definition for editing characters. Quite simply, a character is any keystroke which causes an action in the text. This includes all keys except:
The first three keys are included because, though they do cause some action in the text, they require another keystroke in order to have an effect. The **Command** key is used in conjunction with the edit functions as an alternative to the mouse. The last key, **Enter**, has no effect on the MacWrite document.

**THE INSERTION POINT**

By now you know that the flashing bar, known as the insertion point, determines the point where all text edits are made. The sole purpose for the edit bar, \( \_ \), is to manipulate the insertion point. Notice in our report that the edit bar will not appear within the Header or Footer. This is due to the fact that these can only be edited within their windows.

Placing the insertion point takes a good deal of practice and requires adherence to a very strict set of rules. Although problems can be avoided by placing the edit bar in the desired spot, it is helpful to understand the tolerance to that placement. In normal text, proper placement between characters occurs when the bar is situated between the centerlines of the characters on either side. For placement at the beginning of a paragraph where there is an indentation, place the bar anywhere in that line before the first character.

To place the point at the end of the paragraph, position it between the ending character and the end of the line. Picture the Return character as occupying the empty space at the line's end. Inserting the bar in this space will place the insertion point before the Return character. The case of a tabbed space is the
reverse. Placing the bar within this space will move the insertion point to the spot just before the following character. With a text having multiple rulers, placing the point anywhere before a ruler will extend the conditions of the preceding ruler. To place the point after a ruler, the edit bar must be within that ruler's domain.

Practice positioning the insertion point at various places in the text. Once you have mastered this technique, you will find it much easier to use the functions we are about to explain.

**CHARACTER SELECTION FOR EDITING**

Editing tasks often include deletion of a character or group of characters. This may or may not be for the purpose of replacement with other characters. So far, the only deletion technique used has been backspacing through individual characters. This method can be used for deleting any portion of the text. A more efficient method is selection of characters for deletion or replacement. MacWrite features three techniques for character selection.

The first technique is only valid when specifying single words. Again, we define a word as on page 126 without any ending punctuation such as a period or comma. To illustrate, let's select the word "school" from the third line of the text. Position the edit bar somewhere within the word and double-click the mouse. The word is inverted, as depicted in figure 5.16, showing that it is selected. Do not touch the keyboard as this will alter the text.

To unselect characters, place the edit bar anywhere in the text, including within the selected word, and click. The insertion point appears at that point.

Secondly, the operator may use dragging in the manner described in chapter 3. Unselect the word "school." Position the edit bar before that word and drag across it. The word is again
When reviewing the merits of the book, The Grapes of Wrath, by John Steinbeck I noticed that the book may be enjoyed on many levels. First, children can see it as an action-packed adventure story. Second, high school kids often see it in the classroom where they discuss many of the underlying concepts. Third, adults find it good reading in its own right. Young adults often relate it to strife in many parts of the world today while older adults tend to relate it to the

Figure 5.16. Word selected for editing

selected as shown in figure 5.16. This method is useful when selecting any number of characters from one to the entire text.

To select more than one line, place the edit bar at the beginning point and drag to the ending point. The path taken between start and finish is not important as long as the mouse button remains pressed during the operation.

Character groups extending beyond the display can be easily selected as will be shown in the following example. To begin, make sure that the text is scrolled to the top. Select the last two sentences in the text by dragging from the word “third” in the sixth line to the extreme bottom of the page. The text will scroll until the edit bar is raised. Then place the edit bar at the end of the last sentence and release. The result is shown in figure 5.17.
The third selection method has the same scope as the preceding method but is easier to use. To illustrate this method, unselect the lines and place the insertion point before the word “third.” You should be able to do this in one step. Now place the edit bar after the period in the last line. Press the Shift key on the keyboard and click the mouse. The lines are selected as before.

DELETION AND INSERTION

To delete a selected character string, simply press Backspace. If you wish to replace one word with another, select the word to be replaced and type the new one. At the first keystroke, the old word will disappear. The new characters will
appear as they are keyed in. To illustrate this concept, select the word “kids” in the fourth line. Now type “children.” Notice that the editor adjusts the text for the new word.

When polishing a report, you may decide to move words around within the text or from one text to another. To accommodate this, MacWrite has three options under the Edit menu:

- Cut
- Copy
- Paste

These allow MacWrite to utilize the Clipboard mentioned in previous chapters. Any characters transferred to the Clipboard will replace previously existing characters.

Let’s start by cutting the word “school” in the third line. Select the word and choose Cut from the Edit menu. Now choose Show Clipboard. Notice the word appears there. Close the Clipboard window or choose Hide Clipboard.

Place the insertion point before the word “classroom” in the fifth line and choose Paste from the Edit menu. The word is inserted in that spot. Notice that the word remains on the Clipboard and is copied to the text.

The Copy command is better suited for copying or transferring characters to another spot in the text. It operates the same as the Cut command, except that the selection is not removed from the text. The Copy command is useful when copying a catchy phrase or word that is difficult to spell.

Any part of the text may be cut, copied, or pasted as long as sufficient memory is available. Since rulers are parts of the text, they may be deleted or transferred as well.

Since the Clipboard is a separate file, you may use it to transfer characters between windows. For example, to transfer from one document to another, simply cut or copy to the Clipboard, open the new document, and paste. Other sources
of information for a document include the Scrapbook, Notepad, Calculator, and Alarm Clock. To cut or copy information from any of these sources, open the desired window and choose the option. The Cut and Copy commands have the same effect on the Alarm Clock since that information cannot be deleted. A copy from the alarm clock will copy both time and date in that order.

A common editing phenomenon occurs when the user edits a portion of text and then decides that the original version was better. To reverse the previous action, MacWrite features the **Undo** command. Pulling down the Edit menu reveals either **Can't Undo** or **Undo** followed by one of several possible options. These options include Undo:

- Typing
- Cut
- Copy
- Paste
- Insert Rulers

These are the most commonly used options. Nearly every text change can be undone. After an Undo option has been performed, **Redo** will replace Undo in the Edit menu. This command will reverse any Undo. **Undo Typing** will remove all text entered since the last insertion point repositioning. Any action executed after the one undone will remove the Undo option as well as the Redo option. The Edit menu will indicate whether the option is available in each case.
Saving the Document

In most cases, the operator will need to save the MacWrite document for future reference. Several methods are available for saving a document. The most simple of these is to choose Save from the File menu. After about ten seconds, the new document will appear on the disk replacing the old version. You may wish to save documents at regular intervals to avoid losing work due to a power interruption.

In addition, several other commands will initiate the Save procedure. If a MacWrite document has been altered in any way, or if it is a new document, the Close command will initiate the window shown in figure 5.3. You may have used this window when taking breaks. A new document will then give rise to figure 5.4 as well. Choose Text Only to save the text without formatting, pictures, and special menu options such as fonts. You can open a text-only document only from the finder. Certain Mac applications only accept the text-only form of a MacWrite document. Follow the instructions and give the appropriate responses to obtain the desired results.

In a like manner, the Quit command will give rise to the box shown in figure 5.18.

![Figure 5.18. Dialogue box for Quit command](image-url)
One other Save operation is the temporary Save used when printing a document. If a document has been altered, and you wish to print it before any Save operation, the Mac will display a box telling you that it is saving the text during the print sequence. This is removed from disk after printing.

Sometimes, you will want to save both the new and old versions of a document. Since the Mac does not allow two files of the same name on the same disk, MacWrite features the Save As command. Selecting this option will prompt the box depicted in figure 5.4 with the present document name displayed in the space, highlighted for editing. Substitute a different name in its place and select Save to complete the sequence.

### Printing the MacWrite Document

This section is intended for readers using a Macintosh with the Imagewriter printer.

Before printing the MacWrite document, you may need to specify the paper size being used and the orientation of the printer. With the Sample document displayed, select Page Setup from the File menu. The window shown in figure 5.19 will appear.

Preset options are US Letter, which is normal 8½ x 11 inch paper, and Tall orientation. The latter option is for printing the text in standard fashion from top to bottom. The optional paper types are:

- US Legal -- 8½ x 14 inches
- A4 Letter -- 8¾ x 11 2/3 inches
- International Fanfold -- 8¼ x 12 inches
Exploring MacWrite

The optional orientations are:

- Tall adjusted -- to print correctly proportioned pictures
- Wide -- to print sideways (top line down the right margin)

Normally, these options need no adjustment, but are provided for special applications. Make the selections and select OK to set them or Cancel to negate the changes.

Now we are ready to print the report. Select Print from the File menu. The box appears as shown in figure 5.20.
Set the appropriate options as needed.

**Quality**
- High -- all lines printed twice as displayed on the screen
- Standard -- all lines printed once
- Draft -- all lines printed once in small print

Speed of printing increases from High to Draft quality.

**Page Range**
- All -- the entire text
- Selected pages

**Paper Feed**
- Continuous -- form feed computer paper
- Cut Sheet -- individual sheets

Select OK or Cancel after selecting the option.
The Mac may then save the document. Afterwards, it will display a box indicating that the print sequence has begun. Press Command and Period to terminate printing. If **Cut Sheet** is selected, the Mac will ask for a new sheet of paper, stop, and wait until OK has been selected before continuing to another page. This message may appear before the printer is finished with a page. This is due to the fact that the Macintosh operates faster than the Imagewriter. Wait for the page to be completed and insert the new page before allowing the Mac to continue. The Imagewriter will print the text page, and then return to print the Header and Footer.
Disk Storage

When using MacWrite, the operator may wish to review or change a document existing on the disk. To do this, exit the present document and select Open from the File menu. A window appears accompanied by three option boxes:

- Open
- Cancel
- Eject

To open a file, select its name with the pointer and then select Open. Alternately, the operator can open a file by double clicking with the arrow on the file name.

The Cancel option has appeared with other windows. It serves to negate the selection process.

If the desired document is not present but appears on another disk, select the Eject option, and the disk will eject. Insert the proper disk, and the window will appear displaying the new disk’s MacWrite documents. The scroll bar becomes active should there be more titles than can fit in the box provided. Selecting a document will cause the disk to eject, and the Mac will request the initial disk. Follow this and any other disk-switching instructions to obtain the desired results.

When dealing with the Finder, the documents will appear as document icons. The operator may wish to organize files on disk by moving documents to folder areas. If a document is within a folder, open the disk icon, then the applicable folder icon to display the document icon. Open the document by simply opening its icon. The document will appear as it was saved including insertion point placement.
Menus

The MacWrite menus feature several options which are peculiar to MacWrite. We will discuss them here.

APPLE MENU

The Apple menu for MacWrite operates exactly as it did under the system disk with the exception that “About the System Disk” is replaced by “About MacWrite.”

FILE MENU

The File menu features commands which you have used extensively to this point.

- New -- creates a new document
- Open -- accesses the Open window
- Close -- closes a document
- Save -- saves on disk replacing the old version
- Save As -- saves a second document with a new name
- Page Setup -- accommodates special paper needs
- Print -- starts the print sequence
- Quit -- used to exit MacWrite

EDIT MENU

This menu also includes options covered in detail in previous sections.
• Undo/Redo -- used to negate or restore recent actions
• Cut -- to remove selections to the Clipboard
• Copy -- to copy selections to the Clipboard
• Paste -- to insert selections from the Clipboard to the document
• Show/Hide Clipboard -- displays or hides the Clipboard

SEARCH MENU

This menu features two commands not discussed thus far. These are the Find command and the Change command.

The Find command will search out and highlight any group of characters for editing. To illustrate, access the Sample report and scroll to the top of the page. The Search function will start at the insertion point, so place it at the beginning of the text. Select Find from the Search menu. The window appears as shown in figure 5.21.

Type "the" into the box. Notice that the Find Next block becomes active at the first keystroke. In this case, we are looking for a word isolated by space characters, so keep Whole Word selected. This keeps the Finder from finding "the" as a sub-part of another word such as "they."

Figure 5.21. Find window
Select the Find Next block. The first occurrence of the word after the insertion point is highlighted. To edit the word, place the document window on top and follow normal edit procedures. Return to the Find window by reselecting Find, or move the document window out of the way and access it.

Continue to search through the document until the end is reached. If the characters do not appear between the insertion point and the end, the Mac will display a box to that effect. Select OK from it and proceed to the next operation. The Find box can be altered at any time. Notice that the form of the word is not important. It can be capitalized or not, and it can appear in any font, or style with the same results.

The Change command gives rise to the box shown in figure 5.22.

The first blank, Find what, serves the same purpose that it did for the Find command. The second blank, Change to, will hold the characters for substitution. Once the proper characters have been inserted, the boxes will operate much as the Find box did. The Find Next option operates in the same manner. Change All will make the changes in all cases found in the text. However, this option is not Undo-able. These two options immediately become active once characters appear in the boxes.

![Figure 5.22. Change window](image-url)
The second box, **Change, then Find**, will change a found case and then search out the next. The third option, **Change**, will perform the change and wait for further instructions. The center two boxes become active once the case has been highlighted. These options are designed for selective changing of only certain cases in the text.

**FORMAT MENU**

This menu has been discussed extensively with two exceptions, **Set Page #...** and **Insert Page Break**.

The Set Page #... command is useful when incorporating selections covering more than one document. Suppose one document contained nine pages of a fifteen page report. The second document should start with page ten, but MacWrite documents are normally sequenced starting at page one. To remedy this, display the second document and choose Set Page #... from the Format menu. The box appears as shown in figure 5.23.

The present first page number appears in the box. Enter the new page number in the box and select OK or Cancel as desired. The first page of the document now appears with the new numbering. All successive pages are numbered accordingly.

![New page number?](image)

**Figure 5.23.** Set Page #... box
The final Format option is Insert Page Break. This is useful when writing selections with multiple parts or chapters where the author wants to begin a chapter with a new page. Selecting this option, the MacWrite editor will end the page at the insertion point and move the point to the top of the next page. This can also be used to insert a break at any point in an existing text.

Many dialogue boxes feature a response already highlighted. These include figures 5.3 and 5.18. When such a box appears, the operator has the option of either using the mouse to respond or selecting the highlighted option alternately by pressing either the Enter or Return keys.

**FONTS**

The MacWrite word processor allows output of customized writing that is professional in appearance. To better facilitate artistic style, the Font and Style menus are provided.

The font menu features several fonts indicative of many locations around the world. Because these fonts tend to be identified with cities around the world, they bear their names. The first font, New York, is preset any time you use MacWrite. To use any other, simply select that font and begin typing. The check mark will move to indicate the selected font. To change the font of existing text, first select the characters, then select the font. The change will appear. A selection follows which illustrates different fonts.

**STYLES**

Stylistic options are also available within each font under the Style menu. The author may write:

- Bold
- Italic
Underline
Outline
Shadow

These are alternatives to plain text writing. The author may choose any one of these or any combination which best suits his or her needs.

Often, the written word is best expressed in a different size. The second half of the style menu provides for this. Examples of style options appear in New York font in figure 5.25. Twelve point is the standard size. One point equals $1/72$ of an inch. Therefore, a 12 point character is $1/6$th of an inch high.

When all else fails use the New York font.
But, you may like to use the Geneva font.
The Toronto font may be easier to read.
The Monaco font may appear more international.
However, the Chicago font is bolder.
The Venice font is nice for informal occasions.
But, the London font may look more scholarly.
When in Greece, you use the Athens font.
The San Francisco font is the most distinctive.

Figure 5.24. Font examples
Any font may appear in any combination of styles at any size. To change the style of a selection from a document, select plain text and then set the proper style.

Plain text may do in most cases.

Some words may best be typed Bold.

Use Italic style to catch someone’s eye.

You may prefer to Underline some words.

Make it stand out, Outline a word.

OK, but Shadow style may do as well.

Or, use all at once.

Small words appear in 9 Point text.

Most use 12 Point text.

14 Point makes it a bit bigger.

But, not as big is 18 Point.

24 Point is the biggest.

Figure 5.25. Style sample
Introduction

Apple's MacPaint program allows the output of sophisticated graphic designs using the Mac. The strength of MacPaint lies in its simplicity. As with MacWrite, MacPaint does not require that the operator enter special characters. The mouse can perform nearly every manipulation needed to create artistic drawings, electronic schematic diagrams, charts, and graphs. The output that can be created with MacPaint is limited almost solely by the operator's imagination.
This chapter is devoted to the study of MacPaint. It will begin with a discussion on how to access the MacPaint document. Next, we will discuss the drawing tools used to create the illustrations, followed by a discussion of shapes and patterns which are not drawn, but which are guided into the proper proportions. The chapter will continue with a section on manipulations both of the images on the page and of their contents. Then we will cover the special menu options available and the special functions augmenting those menus.

**Originating the MacPaint Document**

The operator can originate a MacPaint document in one of two different ways:

- From the Desktop
- From MacPaint

These techniques as well as those used to access an existing document are exactly the same as those used when dealing with MacWrite.

To originate a MacPaint document from the Desktop, simply open the MacPaint application icon. The document will open revealing the MacPaint display shown in figure 6.1. The display includes six parts:

- MacPaint document title bar
- Drawing surface
- MacPaint tools
- Border width selection box
- Pattern boxes
- MacPaint menu bar
Figure 6.1.  a, Title bar; b, Drawing surface; c, Tools; d, Border width selection box; e, Pattern boxes; f, Menu bar

The drawing surface represents the user’s access point to the MacPaint document. All drawing will occur within this area. The tools are used to draw images and to manipulate them. The border width selection box allows the user to choose the border widths when drawing shapes or to choose no border at all in certain cases. The pattern boxes are for filling in the various shapes with selected patterns. For the most part, the menu bar duplicates those used in MacWrite. However, several other options appear which are essential to MacPaint operation.

To explain the second method of originating a MacPaint document, close the new document by clicking the close box in the left corner of the title bar. Now select New from the File menu. The new MacPaint window will then appear.
Accessing an Existing MacPaint Document

There are two different sources which the operator can use to access an existing MacPaint document:

- From the existing disk
- From an alternate disk

To call up an existing document from the present disk, use the same method used for MacWrite. Either open the document's icon from the Finder, or choose Open from MacPaint's File menu and open the appropriate document.

The method for opening a document from an alternate disk is also the same as for MacWrite. From the Finder eject the startup disk and insert the disk containing the MacPaint document. Either the startup disk or the alternate must contain the MacPaint application. If it does not appear, the Mac will not access MacPaint documents. Since two disks are involved, the Mac will need to refer to both of them. This involves a number of disk-switching operations which soon become quite tiresome. Perhaps a future addition to the Mac's memory will help this problem, but in the meantime the owner may wish to use the optional second disk drive.

To avoid disk-switching, insure that the alternate disk is also a startup disk* and that it features MacPaint. Eject the first disk and turn off the Mac. This erases the contents in RAM memory. Now that the Mac's memory is cleared, restart the Mac and insert the alternate disk. If this disk contains the System icon but not the Finder, the Mac will stop but will not eject the disk. To retrieve the disk, turn the machine off and then on. Then press the mouse button. Assuming the alternate disk is a startup disk, access the document from the Desktop as you would normally.

* A startup disk must contain both the System and Finder Mini-Mac icons.
The Drawing Tools

THE DRAWING SURFACE

The MacPaint drawing surface is a portion of an entire page measuring 8 x 10 inches. The surface is composed of several thousand square segments (or pixels) which are selectively turned black or allowed to remain white to create the image. The drawing surface measures 416 x 240 pixels for a total of 99,840. Due to this large number of dots, each one blends in with its neighbors to give the impression of a continuous image. The entire page contains 720 x 576 points totalling 414,720 altogether. The printer will print each pixel in an area of .00019 square inches.

THE PENCIL

There are five drawing tools available with MacPaint:

- The pencil
- The paint brush
- The spray can
- The paint can
- The eraser

The pencil is used to draw lines on the drawing surface. To illustrate the different tools, let’s draw the picture shown in figure 6.2.

After following these instructions, the Mac operator should begin to understand MacPaint operation and should be able to draw a reasonable facsimile of the drawing. Let’s begin by drawing the tree trunk. Use the mouse to insure that the pencil symbol is selected by clicking it. Now move the pointer onto the drawing surface where it is transformed into a pencil. Lines will appear at the tip of the pencil as it is clicked and dragged. Draw the tree trunk as shown in figure 6.2. If your rendition is unacceptable, read ahead to the section on the eraser and change it, or leave it for now. Your drawing might resemble that shown in figure 6.3.
Figure 6.2. MacPaint picture

Figure 6.3. Use of the pencil
THE PAINT BRUSH

The next drawing tool, the paint brush, is used to create wide strokes on the drawing surface in any pattern desired. Since patterns will be discussed later, for now, we will use the paint brush with its preset pattern, black.

Select the paint brush and move the pointer to the drawing surface. The pointer switches to a small dot as it enters the drawing surface. This represents the width of the line that will appear. Practice using the paint brush by drawing the branches in the tree. The result appears in figure 6.4.

THE SPRAY CAN

The next tool, the spray can, works much like a real spray can. It allows coverage of a wide area, and as the can is repeatedly moved over the same area, that coverage becomes more dense.

Select the spray can. Notice, as the pointer moves onto the drawing surface, that the tool symbol switches to a circle filled with dots. When a dot passes over a block of the drawing surface, this block turns black resulting in a path designed with the spray can’s intermittent effect. Fill in the leaves of the tree by swirling the spray can around the branches. The result should resemble that depicted in figure 6.5.

THE ERASER

This tool is used to undo parts of the drawing. Click the eraser symbol and move the pointer onto the drawing surface. The arrow switches into a white box. While the mouse button is pressed, any dot over which the eraser passes will turn white. Practice by erasing an unsatisfactory portion of your drawing, or erase the whole picture and start again. Figure 6.6 shows the eraser in action.
Figure 6.4.  The paint brush

Figure 6.5.  The spray can
MACPAINT AND MEMORY OF EVENTS

The MacPaint document can be visualized as having two storage areas for information. These areas are the permanent image and the memory of the most recent event.

The permanent image is the area holding all picture information. The memory of the most recent event holds the information for the most recent action taken with the picture. Since the Mac remembers the preceding action, it can reverse that action. The operator can use the Undo command in the Edit menu to exploit this feature. Assuming no action was taken since the erasure, the action is reversible. Selecting Undo from the Edit menu will restore the action. Selecting Undo again will reerase that portion of the drawing. To erase further now would make it impossible to undo the first action. Only the most recent action taken with the drawing is reversible.
Erasing a section by erasing a portion, then releasing the mouse, and then erasing the rest would make the first part of the erasure irreversible. This applies to all actions taken with MacPaint.

**Lines and Shapes**

Now that we have discussed the rudimentary techniques of drawing and erasing, and have witnessed the versatility of alternately doing, undoing, and redoing an action, we can move on to more complex shapes.

**THE LINE**

Notice the line symbol to the left of the eraser. This feature allows the operator to draw a straight line between any two points.

To help provide a reference basis for our drawing, use the paint brush to create the outline of the hill. Since the paint brush will paint over the tree, you will need to break up the line. Now draw the kite string as shown in figure 6.2. Select the line, and place the cross hairs at the line’s beginning point. Drag the line to the point in the sky where the kite is positioned. Notice that the line originates at the point where the mouse button was pressed and extends to the cross hairs until the button is released. Since the line is now in recent memory, you can undo it if it is incorrect. The latest version now appears in figure 6.7.
Figure 6.7. The line

OPEN SHAPES

Five open shape options are available to MacPaint. They appear as the last five selections in the left column of the tools boxes. They represent:

- The rectangle
- The rounded rectangle
- The ellipse
- The irregular curved shape
- The irregular straight-sided shape

To illustrate these shapes, we will draw some of the objects in the scene. It does not matter where they appear on the surface. We will move them into proper position later.

Select the rectangle block and move the cross hairs to the drawing surface. Now, experiment with the rectangle. A rectangle will appear extending from the starting point to the
cross hairs as they are dragged across the drawing surface. Try to draw the body for the thermos on the picnic table. Undo the drawing or erase any mistakes.

The rounded rectangle is not a part of the diagram. However, we can easily experiment with it without damaging the picture. Choose the rounded rectangle option, and move the cross hairs to a clear area on the surface. As you draw the image, notice that the cross hairs do not coincide with the corner of the box. This is because the image appears within an imaginary rectangle extending from the origin to the cross hairs. The image is not squared, so it appears to not coincide. This can result in problems when attempting to center one image within another or when attempting to achieve exact positioning.

The ellipse operates as do the previous two shapes. Select this option and draw the sun over the hill. Notice the much increased problem with the coincidence of the cross hairs with the image. This can cause many positional problems.

One solution to the problem might be to draw a reference rectangle for the ellipse. Erase the sun and draw a long ellipse in the empty space as shown in figure 6.8.

Now try to draw a different ellipse within the first. It should be as wide but shorter than the first ellipse. It should touch the edges of the first one at the middle much like a cat's eye turned on its side. This example illustrates the difficulty of precise placement. Your results may have been similar to those depicted in figure 6.9.

You may have successfully drawn the ellipse on your first or second attempt, but doing so requires a keen eye and a bit of luck.
Figure 6.8. Elongated ellipse

Figure 6.9. Attempted double ellipse
Now, let's create the ellipse using a reference rectangle. Erase the two ellipses just created and draw a rectangle with the same width and height. We will begin and end all ellipses somewhere on the perimeter of this rectangle. Draw an ellipse by placing the cross hairs exactly at the upper left corner of the rectangle, and drag to the lower right corner. The exact positioning of the start and finish points is easy. Notice that the cross hairs turn white as they pass over the black portions of the screen. To position them on the upper left corner, insure that the lower and right arms of the cross hairs turn white indicating that they exactly outline the upper left corner of the rectangle. This is call the \textbf{dot inversion technique}. Now, draw the ellipse from that point to the opposite corner. It will exactly fit within the rectangle. The reference rectangle has enabled exact placement of the ellipse.

To place another ellipse within the first ellipse, place the cross hairs exactly on the left side of the reference rectangle and drag to the opposite side. It is simple to judge center placement since there is no question that the new ellipse will fit. The result is depicted in figure 6.10.

Though it may be possible to judge one concentric ellipse without the reference rectangle, it is much more difficult to judge multiple ellipses. A sample using this method is shown in figure 6.11.
Figure 6.10. Concentric ellipses

Figure 6.11. Multiple concentric ellipses
When the rectangle is no longer needed, simply erase it leaving the finished product. This erasure may be a bit tricky. Detailed work will appear later in this chapter.

The next shape to be drawn is the irregular curved shape. To make room for experimentation, erase the ellipses and select the next symbol.

Moving the cross hairs across the surface leaves a line following the path. These shapes are arbitrary and need not be closed. Though this procedure may seem to perform the same function as the pencil, this option has some important differences as we will see when discussing border widths. Doodle on the screen for a while to get the feel for creating irregular curved shapes using the cross hairs. Then erase the doodling and draw the cloud outline.

The last open shape is the irregular straight-sided shape which is used to create arbitrarily shaped polygons. Select this option and position the cross hairs. Click and move the mouse. Notice that a line extends from the point of the last click to the cross hairs. Click again and notice that the anchored point is now moved. Create several sides to the shape. The sides may cross one another with no ill effect. To terminate the figure, either double-click at any position or return the cross hairs to the origin and click. The line will no longer follow the cross hairs. Use this feature to draw in the kite on the end of the string. The drawing should now resemble that depicted in figure 6.12.
Figure 6.12. The irregular straight-sided and curved shapes

PATTERNS AND FILLED-IN SHAPES

A series of multi-patterned boxes are positioned along the bottom of the MacPaint display. These are the series of predetermined patterns available for use on the MacPaint document. Notice the larger block on the left. This is the current pattern block. It indicates the pattern presently selected. To select another pattern, simply place the arrow on the desired choice and click. Notice that the current pattern block reflects the change.

Patterns are available for three drawing tools:

- Paint can
- Spray can
- Paint brush

in addition to the five filled shape blocks which are located next to the open shape blocks.
The **paint can** is designed for use when filling white areas with a specific pattern. Be careful when using the paint can to fill a figure whose outline is not completely enclosed. If an attempt is made to use the paint can to fill such a figure, the paint will “spill” all over the drawing surface.

To illustrate, use the eraser to nick a small gap in the outline of the kite. Then, select the paint can and move to the drawing surface. The arrow becomes a replica of the paint can. The paint spilling out of the can indicates the sensing point for the tool. Placing the end of the spill on the space will color that space.

Try to fill in the kite. Select an appropriate pattern such as, the third from the bottom right on the display. Place the can in the kite and click. As explained earlier, the entire sky assumes the pattern. Select *Undo* from the edit menu to reverse this action.

Now use the pencil to close the gap in the kite’s outline. Try filling the space again. If you properly closed the gap, the kite should fill in with no trouble. If not, select *Undo* and try again. Use the line option again to draw in the crossbars on the kite using the dot inversion technique.

Use the eighth selection in the top row of patterns, to fill in the thermos. The drawing should now resemble that depicted in figure 6.13.

One other problem with the paint can is that the artist needs to be certain that the area to be filled in is not sectioned off by any lines. Had we tried drawing the crossbars before filling in the kite, we would have had to perform four separate operations to fill the kite.
Figure 6.13. Using the paint can

Drawing patterns with the spray can is quite useful. If, for example, you desired a very light dusting of color, the spray can would be best used with a lighter pattern. Choose the tenth pattern in the top row and choose the spray can. Use these to give the cloud a speckled appearance. Place the spray can tool on the cloud and drag it in a swirling motion. The cloud now appears more substantial. Using the black pattern would have resulted in the cloud being too dark.

The last drawing tool affected by the patterns is the paint brush. As described earlier, the paint brush is used to make broad brush strokes on the drawing surface. These brush strokes will be created using the pattern currently selected.

Select the line and draw the lightning bolt from the cloud to the ground. Do not be concerned about the line width as this will be changed later. Now select the second pattern,
the top row of patterns, and select the paint brush. Draw the hole in the ground where the lightning strikes. Now choose the ninth pattern in the top row, and draw the debris flying away from the hole. Notice that the new brush strokes completely cover the previous pattern. The latest version appears in figure 6.14.

In order to create filled shapes more easily, MacPaint features a second set of shapes which complement the open shapes. They operate in the same manner as the open shapes except that they fill in as they appear.

The rectangle, rounded rectangle, and ellipse all fill during their formations. The irregular shapes do not fill until they are complete. If the shape is open, MacPaint will close it by drawing a straight line from the beginning to the ending points.

Use the filled ellipse with the sixth pattern in the bottom row, to draw the watermelon. Experiment with the two rectangular filled shapes as well.

Use the irregular filled polygon, along with the fourth pattern from the right in the top row, to draw the picnic basket. A straight horizontal or vertical line is one with no small zig-zag breaks in it. Draw the basket with a straight top and bottom. For the sides, insure that the zig-zagging is the same on either side so as to create a symmetric appearance. Use the line or pencil to draw the handle of the basket. Erase errors and repeat if necessary.

The drawing should resemble that shown in figure 6.15.
Figure 6.14. The spray can and paint brush

Figure 6.15. Filled shapes
LINE AND BORDER WIDTHS

Our discussion thus far has been limited in that we have used only one line or border width in our drawings. A variety of line widths is necessary for precise graphics.

MacPaint offers several line width options. The border width selection box, located in the lower left-hand side of the MacPaint display allows the user to select the line width desired. Notice the second line width choice in this box. This is the standard line width. This is designated when a MacPaint document is opened or created. To utilize other widths, simply position the pointer on the desired width and click. The line and the borders of all future shapes will be altered to reflect the new line width.

Let’s choose the heavier fourth line width, to make the lightning bolt appear more forceful. Retrace the bolt and notice the effect on the scene. Experiment with different border widths and shapes. Notice that the cross hairs reflect the border thickness in each case. In terms of dots on the screen, the widths are eight, four, two, one, and zero.

ADDING TEXT WITH MACPAINT

Generally, text of some sort is required with a graphics display. MacPaint would, therefore, be remiss in not including provisions for lettering its images. Notice the large “A” occupying the second box down the right side of the tools options. Select this box and move the arrow to the drawing surface. The familiar edit bar appears. Move the bar to the desired location, such as the lower left corner of the drawing surface, and click. The flashing insertion point appears as it did with MacWrite.

The keyboard is now completely active as with MacWrite. Enter a caption for the picture. Choose whatever font, size, or style seems best from the appropriate menu. These may be
changed as desired while the insertion point is in place. When the insertion point is moved using the edit bar, the text portion becomes fixed, the actions becomes undo-able, and MacPaint no longer recognizes the letters as such. They are merely another set of dots comprising part of the whole drawing.

Figure 6.16 reflects the previous two changes to the drawing. Further examples of text entry will appear in the next chapter.

Manipulations

Our drawing, so far, has been a collection of images, some of which are misplaced on the screen. To avoid the difficulty with having to precisely place each portion of the picture, MacPaint features three manipulation tools:

- Selection rectangle
- Lasso
- Hand

Figure 6.16. Line width and text examples
THE SELECTION RECTANGLE

The selection rectangle is designed to move rectangular shaped portions of the MacPaint document. After selecting this option, which appears in the upper right corner of the tools boxes, the arrow changes into dashed cross hairs on the drawing surface. This feature functions in a manner identical to the selection and movement of multiple icons on the desktop. Position the cross hairs above and to the left of the picnic basket, and drag across it. The moving, dashed rectangle appears as with the Desktop case. Releasing the mouse completes the rectangle. Every portion of the block, whether black or white, is now selected. The cross hairs are reconverted into an arrow when moved into the selection rectangle. To move the selection, drag with the arrow across the surface. Notice that the rectangle's white portions supersede the surrounding drawing over which it passes. Figure 6.17 shows the selection rectangle after it has been moved to another position.

Figure 6.17. The selection rectangle
Movement with the selection rectangle is undo-able under the Edit menu. Selecting Undo will cause the rectangle to return to its previous position.

THE LASSO

For our purposes, it is often more convenient to move only those portions of a specified area which have been drawn rather than an entire rectangle.

The lasso is best used for this purpose. The lasso is located in the upper left-hand corner of the MacPaint window. After lasso has been selected, the arrow will replicate the lasso on the drawing surface.

The lasso’s sense point is the bottom tip of the rope. Place and drag the lasso around the thermos. It is not necessary to completely surround the thermos since the Mac will complete any unfinished circle with a straight line. Release the mouse and the area becomes selected. The selected area is not the outline created by the lasso, but the drawing within.

Place the lasso’s sense point on the selection. As with the selection rectangle, it is transfigured into an arrow. In the same manner, drag the selected object across the surface. Notice in this case, that the white area around the selection does not supersede the surroundings. The lasso option is ideal for merging two separate portions of a drawing.

Figure 6.18 shows the thermos after it has been moved. This action is undo-able.
THE HAND

The last manipulation tool is the hand. When discussing the MacPaint document, we mentioned that the drawing surface was part of an entire 8 x 10 inch page. The hand, which is located beneath the lasso, is used to move the drawing surface about that page.

Once the hand symbol has been selected, the arrow-shaped pointer will be transformed into a hand when it is moved into the drawing surface. Drag the hand upwards on the drawing surface until the tree is located at the top of the page. Notice that this action does not cause the images to move on the page. Instead, the drawing surface merely moves down the page. The Mac requires approximately four seconds to recompute the new placement. This option allows the user to create...
graphics on the entire MacPaint page. However, when reopening the MacPaint document, the drawing surface will appear in its original position regardless of its position when the document was closed. Figure 6.19 depicts the hand action.

**The MacPaint Menus**

Although MacPaint's menus are generally identical to those included with MacWrite, they include several important additions. Also, several of the commands that are identical to those found with MacWrite have new applications with MacPaint. The Apple, Font, FontSize, and Style menus will not be discussed here as they are analogous to those included with MacWrite.

![Figure 6.19. The hand](image)
THE EDIT MENU

Most of the MacPaint Edit menu commands are similar to those found with MacWrite. However, their functions differ.

The Undo command has been explained previously. It is used to reverse the last MacPaint action using MacPaint's memory of the most recent event.

The next three options, Cut, Copy, and Paste, perform the same functions as with MacWrite. However, they operate a bit differently. To illustrate, let's copy the watermelon and paste that copy below the tree. Normally, these commands are only useful when transferring images. MacPaint includes a special function (explained on page 207) which copies images more easily within a document than Cut, Copy, and Paste. In our example, however, we will use the Copy and Paste commands within the same document.

Using either the lasso or the selection rectangle, select the watermelon. Next, select Copy from the Edit menu to duplicate the watermelon on the Clipboard. This procedure requires approximately six seconds.

Now choose Paste to copy from the Clipboard to the drawing surface. Since the watermelon is automatically selected, it will not affect the surroundings over which it moves. If the lasso was used to select the watermelon, the copy appears adjacent to the original. If the selection rectangle was used, the copy appears on top of the original. In this case, it appears as if no copy had been created. In either case, position the selected copy as desired using the pointer. The original remains behind.

The Cut command functions as does Copy except that the original is erased.

In some instances, the artist may wish the copy's proportions to differ from the original. To accomplish this, simply cut or copy the selection. Then, draw a selection rectangle of the new size and select Paste. The object will be redimensioned accordingly. Figure 6.20 illustrates an object that has been pasted with both original and altered proportions.
The **Clear** command works the same as it did under the Finder (see chapter 3). Select a portion of the drawing surface and then select Clear. The selected area will disappear. This action can be reversed using the **Undo** command.

The remaining edit commands are peculiar to MacPaint and will require more study. Most of them, however, are self-explanatory.

The **Invert** command is used to invert the coloring of a selected area. Note that none of the lower five options of the Edit menu are available until an area has been selected. The lasso can be used to select an area in which only the Invert command is valid. The selection rectangle allows the use of all five options.

Select the copy of the watermelon. Then, select Invert. The white portions of the selection turn black while the black portions turn white. Reselecting Invert, or selecting **Undo**, will reverse the command.

**Figure 6.20.** Copy and Paste commands
The Trace Edges command will invert the object within the selection and trace its outline in black. If executed again, Trace Edges will reinvert and retrace the object. Each successive repetition of Trace Edges causes the object within the rectangle to be reinverted and retraced.

The tracings will extend to the borders of the selection rectangle. The tracings disappear as they pass through the borders of the selection rectangle. This feature is suitable for retracing a word or covering the entire drawing surface with an intricate pattern.

The two flip commands are essentially self-explanatory. Flip Horizontal exchanges the selection rectangle horizontally, while Flip Vertical exchanges it vertically.

The Rotate command rotates the selection rectangle and its contents 90° counter-clockwise. Note that a Flip Horizontal is not equivalent to two Rotates. With a flip, the item is mirrored about an axis. This contrasts with Rotate where the image rotates in a single plane. Examples of the Invert, Trace Edges, Flip Horizontal, Flip Vertical, and Rotate commands appear in figure 6.21. Note the positions of the small line drawn through the shape compared with the original.

THE GOODIES MENU

This menu is unique to MacPaint. It contains many options which are useful when creating graphics, or when a display must conform to some required set of specifications.

The first option is Grid. Imagine a grid pattern like that shown in figure 6.22a superimposed upon the MacPaint Document. The intersection of any two grid lines is defined as a grid coordinate. The vertical or horizontal distance between any two grid coordinates is eight pixels. Selecting the Grid option will constrain the cross hairs to move from grid coordinate to grid coordinate. They may not appear in any other location. Notice, by dot inversion, that the cross hairs appear within the grid example.
Figure 6.21. Edit menu options

Figure 6.22. The Grid option
The Grid option applies to all shapes except the irregular curved shape (filled or open). In addition, it affects the selection rectangle, alpha-numeric, and the line. This allows the artist to draw more accurately in graduated distances. Figure 6.22b shows an example of graduated drawing using the irregular straight-sided shape. Each corner of the drawing is a grid coordinate. Use the hand and eraser to make room and work the example shown.

The standard drawing surface is sufficient for most drawing needs. However, when outputting more detailed graphics, the artist will require more exact control of the placement of each dot on the screen. The creators of MacPaint designed the FatBits option to satisfy this need. Much of our example diagram could have been created more easily if we had used this option.

To use FatBits, simply select that option from the Goodies menu. The area where the mouse button was last pressed will expand by a factor of 64 to cover the entire window. A copy of the figure at its original size will appear in a block in the drawing surface’s upper left-hand corner. Figure 6.23 shows the FatBits version of the watermelon. If the mouse was not last clicked at the figure to be magnified, use a non-drawing tool, such as the hand, to click in the desired spot. Then select FatBits.

Any tool or shape can be used within the FatBits window. The pencil can be used in a more versatile fashion within that window. The pencil was first described as a line drawing tool. More accurately, it is a dot inversion tool. Normally, the pencil draws a black line on a white background by inverting the dots as it moves. When drawing on a black background, however, the pencil creates a line by turning every dot in its path white. As such, the pencil acts as both a fine drawing and erasing tool. In fact, the pencil could be used in this manner to draw the line through the watermelon. Notice that we have done so in our examples. You can draw this line by using the pencil.
While in the FatBits window, select the pencil and move the tool to the drawing surface. Now, press the Option key. Notice that the pencil switches to a hand. This method allows the artist to use the pencil and the hand while only selecting the former option.

To exit FatBits, either click in the block containing the original figure in the upper left-hand corner of the drawing surface, or reselect FatBits from the menu.

The next option, **Show Page**, is used to view the entire MacPaint document. The dotted line depicted in figure 6.24 indicates the location of the drawing surface within the document.

The Show Page option is useful in a number of circumstances. First of all, Show Page allows the user to view the entire page. Though the figures are shrunk so as to allow the display of the entire page, the proportions of the images within the page remain the same.
Show Page allows a repositioning of the drawing surface. First, place the arrow within that area. Now, drag the drawing surface around the page. The drawing surface box moves with the arrow within the boundaries of the page. A change will not be made until OK is selected. Select Cancel to redisplay the drawing surface in its original position. Practice by moving the drawing surface so that the picture is centered within it.

The operator can also move images about the page within the Show Page window using the pointer. Position the arrow on the page but outside of the drawing surface. Now, drag the example drawing around the page. Notice that the image will move partially or completely off the page. The lost portions of the image can be retrieved by pulling them back onto the page. However, if OK is selected, any portions of the document not appearing on the page will be permanently erased. This application of Show Page is useful when erasing a large section of the page.

The Show Page window appears in figure 6.24 with a portion of the original drawing slid off the page. Move the image to a position below the drawing surface rectangle, and select OK. The drawing surface now displays a blank portion of the page.

The next option under the Goodies menu is Edit Pattern. This option is used to custom design a pattern for use in drawing. Selecting this option will reveal a window containing two boxes such as the one shown in figure 6.25.

To alter the pattern, use the arrow to click in and click out the blocks in the left-hand box. The box on the right will show the effect of the change. Select OK to set the change and Cancel to negate it.
Figure 6.24. Show Page window

Figure 6.25. The Edit Pattern window
Any pattern change will be made permanent for that document. The change will not affect patterns for other documents. Avoid altering a preset pattern unless you have recorded the original for future reference. Creating new patterns from the pure white or black choices may be the safest option in this case.

The Brush Shape command gives rise to the window shown in figure 6.26.

The heavy box within the window indicates the present brush shape. To alter it, simply position the arrow on the desired brush shape and click. The window will vanish leaving behind the drawing surface and the new brush shape. The brush now operates normally except that it creates graphics using the new shape. The dotted shapes do not operate like the spray can as you might expect. Instead, they draw continuous figures. Figure 6.27 depicts a figure created with the slanted brush shape.

![Figure 6.26. The Brush Shape window](image)
The final drawing option available with the Goodies menu is **Brush Mirrors**. Selecting this choice will reveal the box shown in figure 6.28.
Let's begin our discussion of Brush Mirrors by erasing the last drawing we created and selecting Brush Mirrors. The crossed lines indicate the axes about which the drawing will be created. To select one, a few, or all axes for drawing, place the pointer on the line representing the desired axis and click. The selected line will thicken. To remove the Brush Mirrors option, choose None from the Brush Mirrors window or unselect all axes from the window and select OK.

The vertical axis represents an imaginary vertical line drawn down the center of the drawing surface. Any figure drawn with the paint brush on one side of this line will be duplicated in a mirror image on the other side as shown in figure 6.29a. With the horizontal axis selected, figure 6.29b shows that any drawing created in the upper portion of the drawing surface will likewise be mirrored on the bottom part of the surface. The diagonal axes operate the same as the horizontal and vertical. Picture an imaginary diagonal line appearing at 45 degrees through the center of the drawing surface. Since the drawing surface is rectangular and not square, the diagonal will not extend from corner to corner on the surface. Because of this, there is a region on the drawing surface on which there is no corresponding mirroring area across the diagonal. Figure 6.29c shows this effect. Figure 6.29d shows the artistic potential of using all mirrors at once.

The next two options in the Goodies menu are informational in nature. The first, Introduction, is a quick reference guide to the basic operation of MacPaint. The window is repeated in figure 6.30.
Figure 6.29.  

**a**, Vertical mirror

Figure 6.29.  

**b**, Horizontal mirror
Figure 6.29.  

- **c.** Diagonal mirror

- **d.** All mirrors selected
Figure 6.30. Introduction window

The last option, Short Cuts, illustrates many of the special commands available with MacPaint. Further discussion of this feature appears on page 203.

THE FILE MENU

The File menu features many of the same commands available to MacWrite. The following commands operate identically to MacWrite:

- New
- Open
- Close
- Save
- Save As
- Print
- Quit
The remaining options are:

- Revert
- Print Catalog

The Revert command allows the artist to cancel changes to a document and recall the saved version without the need for closing and reopening the document. When Revert is specified, the dialogue box shown in figure 6.31 will be displayed.

![Figure 6.31. The Revert box](image)

Select OK, or press either the Return or Enter keys to recall the saved version. Select Cancel to redisplay the present version.

The Print Catalog command results in miniature version of all MacPaint documents residing on a disk being output to the printer. The document title will be displayed underneath each miniature illustration as depicted in figure 6.32.
Figure 6.32. The Print Catalog option

Constraints and Special Functions

We will now discuss the optional commands available in the Short Cuts window. These serve as productivity aids for the experienced MacPaint artist. Figure 6.33 depicts the Short Cuts window.
In the following sections we will use the terms constrain or constraint several times to describe several different functions. In this context we refer to constraining the direction of movement. This means that the constraints will limit the movement of the tool being used to a specific direction. This direction might be horizontal, vertical, or, in some cases, diagonal. There are two sections dealing with constraints. First we will discuss constrained manipulation, then we will cover constrained drawing.

For our purposes, we refer to special functions as a series of keyboard combinations which operate in conjunction with the mouse to perform certain special operations. We also include here a series of options which can be accessed by double-clicking the mouse.
CONSTRAINED MANIPULATIONS

Constrained manipulation of objects upon the drawing surface is restricted to either the horizontal or vertical directions. This means that if the mouse is moved in a general left or right direction when using the lasso or selection rectangle with the Shift key, the Mac will interpret the movement as horizontal. If the mouse progresses in a general up or down direction, this is interpreted as a vertical constraint.

To illustrate constrained movement, we will move the various picnic foods about the surface in constrained horizontal and vertical directions. Return the picnic scene to the drawing surface using the Show Page option. Use the selection rectangle to select the picnic basket. Then, press Shift and drag the picnic basket. Notice that a general up or down movement of the mouse, with an elevation greater than 45 degrees, results in a vertical constraint. A general left or right mouse movement, less than 45 degrees, causes a horizontal constraint. When the mouse is released, the Mac considers the movement to be complete.

Use constrained movement to maneuver the picnic basket about the page. Position the basket in the open space to the left of the tree. Once you have pressed the mouse button and Shift key, the Shift key can be released without affecting the constrained manipulation of the object on the drawing surface.

The lasso is constrained in the same manner. Use the lasso to move the thermos near the picnic basket using constraints. Do the same with the watermelon.

CONSTRAINED DRAWING

Now that we have cleared a working area, we can use constraints to draw the picnic table. The movement of the following tools is constrained when used with the Shift key depressed:
We will now use the paint brush in conjunction with constraints to draw the table top for the picnic scene. Select the paint brush and position it on the drawing surface. Depress the Shift key and drag horizontally to draw a line. This line should be long enough to hold the picnic basket, thermos, and watermelon upon it.

The pencil and spray can operate with constraints in exactly the same manner as the paint brush. We will not elaborate further on these tools.

The line operates somewhat differently than the pencil, paint brush, or spray can when used with constraints. We will use the constrained feature of the line to draw the legs for the picnic table. When used in conjunction with the Shift key, the operator may draw using the line horizontally, vertically, or at a 45 degree angle. Experiment by drawing a line using constraints. Notice that the line jumps in graduations of 45 degrees as the cross hairs pass the halfway points between angles. With the line thickness set to the fourth line and the Shift key pressed, drag the cross hairs so as to draw the table legs at a 45 degree angle. To make both legs symmetrical, draw one, then select, copy, and paste it. Then flip the copy horizontally and reposition it on the table.

Position the table so that all of the items will fit on it. Use the lasso to place each item on the table. Then use FatBits and the pencil to patch the drawing if necessary.

We have nearly completed the scene. The next constraint subject will help finish it. The rectangle, rounded rectangle, and ellipse can be used to constrain squares, rounded squares, and circles, respectively. Here we use the term constrain in that we limit the shape of the figure. Use the constrained ellipse to draw a circular sun over the hill. Now, add the finishing
touches, and the masterpiece is complete. Refer back to figure 6.2 on page 166 for the finished product.

Constraints also apply to the irregular polygon shapes. They follow the same guidelines as did the line. Any shape whose angles are multiples of 45 degrees can be created using these constraints.

SPECIAL FUNCTIONS

The remaining special functions available with the keyboard are illustrated in figure 6.33. In this section we will discuss these special functions and illustrate their uses.

The Option key is used to copy a portion of the document. We will show this function by using the Option key to manipulate a copy of the kite about the page. First select the kite and then press and hold the Option key. The selected portion of the document will be copied as soon as we attempt to use the pointer to move the selection. Use the pointer to drag the selection away from the original. This feature is quite useful when repeated versions of a drawing are required. To create another copy, simply release the mouse, repress the button, and continue to drag the object. We will use this feature extensively in the examples in the next chapter.

To create a copy which is aligned vertically or horizontally with the original, use Option and Shift together. An example of horizontally aligned copying is shown in figure 6.34.
The artist can create echoed images using the Option and Command keys simultaneously. To illustrate this feature, we will spread echoed copies of the sun in the picture across the drawing surface. Select the sun in the sky. Now drag the sun quickly while both the Option and Command keys are pressed. A path of echoed images will be created. The more rapidly the drawing is dragged, the greater the number of images that are generated with greater separation. After you have practiced creating echoed images, be sure to Undo this action to avoid littering the drawing surface. An example of echoed images appears in figure 6.35.

An additional use of the Option key is in conjunction with the line and the shapes. When drawing a line or shape while depressing the Option key, it will appear with the pattern currently selected.
Figure 6.35. Echoed copies

The Command and > keys can be used to change the Font size to the next available option on the FontSize menu. Pressing the Command key with the < key results in the selection of the preceding option in the Font Size menu. The Command, Shift, and > or < keys can be used in a similar fashion to change the Font selection.

Certain MacPaint selections function differently when they are double-clicked. The double-click applications are described below:

- **Selection rectangle**: Select the entire window (This works in an identical manner for the FatBits window)
- **Hand**: Enter the Show Page option
- **Paint brush**: Enter the Brush Shape option
- **Pencil**: Enter and leave FatBits
- **Eraser**: Erase the entire window (This applies to the FatBits window as well)
- **Selected pattern**: Enter the Edit Pattern option
An alternate method of selecting the Undo command is the use of the \ key on the keyboard. The Backspace key can be used to erase images which appear within a selected portion of the drawing surface.

**STRETCHING AND SHRINKING IMAGES**

The dimensions of a selected portion of a MacPaint document can be altered using the Command key. We will illustrate this technique by altering the size of the picnic table. Use the hand to move the scene up on the drawing surface so as to free space for maneuvering. Don’t move the table off the drawing surface. If you are unable to move the images up far enough, the problem may be that the drawing surface lies at the lower limit of the page. Execute the Show Page command and maneuver the images and the drawing surface as desired.

Select the table and move a copy of it to the cleared area. Now, move the rest of the images off the surface and center the copy of the table. Place the pointer in the selection rectangle and drag while pressing the Command key. The image stretches and shrinks with the movement. The alterations are delayed a split second while the Mac recomputes the dimensions.

The placement of the arrow within the selection rectangle plays a crucial role in determining the direction of movement. Placing the pointer near the middle of the right or left side of the rectangle will constrain the alteration to horizontal movement. The opposite sides remain anchored. Similarly, placement near the top or bottom constrains the movement to the vertical direction. If the pointer is in a corner, the image stretches in both directions. Notice that the image can be reversed across the anchored point. The image can be stretched off the surface, but if the mouse is released, the portion will be lost unless Undo is selected. A possible stretch of the picnic table appears in figure 6.36.
The distortion in figure 6.36 becomes apparent as the image is pulled larger. This is because each dot in the original is expanded to spread the image. There are no smoothing marks inserted to make the image appear more continuous. This distortion becomes worse when stretching occurs in only one direction. It may become unacceptably great when expanding intricate patterns.

Alternately, shrinking may cause an image’s fine details to disappear. The artist may, in some cases, be able to draw compensatory markings to reduce this distortion, or he or she may decide simply to redraw the original on a larger or smaller scale.

Figure 6.36. The stretch function
Introduction

This chapter is intended to provide further examples of the techniques which may be used to exploit the versatility of MacPaint. It is recommended that the reader be familiar with the general operations of MacPaint as discussed in the previous chapter. Most MacPaint functions will not be explained in depth here to avoid encumbering the reader with needless details.
The techniques used here are not exclusive in their scope. The reader may prefer to use more basic methods or develop new ones to suit his or her needs. Each example is self-contained and not related to any of the others. The reader may wish to browse through the chapter and pick those examples which best exemplify his or her specific applications.

The emphasis here is not on artistic talent. No freehand drawing skills are required. Anyone can draw diagrams with a professional appearance using the shapes and special functions available with MacPaint.

Each section begins with a short overview illustrating the specific skills covered. A detailed instructive narrative follows to aid the reader in recreating each diagram. Finally, each section contains a short conclusion with comments on alternate methods and a brief review.

The Organizational Chart

The organizational chart is commonly used to illustrate levels of responsibility and authority within a business. Very often, such a chart will be used in a briefing or tour through a company.

This example is designed to provide further practice in the use of reference points as discussed in chapter 6. The diagram will also entail the use of the copy function as well as constrained movement about the drawing surface. It will illustrate methods of entering text into a diagram as well.

INSTRUCTIONS

Figure 7.1 shows the diagram to be developed in this section. This organizational chart is only a small sample of a possible extensive illustration of a business’s hierarchy.
Let’s begin by creating the basic figure we will need repeatedly in the diagram. In order to create the shadowing effect for the boxes, we will superimpose two filled, rounded rectangles slightly offset from one another. The first rectangle is solid black. Draw this figure in the appropriate size.

A precise method of referencing the placement of the shape is the use of a reference point similar to the reference rectangle developed in the previous chapter. Use the hand and click on the upper left-hand corner of the shape. Do not drag the image. Now choose FatBits using one of the methods illustrated previously. Use the line or pencil to extend the sides of the shape to cross at the corner. The intersection is the reference point. Figure 7.2 shows the placement of the reference point.
Now, place a reference point at the opposite corner of the box. Do not use lines this time as we want that corner undamaged. Judge the point placement from the FatBits image.

Using these two reference points, draw two more for the overlaying figure. Move the new references up three dots and left two dots from the first. Choose the solid white pattern with the filled, rounded rectangle and restore the drawing surface. Draw the new shape using the dot inversion technique developed in chapter 6. For easier referencing, draw the shape from the bottom right corner to the top left. Erase the reference dots and return the box corners to their original condition. This is the basic shadowed box which will constitute the majority of the diagram. The result appears in figure 7.3.
Figure 7.3. The shadowed box

Since the creation of this figure was somewhat troublesome, we will use copies of it to complete the diagram. Move the box to a center position high on the drawing surface. Use the lasso together with constrained movement and the copy function (Shift + Option keys) to move a copy of the box about 3/4 of an inch below the original. Then, use the same method to place a copy to the left and right of the newly created box. The result appears in figure 7.4.

The lines connecting the boxes can be easily drawn. Use the line with horizontal and vertical constraints to draw each line. The irregular polygon could also serve our purposes in this case. The diagram is now depicted in figure 7.5.
Figure 7.4. Properly placed boxes

Figure 7.5. Boxes connected with lines
Now we are ready to enter the text portion of the diagram. Select alpha-numeric, set the Font to London, and set the Style to Underline. Also select Align Middle since we want to center the lettering in each box. Now, place the edit bar in the upper middle of the top box and click. The insertion point flashes at that position. Type in:

President

The letters will be displayed center justified with the selected Font and Style. Until the insertion point is moved, the text may be changed or edited. We will need to reset the insertion point for the name since it is displayed with a different Style. Center the point below the title and type the name. The result is depicted in figure 7.6.

Figure 7.6. Text entry
Using the same technique, enter the remaining text in the boxes. Notice that if the text runs over another part of the drawing, the text will supersede the background. The diagram is now complete. A more extensive chart would entail a piece-meal construction by moving the drawing surface from place to place concentrating on one area at a time. The limits to the chart lie solely with the size of the page.

CONCLUSION

Creating this diagram has shown the proper use of reference points to create precise diagrams. More importantly, however, it has demonstrated the role of constraints and special functions in creating presentable illustrations.

The shadowing method detailed here can quickly become tedious and time consuming. The next illustration shows an easier method which is every bit as precise as the one shown here.

The Pie Chart

The pie chart is used to graphically depict proportional divisions of a specific quantity such as a budget as is the case in this example. It should be noted that the data used in this and the next example have no basis in fact. The values were simply invented for the purpose of illustrating text entry methods.

The important techniques used are alternate uses for reference points and lines to achieve shadowing, partitioning of a figure, movement of detailed portions of a diagram, and decorative coloring. Also, we will illustrate data transfer between MacPaint and MacWrite documents.
INSTRUCTIONS

The first step in drawing the basic figure is to determine the reference square. Draw a square whose width is equal to the diameter of the desired circle. Then draw a circle exactly within the square using the dot inversion technique. Now, use the eraser and FatBits to erase all but the upper left-hand corner of the square. Draw a line at 45° away from the corner. We will move a copy of this figure along this line. The diagram should appear as depicted in figure 7.7.

Use the copy function (Option key) and move a copy of the circle up the line until an adequate shadow image remains. This is best accomplished by using the lasso to select the circle plus the square corner and a portion of the line. Figure 7.8 shows the result.

Figure 7.7. Circle with reference line
Since the reference lines are no longer needed, we can erase them. Now we are ready to partition the graph. Since Taxes, Food, and Entertainment constitute fifty percent of the total, we can accurately draw a line splitting the graph in half. First, let’s find the center of the circle. Use the FatBits window to focus on the extreme left portion of the circle where the arc becomes a straight line. Count the number of dots along the straight section. If there is an odd number of dots, start a line from the center point. If there is an even number, start the line from the dot above the center point. Restore the drawing surface and extend the line just past the center of the circle. For the right side, place the line from the dot at or just below the center point. Extend this line just past the center of the circle. Use the same method to draw lines from the top and bottom. The drawing should now appear as shown in figure 7.9.
Notice that the example case contained an even number of dots on the sides. The lines bisecting the circle will not intersect at a single dot but instead form a box cluster of four dots. Erase all of the line but this point or cluster (as your case may be). We have determined the exact center of the circle.

To cut the circle in half, use the line to draw from one edge through the center to the other edge. Be careful not to lose track of the center point. Perhaps it would help to erase the portion of the line residing at the center. Draw in the remaining pie cuts with the proper proportions. You will need to estimate them since MacPaint does not provide an analytical method of calculating the proper sizes. The partitioned graph appears in figure 7.10.

Figure 7.9. Finding the center of the circle
Figure 7.10. Partitioning the graph

Moving the shifted pie cut is accomplished using the lasso with the copy function. Select the lasso and carefully trace around the pie cut. Then, use the copy function to shift a copy of the pie cut away from the center. The result should resemble that shown in figure 7.11.

We have completed the most difficult portion of the diagram. The remaining parts are coloring and text entry. Use lines to sketch in the shadow outline of the shifted pie cut and color each section with a different pattern. One possible combination appears in figure 7.12.
Figure 7.11. Shifting the pie cut

Figure 7.12. Coloring the graph
To enter the data portions shown in figure 7.13, select "A," position the edit bar, and enter the information. Use the line to draw from 5% to its pie cut, and use FatBits to detail the inverted part of the line through the shadow area. Use Align Left for the word "Entertainment," Align Right for "Clothing," and Align Middle for the other portions. The title is underlined and shadowed. Notice that there is no need to make room for the lettering on the patterns.

There is also a text portion of the graph which needs to be added. We would normally add text as we did when labeling the graph, but for this example we will illustrate integration with MacWrite.

Save the MacPaint document, close it, and quit MacPaint. Now, open a MacWrite document. Select the portion to be copied and select Copy or Cut. Close the MacWrite document and reopen the MacPaint document. Position the drawing surface to display the area where the text will appear and select Paste. The box will appear as shown in figure 7.14.

![Figure 7.13. Labeling the graph](image-url)
Clearly, the text is not in a shape which will be convenient for our purposes. This selection rectangle works much as others except that it has a special sizing function. When changing its size, the text conforms, as in MacWrite, to the box dimensions. If the box becomes too small for the text, then the excess will be hidden. When the box is terminated (by clicking elsewhere), the text is fixed and becomes part of the document. Any unshown portions become lost. Shape the text to fit the block next to the graph. The final version appears in figure 7.15.
The graph clearly shows the various expenses that the average household incurs. With many families, however, savings can be as low as 5%.

![Pie chart showing various expenses]

**Figure 7.15.** Completed drawing

It is also valid to predetermine the selection rectangle of the appropriate size, then select Paste. The text will appear conformed to the box.

In order to transfer images from MacPaint to MacWrite documents, use the selection rectangle or lasso to select a part of the picture. Then select Cut or Copy, close the MacPaint document and open the MacWrite document. Place the insertion point just before the diagram's intended position and select Paste. The diagram will begin at the next line after the insertion point. An example is depicted in figure 7.16. Use of the Tall Adjusted mode under the Page Setup window is recommended when printing such a document. Otherwise, elongated drawings are printed.

To move the diagram or alter its size, click in it. The box will appear as shown in figure 7.17.
The graph clearly shows the various expenses that the average household incurs. With many families, however, savings can be as low as 5%.

Figure 7.16. MacWrite document with a MacPaint drawing

Figure 7.17. MacWrite diagram editing box
To move the box right or left, place the arrow on the right or left side of the box and drag. To move up or down, simply insert or delete line spacing. The small boxes along the bottom of the box are used to alter the dimensions of the figure. The right and left boxes are used to stretch or shrink horizontally and vertically, whereas the center box is only used to change shape vertically.

A size altered version appears in figure 7.18. Note the magnified distortion in the graph.

The graph clearly shows the various expenses that the average household incurs. With many families, however, savings can be as low as 5%.

Figure 7.18. Stretched drawing
CONCLUSIONS

This example has demonstrated another method for achieving a shadowing effect in figures. The reference line can be drawn at any angle from the square or, if such precision is superfluous, the reference need not be drawn at all. Simply drag the copy as required, according to your own judgment. Text transfer between MacWrite and MacPaint is also possible using the Note Pad or Scrapbook. These media are more permanent than the Clipboard. Exact proportions on the graph might be accomplished using a protractor on the screen. It should be noted, however, that the same distortion evident while printing a MacWrite document containing graphics not using the Tall Adjusted mode is also apparent on the Mac screen.

The Bar Graph

Bar graphs are another widely used type of graph. These are often used in briefings to illustrate trends or projections over an extended time period.

This section will concentrate mainly on duplication of dimensions using the special functions. Graphs of this nature are normally graduated in uniform lengths. The bars for this graph should be uniform as well.

INSTRUCTIONS

We will begin this graph by drawing the axes. Choose the paint brush and select the extreme bottom left brush shape. This will draw the blocked lines for the axes. Use constrained movement to draw the graph's axes. The result appears in figure 7.19.
Figure 7.19. Graph axes

The horizontal axis will represent the eight years from 1983 to 1990. Place a mark on the axis for the first two years so that all will fit on the line as shown in figure 7.20. Place the paint brush on the spot and click without moving it.

To complete the graduations uniformly, use the lasso to outline the small part of the axis from just before the first mark to just after the second. Now, use constrained horizontal movement with the copy function to move the selection copy right until the first mark of the copy exactly superimposes the second mark of the original. Release the mouse and repeat the process again until there are eight precisely placed marks. Figure 7.21 shows the graduations and the creation of the final mark.
Figure 7.20. First two graduations

Figure 7.21. The graduated axis
The vertical axis will contain three divisions. Use the method described previously to create uniform markings. Label the graduations of the graph by selecting alphanumerics. Enter the numbers shown in figure 7.22. The years are center justified, and the vertical axis numbers are right justified.

To label the vertical axis, use the hand to make room for three lines above the vertical axis. The label appearing in figure 7.23 is Bold and Underlined. Similarly, use the hand to position and place “Fiscal Year” below the end of the horizontal axis.

We are ready to enter the bar graph data. Create a reference rectangle of the width desired for each bar. The height should be about a third of the graph height. Use the open rectangle. A good example appears in figure 7.24.

Figure 7.22. Labeling the graduations
Projected Profit
(Millions of Dollars)

Figure 7.23. Labeling the graph axis

Figure 7.24. The reference rectangle
Now, use the copy function to place one copy of the rectangle on each graduation as shown in figure 7.25.

Since the first reference rectangle is no longer needed, erase it. The series of copies made on the graph axis will determine the width of each bar. Use the filled rectangle to draw the bars at the proper size. Ensure that each one is as wide as the reference. Begin each rectangle just below the surface of the axis so the bottom outline of the rectangle will blend with the axis. Choose a different pattern for each bar. The result appears in figure 7.26. The bar heights will have to be approximated.

To complete the graph, label the bars and erase the excess from the reference rectangles if necessary. The final product appears in figure 7.27.

![Figure 7.25. Placing reference rectangles](image-url)
Figure 7.26. Drawing the bars

Figure 7.27. The bar graph
CONCLUSION

This example illustrates a simple method of drawing a uniform and professional looking illustration. We also moved the drawing surface about the page to accommodate a larger diagram.

A Dimensional Illustration

Another application for MacPaint is the physical diagramming of some machine, tool, or like object. In this example, we will draw an ax with labeled dimensions.

The example will illustrate the use of size alterations to achieve proper proportions. We will also get further practice in drawing a large figure by moving the drawing surface about the page. The use of customized patterns will also appear here along with a discussion of lettering methods to improve presentability.

INSTRUCTIONS

We will begin by creating the ax head. This will cover most of the drawing surface. Rather than drawing the parts free-hand, we will use portions of other shapes.

For the upper and lower arcs, we will use a flat ellipse. Draw an ellipse with the proper arc. Then copy it and move the copy vertically below the first as shown in figure 7.28. If the arc is not correct, you can adjust its size with the selection rectangle and the sizing function.

Now, cut off the top portion of the upper ellipse and the bottom portion of the lower ellipse. Then create a long ellipse to the right side of the drawing surface. The left and right arcs of the ellipse should be appropriate for the cutting edge of the ax. Erase the right half of the ellipse. Then select it and move a copy of it away from the original using the lasso. Position the copy at the left edges of the first two arcs. Select the original of the long ellipse and flip it horizontally. As with the first, place it at the right edges of the first two arcs as shown in figure 7.29.
Figure 7.28. Two ellipses

Figure 7.29. Assembling the individual shapes
To complete the ax head shape, erase the excess of the two arcs on either side. Choose two places about the center of the ax for the handle. Draw straight lines to the bottom of the page. Draw to the bottom of the drawing surface. Then use the hand to push the image up, and continue drawing until you reach the bottom.

At the bottom, we will draw the nub of the handle. Use FatBits in a blank area and draw one half of the shape as shown in figure 7.30. Select a copy of the shape and flip it horizontally. Move the original and the copy into place at the end of the handle. Draw in the gaps in the lines. The result appears in figure 7.31. This completes the ax drawing. The next step is to draw the dimensions.

Use FatBits to create the shape shown in figure 7.32. This will form the end of each dimension line.

Figure 7.30. Detailing the nub of the ax handle
Figure 7.31. Completed ax handle

Figure 7.32. Dimension line end
Figure 7.33. Placement of dimension lines

By now you should be adept at constraints, manipulations, and special functions. Place a copy of the line end in the appropriate places. Then connect the ends with lines. A portion of the figure appears in figure 7.33.

To add clarity to the figure, we will draw dotted lines to some of the line ends. To do this we will customize one of the pattern blocks. Select the Edit Pattern window and set the pattern to that shown in figure 7.34a for horizontal dots or figure 7.34b for vertical dots. Set the Brush shape as shown in figure 7.34c.

Position the paint brush dot and draw the applicable lines. Refer to figure 7.35.
Figure 7.34. Setup for drawing dotted lines.  

*Figure 7.34.* Setup for drawing dotted lines. *a,* Horizontal dotted line pattern; *b,* Vertical dotted line pattern; *c,* Brush shape for dotted lines
Figure 7.35. Drawing dotted lines

Some of the preset patterns would draw dots more frequently. There are several options available for customized dotted or dashed lines as well.

To enter dimensions in vertical lines, place the edit bar exactly on the line using the dot inversion placement technique. Click, then enter the numbers center justified. For the horizontal lines, ensure that the edit bar is bisected by the line, click, then enter the values. To complete the figure, enter a title, centered above the ax. The one shown in figure 7.36 is 24 point, Bold, and Underlined.
Build a Better Ax

Figure 7.36. Completed diagram
CONCLUSIONS

The major difficulty with this example was properly proportioning the ellipses. Sizing helped alleviate the problem. Several attempts may, however, be required to achieve the desired results.

The beauty of the MacPaint software package is in the detailed work which is possible using the FatBits option and the dot inversion positioning technique. Although there were some difficulties with drawing the ellipses, these are far outweighed by the benefits of not having to draw the diagram freehand.

We have illustrated here the use of MacPaint to create an image from simpler constituent parts. This versatility greatly expands the possible figures that can be created.

The Electrical Circuit

The following example is a schematic diagram for an electrical circuit. No knowledge of such circuits is required in order to create the drawing. It is offered simply as another example of piecemeal construction of a diagram from simpler parts.

We will rely on an extensive use of constraints, manipulations, and special functions to accomplish the example. We will also deal with labeling using mixed font sizes, and we will continue to use the FatBits option for detailed drawing.

INSTRUCTIONS

Let’s begin by creating the detailed parts of the diagram. Though we will assign a name to each symbol, do not be concerned as to its function. Figure 7.37 shows the FatBits images of the symbols for the resistor, ground, capacitor, transistor, and contact point.
When building circuits from scratch, it is not often convenient to be as neat and precise as we will be here. However, most techniques used here are quite timely.
Arrange the four resistors in a box connected as shown in figure 7.38. When selecting the resistors, rotate and flip the copies to the desired orientations.

Use the selection rectangle to position a copy of the transistor and draw the lines as shown in figure 7.39. Use FatBits to patch or position the figures if necessary.

Position and connect the remaining components as shown in figure 7.40. Notice that lasso manipulation of the capacitors leaves the background line crossing it. Patch it or use the selection rectangle. Some detailed work is necessary in either case. Also attach the contact points and position the grounds directly below the contact points. Use reference lines if necessary to judge placements.

Figure 7.38. Resistor array
Figure 7.39. Transistor placement

Figure 7.40. Component placement
The cross connection in the center should be bypassed. In order to repair this, draw a small circle slightly larger than the contact point and center it over the crossed connection. Erase the left half of it and redraw the lines as shown in figure 7.41 to give the "jumping over" impression.

The labels are drawn in two parts. The main symbol designation appears in 12 point while all subscripts but those for $V_i$ and $V_0$ are 9 point. Since all subscripts are slightly below the main symbol, they will require separate insertion point placements. For $C_2$ and $R_{bs}$, it may be necessary to create the labels in a more open area and then use the lasso to move them into place. Refer to figure 7.42 for the final version. Incidentally, this circuit is called a bootstrap biased common emitter amplifier.

CONCLUSIONS

This example relied heavily on copying and manipulating component parts of the diagram. The task could have been quite tedious without those functions, but it was almost trivial with them. This concludes the examples using text. The final example discusses a simple method of artistic drawing.
Figure 7.41. Bypass connection

Figure 7.42. Completed circuit
An Artistic Example

This example requires no freehand drawing skills as it utilizes the Grid function to steady the operator's hand. The primary functions illustrated here are the use of the Grid function and the paint can.

INSTRUCTIONS

With the Grid function, draw the following picture. Use the line, open polygon, and/or filled polygon to draw the images. Note that lines may not extend to the extreme border of the drawing surface. They may have to be penciled to the edges. Make sure that the floor and staircase are closed so we can use the paint can without spilling over. All corners of the diagram are grid locations with the exceptions of the flag in the picture and the circle in the iron. Use FatBits for these parts.

Figure 7.43. Initial drawing
The stair railing is created using the line with the third thickness.

To draw the lamp shade, follow the arrows depicted in figure 7.44. Each corner is a grid position.

To complete the example, use the paint can to fill the areas. If there are leaks and the paint spills over, undo the action and plug the holes. Refer to figure 7.45.

One advantage to the Grid function is that movement of portions of patterned areas does not involve problems with matching patterns. One grid block is the size of one Edit Pattern block.

Figure 7.44. Drawing the lamp shade
CONCLUSIONS

This example has introduced a practical use for the Grid function of the Goodies menu. It also explored further uses for the paint can in drawing decorations.
Introduction

With a modem and a communications software package, the Mac is capable of communicating with other computers. The term "modem" is an acronym meaning modulator/demodulator. The purpose of the modem is to interface between the Mac and the telephone system. The Mac processes data formatted in 1's and 0's as we discussed in chapter one. The telephone system deals in audible sounds. The modem's job is twofold. First, the modem must accept instructions from the Mac telling it what to do. These instructions include commands to set data format, answer the telephone, and dial a phone number.
The second task which a modem must perform is to transmit and receive data. In order to accomplish this, the modem must have some scheme for changing the bits into audible tones. This scheme must be mutually agreed upon by both the local modem and the remote modem. If one modem was speaking in one way and the other was speaking another way, each would receive meaningless noise from the other. It would be like an American speaking to a Frenchman. If neither knew the other’s language, communication would be pointless.

Most modems use a technique known as Tone Modulation. Here, the modem will send one predetermined tone when sending a “0” and a different tone when sending a “1.” On the receive side, the modem will relay a “0” to the computer when it receives one specific tone and a “1” when it receives another specific tone. As long as there is mutual agreement between the two modems as to the interpretation of each tone, communication should run smoothly.

There are two types of modems which have been used extensively for computer communications. These are acoustic and direct connect modems. Acoustic modems are designed to connect with a standard telephone. An acoustic modem incorporates a cradle which is designed to hold a telephone handset securely. The modem’s speaking and receiving units use the telephone as a person does. Signals are sent through the talking portion of the phone and received through its listening portion. An acoustic modem is depicted in figure 8.1.
The disadvantages to an acoustic modem are that it is susceptible to noise interference both from within the room in which it is used and from the telephone handset itself. Also, the modem cannot be instructed to pick up the phone on its own. An operator must be present to transfer the handset to the modem. The modem will require use of a dedicated telephone when it is in use. This may cause inconvenience for the operator. If the operator’s telephone handset is incompatible with the modem, the connection may be impossible. For these reasons, the acoustic modem is generally considered obsolete.

Many of the difficulties encountered with acoustic modems can be avoided by using a direct connect modem. This sort of modem was designed to be a stand-alone unit. The modem which we will use in this chapter for our examples is a direct connect modem made by Hayes Microcomputer Products, Inc. This modem is compatible with many computer...
systems including the Mac. Figure 8.2 depicts a Hayes direct connect modem. The unit contains its own microprocessor so that it can operate the telephone line according to the instructions received from the computer. Since the modem does not rely upon the operator to lift the phone when making or receiving a call, the modem can perform these actions itself electronically.

Direct connect modems solve many of the problems encountered with acoustic modems. They are not as susceptible to interference as their predecessors. They can operate the telephone without assistance. This means that the modem can be operated remotely with no operator present as long as the modem is left on and the computer is set up in advance. The direct connect modem can remain permanently connected to the phone line. This eliminates the need to dedicate another telephone for the modem's use. The modem also does not require a physically compatible telephone receiver.

Figure 8.2. Direct connect modem
One disadvantage of the direct connect modem is that many business telephone systems do not allow for extensions with modular receptacles. Installing a modem in this situation may require special wiring considerations.

As with all other computer functions, the Mac must be told exactly what to do to establish communications and relay data. This requires a program generally known as an emulator. To emulate is to mimic something in every way. A terminal emulator will cause the computer to act as if it were a computer terminal. The program which the Mac uses to link with other information systems is called MacTerminal™. This software, released by Apple in the summer of 1984, was designed to take advantage of the Mac's visual interface ideology.

In many cases, MacTerminal removes the need for the operator to actually deal with the special instructions to the modem. Instead, the operator simply sets the system parameters from the various menu options. MacTerminal will interpret the options and send the appropriate commands to the modem. The program will also see that the data gets to the modem through the proper interface port.

OVERVIEW

In this chapter we will discuss the equipment and software needed to set up a communications link between the Mac and various other information sources. We will begin with a discussion of the hardware involved. There are several modems which may be used with the Mac for communications. We will explore the MacTerminal program and see how to use the menu options.

Then, we will continue with a discussion of communications with the various available data base services, followed by an example of modem communications with the IBM PC XT®.
Communications Equipment

Most modems used in computer communications require a serial interface to connect to the computer. This fits in well with the Mac since it is designed to use serial interface equipment exclusively. The modem which Apple distributes for the Mac comes in two models. The first model operates at 300 baud. The baud rate is an indication of the speed at which the modem transmits data. One baud is about one bit per second of data transfer. The other, more advanced Apple modem can operate at 300 and 1200 baud. The 1200 baud rate is usually advantageous when transferring large quantities of information. Due to lack of availability, we will not utilize the Apple modem for our examples. The Apple modem should operate much the same as the Hayes modem which we will use here.

THE HAYES MODEM

As noted above, the modem which we will use for this chapter is the Hayes direct connect modem. It operates as the Apple modem does and is offered in 300 or 300/1200 baud models. We will use the 300 baud model. The Hayes modem requires a separate electrical connection and uses a power converter to change the normal 120 VAC from the wall socket to 3.5 VAC needed to power the modem. The modem also requires a cable adapter to connect with the Mac. The cable adapter is available at most computer and electronics stores. It is designed to mate the Mac's 9-pin connections with the Hayes modem's 27 pin connection. Although the latter connector is much larger, the Hayes modem uses only 6 pins. Therefore, no special wiring is necessary to connect the modem.

Follow the installation instructions accompanying the modem and connect it to the Mac. The instruction manual for
the modem lists the various settings for the Dual Inline Package (DIP) switches which are located behind the modem's front panel. Adjust these settings as they pertain to your needs. To activate the Hayes modem, locate the small toggle switch in the back of the modem. Flip it to the up or "on" position, and the modem's LED display lights should shine. These lights indicate the following conditions:

- **MR** — Modem ready
- **TR** — Terminal ready
- **SD** — Send data
- **RD** — Receive data
- **OH** — Off hook condition
- **CD** — Carrier detected
- **AA** — Auto answer mode

The MR lamp is always lit when the modem is turned on. If it is not lit, either the lamp is burned out, or the modem is not functioning properly. The TR lamp is normally always lit except under special conditions which are described in the operations manual for the modem.

The SD and RD lamps indicate similar conditions. They light whenever the modem is sending (SD) or receiving (RD) data. These lamps become important when you wish to monitor the data transfer process.

When making or receiving a call, the modem must set the telephone in the **off hook** condition. You do this manually whenever you lift the telephone receiver. When the modem sets the phone to the off hook condition, the OH lamp will light.

When the modem makes a communications link with another modem, it sends a constant signal through the telephone line. The opposing modem does the same. This constant signal is called a **carrier**. When the modem receives the carrier from the other side, the CD lamp will light indicating that a
link has been made. The carrier is the basis for all telecommunications. In order to relay information, the carrier is \textit{modulated}. That is, it is altered in some predetermined pattern. In our case this modulation is via a series of tones as described previously.

The Auto Answer light could be lit for one of two reasons. Of course, it will be on when the modem is in auto answer mode. That is, the modem will answer the telephone without any specific instructions. To enter this mode, either set DIP switch number 5 to the up position or enter the command AT S0=1.

The lamp will also light momentarily when the phone is ringing to indicate an incoming call.

\textbf{MacTerminal}

The MacTerminal software package enables the Mac to utilize a modem and communicate with another computer. The name describes its primary function. The application is designed to turn the Mac into a computer terminal. At the time of this writing, the official version of the MacTerminal application had not yet been released. Our examples are based upon a prerelease version which is very close to the final product. For this reason, the following discussion may vary slightly from your experience with the MacTerminal application.

Basically, MacTerminal operates in a manner similar to other applications used on the Mac. When the application is opened, the software will create a document. In the case of MacTerminal, the document is a place where information will appear as it is received from the modem and, in most cases, as it is entered into the computer for transmission. When under the application, all characters entered onto the MacTerminal document will be sent to the modem via the serial communications port on the Mac's back panel.
In general, information is sent out as strings of characters in the standard ASCII format. The American Standard Code for Information Interchange (ASCII) is the standard information coding format used throughout the communications industry. A listing of the standard ASCII codes appears in Appendix A. When communicating in this manner, the Mac may speak to nearly any other computer.

THE MACTERMINAL DOCUMENT

Before continuing our discussion of MacTerminal, let's access the application. Locate the diskette which contains the desired application and insert it into the Mac. Open the disk's icon and find the MacTerminal applications icon as depicted in figure 8.3.

![MacTerminal icon](image)

**Figure 8.3.** The MacTerminal icon

Open the icon. After about 25 seconds, the display appears as shown in figure 8.4. The display includes the items which should be quite familiar to you by now:

- Menu bar
- Close box
- Title bar
- Scroll bar
- Size box
Figure 8.4. New MacTerminal document

ESTABLISHING A COMMUNICATIONS LINK

For the communications example, we will assume that you have access to a Hayes 300 baud modem and the MacTerminal software, and that you can access the telephone system. It is also necessary that you have a list of the phone numbers for any remote computers which you wish to contact. We will also assume that the Mac is configured with the modem connected and turned on, and that the MacTerminal document appears on the Mac screen.
THE SETTINGS MENU — TERMINAL SETTINGS

The first step is to set the various parameters within the Setting menu. Select Terminal from the Settings window. The window, shown in figure 8.5, appears on the Mac display. The window shows the default settings which will appear when the new MacTerminal document is created. Any settings made through the Settings windows will be saved along with the MacTerminal document.

The first item in the window, Terminal, sets the type of terminal which the Mac will emulate. Normally, all characters sent by any type of terminal are in the ASCII code. The special characters, however, may not be sent by a certain terminal type. These characters might include commands sent using the Command, Option, Enter, Tab, or Shift keys. VT100™ normally deals with all of these characters. Teletype (TTY) emulation, on the other hand, deals in few, if any, of these. The proper choice for your application of MacTerminal depends solely upon the requirements and capabilities of the remote computer.

The next setting, Compatibility, determines the other types of terminals with which the Mac will communicate. Many of the various data coding formats are compatible with those terminal formats which the Mac can emulate. The American National Standards Institute (ANSI) data format and the VT52™ format are both compatible with the VT100 format. That is, when MacTerminal is set for VT100 emulation, the Mac can communicate with a computer which recognizes the VT100, VT52, or ANSI format. The other options with the Terminal item have different compatibilities. The compatibilities which are not available in each case will be dimmed when that option is selected.
When the MacTerminal document first appeared, it was empty except for the flashing line in the upper left-hand corner. This line is the **cursor**. Although the cursor is not normally used with the Mac, its counterpart, the insertion point, should be familiar to you. When typing on the MacTerminal document, all characters will appear at the cursor’s position. Likewise, characters received from the remote computer will appear at the cursor. To change the cursor from an underline to a flashing block, select the Block option under the **Cursor Shape** item.

Certain characters are often used exclusively by one nation. For example the French language uses accents in writing which are not used in English. The United Kingdom character set is an available alternative to the United States character set under the **Character Set** item. With this character set, the # character is replaced with the £ symbol.
With the **Line Width** option, the operator has the capability of expanding the MacTerminal document to a width of 132 columns or leaving the width at the default value of 80 columns. With the 132 columns choice, the horizontal scroll bar becomes active so that the operator can view the entire MacTerminal document.

The **Protocol Converter** item is used when the Mac is communicating with other data processing devices through the AppleLine® or Apple Cluster Controller®. These devices are designed to allow the Apple equipment to communicate with IBM main frame compatible computers.

The remaining selections of the Terminal Settings menu address the format of the MacTerminal document. When the “X” appears in the box next to the selection, the item is selected. When the box is empty, the item is unselected. When the first item, **On Line**, is unselected, the Mac will be operating in a Local mode. That is, the computer will not be in communication with the modem. Characters typed into the keyboard will appear on the local Macintosh display only.

When the **Local Echo** item is selected, the document will be in Local mode whether it is On Line or not. Thus, the characters will appear on the Mac display as they are typed in. If the remote computer does not echo characters back to the Mac, this item will need to be used.

The **Status Lights** item refers to the indicator lights which can be displayed above the MacTerminal document. Check this item and select **OK** in the Terminal Settings window. Immediately below the title bar appears a group of indicators which provides pertinent information to the operator. When the circle to the right of the indicator title is black, the indication is true. When the circle is hollow, the indication is false.
Figure 8.6. Status Lights*

Notice in figure 8.6 that the On Line indication is true. This tells the operator that the Mac is passing information to the modem. When off line (On Line is false), the terminal is not communicating with the remote computer. The communications link will be broken. This is useful when allowing a first-time MacTerminal user to experiment with the document.

The Local indication can refer to the Local Echo mode of the document. When the modem is sending data, it does not normally repeat the characters back to the user. Therefore, when sending data, the user will not see what he or she types on the MacTerminal document unless the remote computer can echo the characters it receives back to the Mac. When the application is in Local Echo mode, the Local indicator will become true, and characters will appear on the document as they are typed.

When the modem is not transmitting data but is accepting instructions, it will repeat those instructions back to the user. If the document is in the Local Echo mode during these periods, each character will appear twice on the document.

The Local indicator will also change to true when the On Line setting has been disabled. When this occurs, the On Line indicator will be false.

* We have condensed this display due to size limitations.
At some time during operation under the Handshake protocol, the Keyboard may become locked. That is, characters typed into it will be ignored. If this occurs, the Kbd Locked indicator will revert to true. If you wish to enter characters into the MacTerminal document and the keyboard is locked, unlock the keyboard by selecting Unlock Keyboard from the Commands menu.

The indicators L1 thru L4 are used when the Mac is emulating the popular Digital Equipment Corporation (DEC™) VT100 terminal type. They indicate information concerning the status of the terminal.

Return to the Terminal Settings window at this time so that we may review the rest of the items within. Normally, when typing onto the document for any Mac application, the Mac will repeat characters if a key is pressed and held. With the MacTerminal document, this feature is controlled by the Auto Repeat item. When it is turned off, characters will not repeat if a key is held down.

One important feature with the MacWrite document was the Wraparound function. When a line extended to the right margin of the document, the characters were wrapped around to the next line. Although the MacWrite Wraparound function placed an entire word on the next line, the MacTerminal document will Wraparound the characters individually when the Auto Wraparound item is selected. When unselected, the characters past the right margin of the document will overwrite the last character in the line.

When the New Line item is selected, the cursor will line feed to the next line in the document when the Return key is pressed. In other words, with New Line selected, pressing the Return key will generate both a Return and a Line Feed character. Otherwise, the cursor will return to the first column of the same line it was on.
The **Repeat (Rpt.) Controls** item allows you to determine whether the control characters will repeat if the keys are pressed and held. This option is not available if Auto Repeat is not selected. Control characters are non-printing characters such as Return and Tab.

Notice, in figure 8.5, that the **Transparent** item is dimmed. This item is only available with the TTY terminal mode. When it is selected, the non-printing characters such as Backspace (BS), Carriage Return (CR), and Line Feed (LF) will appear as printed characters upon the MacTerminal document.

When all Terminal Settings have been made to the desired specifications, select OK and the window will disappear with the new conditions saved. Selecting Cancel here will remove the window with the new conditions not saved.

**COMPATIBILITY**

The next item in the Settings menu is Compatibility. The window shown in figure 8.7 will appear when the Compatibility item is selected from the Setting menu. These settings determine the format of the data stream flowing to and from the modem. Each one of these settings should be mutually agreed upon by both the local and remote computer in order to insure coherent communications.

The term **Baud Rate** has appeared before in this chapter. The baud rate which should be selected for each application depends upon the needs and capabilities of the modems and the computers involved in the communications link. Select 300 baud for our application with the Hayes modem. The 1200 baud choice is the default value.
The MacTerminal application can deal with either seven or eight bits per character. The proper choice depends upon the remote computer.

Handshaking is a more advanced concept which many computers are using today. With this communications method, the computer on either end of the link will not transmit data until the other unit signals that it is ready to receive data. The Mac can also tell the remote computer to temporarily cease data transmission with this technique. Without this feature, the computer assumes that the other computer is always ready to receive data. Thus, data may be lost if the remote computer is not ready to receive. Select XOn/XOff for the Handshake option for the Mac. Select None if the remote computer does not use this feature. Handshaking is unnecessary at data rates less than 1200 baud.
The MacTerminal emulator may be used with the Mac under many configurations. These do not necessarily involve the use of the modem or the telephone system. If you are connecting the Mac to another data source via direct cable connection, select Another Computer under the Connection item. If you use a modem, allow the setting to remain Modem. Selecting Another Computer will cause the Phone menu to be dimmed as it is not needed under this application.

Since both the Phone Port, , and the Printer Port, , on the Mac's back panel use the standard RS-232 specification, they are both equipped to handle the modem. To direct the Mac's attention to the printer port for the modem connection, select from the Connection Point option. At the time of this writing, the use of the printer port was not yet implemented into the software. Although we cannot comment from direct experience, Apple Corp. has recommended that you refrain from using the printer port for communications. It is not designed for extensive, bi-directional data transfer and will not function at data rates exceeding 1200 baud.

When all Communications settings are correct, select OK from the window. Select Cancel to negate the new settings.

FILE TRANSFER

Selecting File Transfer from the Settings window will cause the window, shown in figure 8.8, to appear. Through this window the operator may set the parameters of the file transfer conditions.
With XM Modem set in this window, the Mac can transfer any sort of file to the remote computer. The Text choice will allow only text files, i.e. MacWrite or MacTerminal documents, to be sent. The Text mode will not allow drawings to be sent. Through this window the operator may indicate whether communications are with a MacTerminal equipped computer or not. MacTerminal may be used either with the Mac or with a Lisa using the MacWorks adaptation software. Only ASCII strings may be sent to any computer not using the XModem transfer method.

The operator may specify a delay between transmission of characters or lines in this window as required by the remote computer. This might be required if the remote computer cannot accept large amounts of consecutive data.

The last two items in this window refer to the format of the transferred data. When Retain Line Breaks is selected, the Mac will record the Return characters at the ends of the text lines received from the remote computer. When the data is to be transferred into a MacWrite or similar document which does
not normally end each line with a Return character, this option should not be selected.

When the next item, *Word Wrap Outgoing Text*, is selected, the outgoing text will follow the MacWrite word wraparound protocol. Words which fall at the end of a line will be repositioned so as to not split them. With this option not selected, individual characters will wrap around to the next line.

When the settings within the window are proper, select OK. The window will disappear with the changes recorded. Otherwise, select Cancel to remove the window with the changes not retained.

**ANSWERBACK MESSAGE**

Some computers request a message when another computer establishes a communications link. This message often is used by private computer services to identify the user or the user's computer. To enter a message into the Mac, select Answerback Message from the Settings menu. The window shown in figure 8.9 will appear.

Most computers requiring this feature specify that the message in the window must be entered with the same beginning and ending character. A greeting message might be: xHellox. Select OK from this box to set the message.

![Answerback Message window](image)

**Figure 8.9.** Answerback Message window
SHOW TAB RULER

When dealing with the MacTerminal document, locally entered data or data coming from the remote computer will often contain tab characters. This might occur when transferring tables of numbers over the communications link. The designers of MacTerminal included a Show Tab Ruler item in the Settings menu. This enables MacTerminal to use the tab characters to properly format tables. Selecting this option will cause the ruler shown in figure 8.10 to appear.

Figure 8.10. The Tab ruler

Normally, the tabs are preset every eight columns beginning at the ninth column. This setting is a standard used by most computers. For other situations, the tabs may be reset on this ruler. To remove a tab, click on its marker. To create a new tab, place the pointer over the desired position on the Tab ruler and click.

To return to the MacTerminal document, pull down the Settings menu again and select Hide Tab Ruler. The ruler will disappear and the Mac will remember the new settings of the tab markers.
PHONE MENU — PHONE SETTINGS

Now that all communications settings have been properly made, we are ready to make contact with the outside world. The Phone menu is depicted in figure 8.11. Pull down the Phone menu and select Phone Settings. The window, depicted in figure 8.12, will appear. The purpose of this window is to record the telephone number which the modem will call to contact the remote computer. It is also used to set the dialing conditions for the modem.

Enter the number of a computer service into the blank. As with many other Mac menu windows, the blank will appear with the previous number highlighted if it already contains an entry. The majority of the telephone systems today have been converted to touch tone service. To instruct the modem to dial the phone number using tones, select Tone from the Dial item. If you are in an area which uses the rotary dial pulse system, select Pulse. These two will be the most prevalent cases.

If, however, you are in an area where a mixture of tones and pulses is required, MacTerminal can accommodate this as well. Entering a T into the phone number sequence will instruct the modem to use tones. A P will indicate rotary pulses. To enter a mixed dial instruction into the Phone Settings window, simply insert a T or P in the appropriate position in the number sequence. The modem will change modes at the specified point.

![Figure 8.11. Phone menu](image)
A mixed sequence might appear like this: T9,P(812)555-1212. The comma indicates a pause in the dialing sequence. This is useful when using a business phone where you need to dial for an outside line and then pause before entering the rest of the number. The parentheses and dash are ignored by the modem. You may enter them for convenience.

Since the modem will change modes as many times as instructed, the Mixed choice in the Dial item is optional. If you do not choose Mixed, the Mac will send a mode instruction, either Tone or Pulse, to the modem before beginning the operator-entered sequence. This may be changed, as discussed earlier, by including the T or P character in the number sequence.

The next item in the Phone Settings window determines the number of times which the phone will be allowed to ring before the modem will answer an incoming call. It is normally set to three rings. Setting it to zero will disable the modem’s answer function.

The last item identifies the modem type which the Mac is using. Select Apple 300 if the Mac uses the Apple or Hayes 300
baud modem. Select Apple 1200 if the Mac uses the Apple or the Hayes 1200 baud modem. With any other type of modem, select Other.

Let’s try an example. We will assume that you are contacting the computer installation at a local college. Enter the number into the Phone Settings window and select OK. Pull down the Phone menu and select Dial.

The speaker on the Hayes modem should become active, and you should be able to hear the modem dial the number. The speaker will remain active while the telephone rings. When the phone is picked up by the remote computer, you will hear a high pitched tone. This is one of the tones which computers use to identify themselves over telephone lines. Then, if all goes well, there will be another tone. The speaker should become inactive at this point and the Mac should display a message indicating that it has contacted another modem. The message “Connect” should appear on the document. The last message was sent to you by your Hayes modem indicating that it had contacted another modem and is ready to relay data.

What you have contacted at this point may or may not be another computer. It is entirely possible that you have only contacted a network relay center which handles several computers. Although the exact entry procedures may vary from case to case, you will first have to enter an identifier for the specific computer which you wish to contact. Then you will have to enter an identification code into the computer along with a password. These codes are intended to protect both your files in the remote computer and that computer from illegal entry.

We have yet to discuss the remaining two items which appear in the Phone menu. When we have completed the communications session, we will select Hang Up. The Mac will instruct the modem to hang up the phone and terminate the link.
Selecting **Wait For Call** causes the Mac to display a window indicating that it expects an incoming call. This window will remain on the display until it senses the phone ringing or until you select **Cancel** from the window.

**EDIT MENU**

At this point you may have enough text on the screen to cover about half of the display. If not, you may have had trouble with one of the **Settings** menu items. For instance, the **New Line** setting may not be set properly. Once you have some text to work with, you can try out the **Edit** menu items. Since all data on the document appears on both the local and remote computer displays, there can be no **Cut** or **Clear** options for the document. The **Cut** and **Clear** command will remain inactive unless you use the **Edit** menu with the Desk Accessories. The **Edit** menu items appear in figure 8.13.

![Edit Menu Diagram]

**Figure 8.13.** Edit menu
To select a portion of the MacTerminal document, use the same method used with the MacWrite document. Place the edit bar at the beginning of the text you wish to select and drag to the end of the section. The text will become highlighted. You may now select Copy from the Edit menu. Now that the text is on the Clipboard, you may paste it onto the Apple menu file or an application's file. Closing the MacTerminal document will not terminate the communications link. When you return to the document, everything will be as before, if you have saved the document.

The Copy Table item is used when transferring a table from the MacTerminal document to another application's document. The Mac will substitute a tab character for the spaces between columns when copying the table to the Clipboard.

You may also use the Paste command to place the text upon the document. Copy a portion of text from another file to the Clipboard. Now return to the MacTerminal document and select Paste from the Edit menu. The Paste command will result in the text being placed upon the document and sent to the remote computer.

If you wish to transfer the entire document to the Clipboard, choose the Select All item. Then select Copy to place the text upon the Clipboard. Choosing the Show Clipboard item will cause the Clipboard to appear displaying the text copied there. Select Hide Clipboard to return to the MacTerminal document. The Select All item is also used when printing the entire MacTerminal document using the Print Selection item under the File menu. This will appear in detail later in the chapter.

As always, the Undo command can be used in many cases to negate the action last taken with the document.
The Commands menu contains several items which control the MacTerminal document and the local computer. Pull down the Commands menu. The first item listed should be Don’t Record Lines Off Top. When this item is selected, the entries onto the MacTerminal document will disappear as they scroll off the top of the display. Pulling down the Commands menu again will reveal the command Record Lines Off Top. Selecting this item will return the document to the initial mode. The Mac will retain the lines which scroll off the top of the display.

We will assume at this point that you have been communicating with the remote computer. You will notice that the document scrolls upward beyond the top of the Mac’s display. The portion which is remembered beyond the top of the display is called the “Off Top” portion of the document. The Off Top portion of the document is delineated from the display portion by the dotted line which appears at the top of the display (see figure 8.4).

To remove the lines stored Off Top, select the Clear Lines Off Top item in the Commands menu. This may be necessary when communicating for extended periods of time where the document becomes too large to hold within the Mac’s RAM. The Mac will display the window, shown in figure 8.14. Select Yes to complete the operation. Pressing the Return or Enter keys substitutes for selecting No in this window. You may wish to save this document before erasing the Off Top portion.

The next item in the Commands menu is Reset. Selecting this option will clear the display portion of the document. It will also cause the Settings menu items to return to the settings held when the document was opened or last saved. The Off Top portion of the document will remain intact. The Mac will display another message which is depicted in figure 8.15. Selecting Yes will instruct the Mac to complete the operation.
When we discussed the Handshake concept, we said that the Mac can send a signal to the remote computer to stop it from sending data. When Handshaking is in effect, the Stop Scrolling command will send that message. To continue sending data, pull down the Commands menu and select Start Scrolling.

If the Mac receives a Stop Scrolling instruction from the remote computer, the keyboard will become inactive. That is, the keyboard will become locked. The Kbd Locked status light will become true if the status lights are displayed. To release the keyboard, select Unlock Keyboard from the Commands menu.
FILE MENU

For the most part, the File menu for the MacTerminal document behaves as it has for every other Mac application. Figure 8.16 shows the File menu items. The operator can create a new document with the New command and can open an existing document with the Open command. The Close, Save, Save As, and Quit commands also work as you have come to expect.

If you wish to have a selected portion of the MacTerminal document output to the printer, use the Print Selection item in the File menu. To print the entire MacTerminal document, use the Select All item in the Edit menu before selecting Print Selection. Try this with the document you have created.

![File menu diagram](image)

Figure 8.16. File menu
Selecting the **Send File** item will cause the window shown in figure 8.17 to appear. This window is similar to the Open window used with the MacWrite and MacPaint applications. This window will display the files of the type listed in the File Transfer settings window which are available on the present disk. Select one for transfer by double clicking the file name or by clicking the file name and then clicking Open. If the file appears on another disk, select Eject and insert the proper disk. To return to the document with no action taken, select the Cancel option.

The **Receive File** item instructs the Mac to prepare to receive a document from the remote computer. This option is only available when the Transfer Method in the File Transfer Settings window is set to XModem and the Remote System is set to Other. When Receive File is selected, the box, depicted in figure 8.18, will appear.

The received file will not appear on the MacTerminal document. Instead, it will be directly written to the disk. Enter the name which the file will assume on disk into the blank and select Receive. The Mac will display a message box informing you that it is waiting for incoming data. When the data begins to flow, the Mac will display the number of blocks of data which have been received at each point in the transfer.

![Figure 8.17. Send File window](image)
The final MacTerminal menu, Keypad, differs from the others in that it is used to enter characters onto the document rather than give commands or set parameters. Pull down the Keypad menu. The result appears in figure 8.19. What you see here is an image of a keypad like the numeric keypad which you may have attached to your Mac. Drag the pointer to a button on this keypad and release the mouse button. This action is the same as if you had actually pressed that button on the numeric keypad. Although this may not seem more convenient than pressing the actual buttons, if you do not have the numeric keypad, you may need the Keypad menu to use the special functions PF1 thru PF4.

Now, press the Command key and pull down the Keypad menu. Figure 8.20 shows that the keys PF3, PF4, dash, and comma have been replaced by cursor control keys. Selecting one of these arrows will allow you to move the cursor about the MacTerminal document. Consequently, it also controls the cursor on the remote computer’s screen. If you do not have the numeric keypad, this is the only means by which you can manipulate the cursor on the document.
Figure 8.19. Keypad menu

Figure 8.20. Keypad menu with Command key pressed
In order to illustrate the final keypad menu display, we will need to alter the Terminal Settings window. Access this window and select IBM 3278. With this mode, the Mac emulates a standard IBM main frame terminal. Select OK from this window and pull down the Keypad menu again. Figure 8.21 shows the result. These functions are available for use with the IBM compatible computer.

![Keypad menu with Terminal IBM 3278](image)

**Figure 8.21.** Keypad menu with Terminal IBM 3278

For now, we have finished using the computer link. With most large computer facilities, when you log off the computer, it will terminate the communications link for you. If this does not occur though, select **Hangup** from the Phone menu. The Mac will instruct the modem to terminate the telephone link.

**KEYBOARD EQUIVALENTS**

Most standard computer keyboards feature special function keys which are not used on the Mac. When using MacTerminal, the following keys are used to substitute for the special functions:

- Control = Command
- Escape = ~ (tilde)
- Break = Enter
Data Base Communications

Another popular use for telephone communications between computers is data base access. A data base is composed of one or more computers, usually large main frames, which can be accessed by multiple subscribers who use the data base service to obtain various sorts of information. This includes information on stock prices, journals and periodical articles, scientific abstracts, credit information, and current and past news. Virtually any type of information can be obtained from data base services. Data bases are also used by their subscribers to contact each other through a computer network.

Once you have subscribed to a data base service, the data base company will open an account for you on their computer system and send you the access codes needed to utilize your account. They also will send information on how to use the various services which are available.

We will illustrate using a data base service to write the current news on the Mac display. The procedure for accessing an account may vary from case to case, but in general it proceeds as follows. Configure the Mac with the modem and open the MacTerminal document. Be certain that the Settings menu items are set up in accordance with the requirements for the data base computer.

Select Dial from the Phone menu. The modem will make the connection as it did the previous example. Usually your access is not directly with a computer but with a network facility such as Tymnet or Telenet. These services act as clearing houses to connect thousands of subscribers with their intended computer services.

Next enter the identifier for the computer service you wish to contract. That data base service will give you the proper code. Once you have connected with the proper computer, enter your account ID code and your password. The password is important since it protects your account from illegal entry.
An example of the entry procedures for a data base appears in figure 8.22.

@ATDT555-1212
CONNECT
TELENET
216 13U
TERMINAL=d1
@c 30147

30147 CONNECTED
Connected to THE SOURCE
> id c99999
Password?
CL9999 (user 51) logged in Tuesday, 10 Jul 84 16:44:20.
Welcome, you are connected to THE SOURCE.
Last login Tuesday, 10 Jul 84 15:52:56.

(C) COPYRIGHT SOURCE TELECOMPUTING CORPORATION 1984.

Figure 8.22. Accessing a data base

Once you have accessed your account, you can utilize the services available to you through the data base. To access the daily news, you would follow the procedures outlined by the data base service. The Mac can be thought of as a terminal connected to the computer. The commands you type into the
Mac's keyboard will be entered into the data base computer. The data base computer will treat those commands as if you had entered them directly.

One important function offered by most data base services is the **keyword search**. Once the search is initiated, the computer will search the files you specify for the occurrence of some keyword which you also specify. Then the computer will report on the number of files in which it found the word. You then have the option of displaying one or more of those files (newspaper articles, magazine articles, or abstracts) on the Mac screen. Since the Mac stores the entire document, you can save the information on the MacTerminal document or transfer it to another application's document. With the Handshake function, you can use the Stop Scrolling command to instruct the data base computer to wait, if you need to copy information, before it completes the file transfer. This applies only if the data base computer uses Handshaking.

Once you have finished with the data base, you will exit the account by entering a terminating command. The "Off" entry is a prevalent command for exiting a computer account. Upon logging out of the computer, you will be returned to the computer network facility. From there you may access another computer if you wish, or you may hang up. Select Hangup from the Phone menu. The link will be broken, and the modem will be returned to the command mode of operation.

**Communication with the IBM PC XT**

Communication links between individual personal computers are widely used. In our example, we will illustrate a link between the Mac and an IBM PC XT. Since most terminal emulators use the ASCII communications format, the Mac may be connected with any computer which contains the proper hardware and software.
For this example, we will assume that the remote computer is calling the Mac. This situation is the reverse of our previous two examples. We will also assume that the IBM PC XT utilizes an emulator for which we have configured the Mac. Set up the Mac as before and select **Wait For Call** from the Commands menu. The modem will wait for an incoming call. The modem will answer the phone and send out the tones required to establish the connection.

Once the Connect message has appeared on the Mac display, the IBM PC XT is on line with the Mac. Any characters entered on the MacTerminal document will also appear on the IBM PC XT's display. Conversely, any characters entered into the PC XT will appear on the MacTerminal document. Normally, this sort of communications link is only capable of data transfer. The remote computer usually controls only the displayed characters of the local computer. You probably will not be able to open and edit the remote computer's files through such a link.

Let's transfer a file to the remote computer. There are two methods which may be used to transfer data files. The first is to write the file on the MacTerminal document; the second is to use the Send File item in the File menu. To use the first method, save and close the MacTerminal document. Open a document which you wish to transfer, a MacWrite document for instance. Use the Copy command of the Edit menu to put the desired text on the Clipboard. This allows you to transfer only a part of a file instead of the entire file. Reopen the MacTerminal document and select Paste from the Edit menu. The text should appear on both the local and remote computers' screens.

The second file transfer method involves using the Send File item of the File menu. Select this item, and the available documents will appear. Select the desired file, and the Mac will accomplish the transfer. The file will not appear upon the MacTerminal document. Instead, the Mac will display a box, such as the one depicted in figure 8.23, informing you of the
progress of the data transfer. You may terminate the transfer at any point. The data will be lost, however, if the remote computer is not prepared to accept it. The availability of the documents which may be transferred depends on the settings of the File Transfer window under the Settings menu.

Figure 8.23. Sending a file

You may wish to connect The Mac with another personal computer such as the IBM PC XT using the modem but not the telephone. The Hayes modem is capable of this configuration. Connect the modems back to back as shown in the Hayes modem manual. As an example, instruct the Mac to dial the PC XT. The modem will dial the number and wait for an answer. Since there is no ringing, the IBM PC XT's modem will not automatically answer. Enter "ATA" into the PC XT. This is a direct modem command forcing it to answer the telephone. The modems will connect normally.
Conclusion

In this chapter we have discussed Macintosh communications. We defined the term and reviewed some examples of it. We have used the Hayes 300 baud modem to connect the Mac with two large computers and another personal computer. In the process of doing this, we have learned about the MacTerminal emulator application. Since the final version of MacTerminal was not completed at the time of this writing, there may be some slight discrepancies between our discussion and your experience. However, the general principle is the same. The application is designed to enable the Mac to mimic a standard computer terminal.

There are many other uses for communications with other computers. Some banks allow you to do business with them over this type of link, for instance. You can access airline ticket reservation computers to inquire about and book flights. As the communications industry grows, you will be able to access more and more information from your home or office through this powerful medium.
Introduction

This chapter will provide some basic troubleshooting hints which the Mac operator may find useful. For the most part, the Mac will display messages when something goes wrong with the hardware or software. Most system error messages allow the operator to restart the system or allow the operator to correct the problem, if it is simple, before continuing operation.

Malfunctions with the Mac can be broken down into two categories:

- Hardware problems
- Software problems
The solution to the first category is simple. Either the Mac is not connected together correctly, or some internal part is broken. Of course, if the former problem occurs, you can solve it easily. If an internal Mac part is broken, the owner should take it to an authorized dealer and have it repaired. We do not recommend that you attempt to repair the Mac.

This chapter includes hints on troubleshooting Macintosh hardware and software problems. This will include problems with the:

- Display
- Disks and disk drive
- Keyboard
- Mouse
- Printer

The Mac computer hardware is quite durable so many of these problems may never occur. The software within the system may be the source of problems during normal operation. Since the software must manage all of the computer's resources, it is very complex. Such complexity is difficult or even impossible to perfect.

The system programming which is included with your Mac is the end result of many man-years of programming time. The resulting work has undergone extensive testing and should operate with no trouble. However, Apple computer engineers are constantly working to improve the software. As a result, updated versions are released on a fairly regular basis. Be certain that all software included in your system was created under the same version of the operating system. Mixing files from one version to another may cause undo problems.

To determine the version for the system, return to the Finder and select About the Finder from the Apple menu. This information can be determined for an application by choosing the same option from the same menu after the application has been chosen.
The Mac Display

By far the largest single component in the Macintosh is the display. The rectangular display on the front of the Mac main system unit is in reality the face of a large vacuum tube. In this age of high technology where most vacuum tubes are obsolete, we have yet to find an adequate replacement for the standard picture tube.

In order to create a display, the tube shoots a beam of electrons at the display screen which is covered with a phosphorous material. To aim this beam, the tube uses a cluster of magnets which steer the electrons as they pass through their magnetic fields. All this hardware requires a variety of high voltages which the Mac generates from the electricity it receives. The circuitry for these voltages resides along the left side of the Mac system unit. We recommend that you refrain from placing anything containing liquid upon the main unit. Any leakage through the vents in the top could cause extensive damage to the Mac.

Once the Mac has been properly installed, turn on the main unit. The power switch is located on the right side of the back of the main console. The switch is labeled with a “I” and a “0” that represents the conditions of “on” and “off,” respectively.

When the Mac is first powered on, it should emit a short tone. The screen will remain blank while the picture tube warms up. After a few seconds, a display will appear. If not, check to see that the unit is properly plugged into a wall socket. The intensity control may be set too low for a display. The control is located on the left side of the Mac’s face immediately below the Apple logo. To turn up the intensity, turn the dial clockwise. If there is still no display, the owner should contact an authorized repair service.
Disks and Disk Drives

The Mac uses diskettes to store and recall large amounts of information. This technique is required because the computer has only a limited amount of built-in memory. In addition, each time the computer is turned off, the major portion of the memory is erased. Only about one third of the system's memory is "permanent," but this portion is reserved for the use of the computer. This situation requires the use of diskettes to establish a stable means of storing information.

The Macintosh is designed to operate with a custom version of the Sony 3½ inch diskette. Each diskette is housed within a hard plastic covering. The disk drive records as well as reads information from the surface of the diskette. These types of diskettes differ from the more commonly used "floppy disks" in three major ways. First of all, Mac diskettes are more efficient since they offer more than twice the data storage on a smaller surface. Also, the plastic cover on Mac diskettes makes them more durable. Finally, Mac diskettes are more accurate because they have a metal center that allows the drive to hold the diskettes securely. Each diskette is capable of storing about enough information to fill 150 double spaced, typed pages.

Since the disks are essentially a magnetic means of recording information, disks can be erased by magnetic fields. Therefore, diskettes should always be stored in a safe place. Virtually all electrical equipment (including the Mac) generates stray magnetic fields. Therefore, never keep diskettes near electrical appliances or telephones.

The durable construction of the Mac's disks makes them very reliable. They can be handled, dropped, or written upon without harming the magnetic medium within. At some point during normal operation, you may find that the Mac will not accept a certain disk. This sort of error is usually referred to as a system error and requires that the system be restarted. This problem is most likely not due to a physical defect in the disk.
The Mac has probably damaged the software information on the disk making it impossible to read.

One possible remedy for this problem is as follows. Restart the system using a functioning disk. Then eject the disk and insert the faulty disk. As the disk drive begins to read the disk, press and hold the Option and Command keys. This key combination obliges the Mac to reinitiate the disk and read the files on it.

Files on the disk are often organized into groups. A grouped collection of icons is known as a folder. See figure 1.9b. The folder does not, in itself, represent any data. It is simply a holding place for other icons. When performing the above procedure, the Mac will probably erase all folders, except the Empty Folder, leaving the icons held within them on the disk window. The files represented by these icons have not been damaged. If desired, the operator can reorganize these icons into folders.

When naming documents, it is a good practice to name each document so that its folder can be identified. This aids the Mac user is reorganizing documents into their respective folders should these folders be erased.

**DISK FILE RECOVERY**

Whenever a computer uses a disk storage medium, there is a chance that the disk will become faulty making data inaccessible. The Mac does not provide a normal procedure for retrieval of information from such a disk. However, there is a special procedure to follow which should give the desired results.

This method appears to work for recovering MacPaint documents. However, it should be used only as a last resort, and only if the previously described method fails. The Mac was specifically designed to give complete disk handling control to the computer. If the operator forces disk ejection at an improper moment, he or she might cause enough damage to the disk's data to make it completely unreadable.
Access MacPaint on a system disk. Close the present document and choose Open from the File menu. Select Eject and insert the faulty disk. If the disk’s documents appear, then select the one you wish copied. At this point, the Mac will request disk switches a few times as it loads the file. Finally, the document appears within the MacPaint display with the system disk inserted.

The task here is to fool the Mac into thinking one disk is present while another actually is present. Use an unbent paper clip or similar object to “punch out” the system disk using the following procedure. Insert the paper clip into the small pin hole to the right of the disk slot. Press in until the disk ejects. Do not attempt to eject a disk while the disk drive is running. The pin hole is shown in figure 9.1.

Figure 9.1. Disk ejection hole
Now, insert the bad disk and select Save As from the File menu. The Save As dialogue box will appear. The message “Save current document as” may not be displayed, or it may be displayed as a group of garbled characters. Select Eject from the dialogue box and insert the system disk. Notice that the dialogue box remains on the Desktop. Enter a new filename in the space provided in the dialogue box or keep the old one and hit Enter or Return, or select Save. The document will appear on the system disk. Be sure the document does not have the same name as another on the system disk. Only one file at a time can be copied using this procedure.

After the Save As command, there is a good chance that the Mac will display a system error message. All is not yet lost, however. At this point, punch out the bad disk again and reinser the system disk. Choose Restart from the system error box. If all goes well, the system will restart and two files will appear on the system disk labeled “Paint1” and “Paint2.” These contain the information for the transferred document. It is, however, in an inappropriate form. To properly format it, open the MacPaint application icon. A new document will appear entitled “rescue.” This document will be the transferred file. Upon closing the document, the Mac will treat it as a new file and ask the appropriate questions. When we have returned to the Finder, you will see that the two Paint files are replaced by the transferred document with the name entered.

You may try variations on this procedure with the following guidelines. First, never try to punch out the disk if the disk drive is running. Second, do not be too surprised if some action causes the disk to become unreadable, and it has to be reinitialized.
The Mac Keyboard

If the keyboard on the Mac malfunctions, there is little the operator can do but contact an authorized dealer. There are, however, some precautions which can prolong the life of the keyboard. First we would reiterate that you should never eat or drink around any computer equipment. The keyboard is especially susceptible to damage from spilled food or drink. Any matter which falls between the keys can become lodged there hindering the keystroke action. Any liquids which fall on the keyboard will seep in and can cause electrical malfunctions.

The second precaution is to try to use the softest possible key touch. The keys are quite sensitive and require very little pressure to sense each keystroke. The keys operate by making an electrical contact each time a key is pressed. Striking a key too hard may cause the electrical contacts to age prematurely. On the whole, however, the keyboard is durable and very reliable.

Taking Care of the Mouse

The Macintosh mouse should be cleaned at regular intervals to avoid damage to the internal moving parts. First remove and clean the mouse ball and its retaining ring as shown in figure 9.2. Then blow out any debris lodged in the ball cavity. Use cleaning fluids on the mouse sparingly. To clean the rollers on the inside of the mechanism, use a cotton swab slightly moistened with alcohol or cleaning fluid. Never use water to clean the mouse as this may damage the internal circuitry. Reassemble the mouse after it is clean.
Figure 9.2. Cleaning the mouse

The Imagewriter Printer

The printer designed for use with the Mac is a complex and versatile machine. If you want to delve deeply into its operation you should review the owners manual which came with it. The applications available for use with the Mac at present do not allow the operator to take advantage of the special control codes for the printer.

There are a series of switches and settings within the Imagewriter printer which must be preset properly to insure normal operation. The Imagewriter should have been set up at the factory. If not, you should take it to the dealer for adjustment.

When using the Imagewriter printer, you may find that it is not an entirely friendly machine. To begin with, the paper will curl severely if left in the paper feed for just a few hours.
Also, the printer generates a considerable amount of noise especially when printing repeated patterns such as lines or MacPaint images. The construction of the printer is such that the paper must lie behind the unit upon the connecting cables. This not only increases the space the printer utilizes, but also it does not allow the paper to lie flat. This could cause paper feed problems.

The only suggestion we have to remedy the first problem would be to unload the paper feed when the printer is not in use. The latter two problems could be solved with a covered printer stand sold at many computer supply stores. This would help dampen the noise and would allow the paper to reside below the stand.

Outside of the normal MacWrite and MacPaint print sequence, there are only two printer operations* which you can perform on the Mac. The first is to print the active window. If the Command, Shift, and 4 keys are pressed simultaneously, the printer will output the window which is presently active. If there is no print job in action, the active window will be printed.

The second print command is similar to the first. Pressing the Command, Shift, Caps Lock, and 4 keys will cause the printer to print the entire Mac screen display. While the Mac is sending the printer the print data, the screen will freeze. Note that such items as the pointer, MacPaint tools, and menu titles are not part of an active window and will not appear in the printout unless Caps Lock is depressed.

---

* At the time of writing this book the Macintosh programming languages, Macintosh BASIC and Pascal, have not been published. They will probably enable the Mac user to exercise more direct control over the printer.
Maintenance on the printer is simply a matter of changing the ribbon and clearing paper faults. Lubrication is required only once a year or so. The ribbon should have a relatively long lifetime. When the output becomes too faint, it should be replaced. Remove the ribbon by pushing back the ribbon cassette retaining tabs and lifting the cartridge. Installation instructions are listed in chapter 2.

The Imagewriter printer is very reliable and rarely develops problems with the paper feed. If a problem should occur, turn off the machine immediately and remove the covers. Remove any torn paper and reload the feed mechanism. Reinstall the covers and restart the printer. It may recommence printing if the print sequence was not complete. Allow the printer to complete the sequence before attempting to continue.

If the printer runs out of paper, the PAPER ERROR light will shine. To print the last few lines of a page, repeatedly press the SELECT button until the page is complete.

The printer only uses its preprogrammed character set when printing text in draft mode. Otherwise, it will print in accordance with the Mac's instructions. To self test the output by printing the character set, turn off the machine. Then, press the FORM FEED button while turning the printer on. The printer will type the character set until you turn the printer off again.

Only a few areas on the Imagewriter need to be cleaned and oiled. The printer should be cleaned every few months or as needed if it is heavily used. Turn off the printer and remove the paper cover toward the rear of the machine. Locate the PAPER ERROR switch. Its position is shown in figure 9.3.
Use a soft brush to remove any dust and debris which might be lodged within the mechanism. Reassemble the printer.

The print head should also be cleaned periodically. To remove it, turn off the printer, and remove the large carrier cover over the print mechanism. Locate the two metal retaining tabs on either side of the print head near the platen. Figure 9.4 shows their positions. With your thumb, press the tabs outward to release the print head. Grasp the print head and pull up with a firm, steady force. Press the roller shaft back to allow clearance for the print surface. It should require about as much force as it takes to remove a plug from a wall socket. Do not force it or use any tools. Excessive force may damage the print head.
Figure 9.4. Print head retaining tabs

As with the PAPER ERROR switch, remove any dust or debris from the print head and reinstall it. Be sure that the electrical contacts are properly aligned before pressing the print head into its socket. The two positioning posts should also align into their sockets on the print head. Reassemble the printer for use. Note that the printer will not function while the carrier cover is removed.

The only lubrication required on the printer is a once a year oiling of the carrier bar on which the print mechanism moves. Locate the felt ring below the print head as shown in figure 9.5. Place a few drops of machine oil on the ring. Be sure to use a light oil which does not contain rust inhibitors. Be careful not to put oil on any other parts of the printer.
If the Imagewriter malfunctions and you are not able to discern the cause or trouble, check to see that the Mac is sending the proper information. To do this, first insure that the cables are securely plugged into the backs of both units. If there is no problem with the cables, check the character set as described above. If the printer operates normally, the problem may be with the Mac’s software. Otherwise take the printer to an authorized Apple representative.

Some Additional Hints

Most computers feature a special set of commands which control the operation of the unit. The Mac is very limited in that respect. You have already reviewed the use of the Command and Option keys to oblige the Mac to read a disk whose
software is damaged. There are a few other such commands which perform similar functions. The validity of these options depends upon the version of the system you have. Some functions may not work while some additional ones may be included on your Mac.

When using the Backspace key, deleted characters are transferred into a special memory space which can be called the Backspace buffer. To unload this buffer and print out the deleted characters, press the Command key while pressing Backspace. The characters will appear in the reverse of the order they were deleted. This function is useful when using MacWrite. If you incorrectly typed the word “Mac” and wanted to delete it and place it elsewhere, simply backspace through the word. The letters will be loaded into the Backspace buffer in reverse order, “caM.” When you reach the point where the word should appear, press Command and press Backspace three times. The word will appear.

The combination Command! (or Command, Shift, 1) will override the computer system and cause the Mac to eject the disk in the main disk drive. Although this option may be useful, it may have a drawback if used unwisely. If a document resides in computer memory and the operator wants to keep it, he or she will have to ensure that it is saved before ejecting the disk and turning off the Mac. The normal procedure for exiting an application and ejecting the disk is designed to give the operator the option of saving the document.

Entering the keystrokes Command# (or Command, Shift, 3) will cause the Mac to create a MacPaint document, called Screen 0, which holds a copy of the display on the Mac screen at the time the command is entered. Each successive repetition of the command will create a like document entitled Screen 1, Screen 2, and so on. The MacPaint application need not be present on the disk for the document to be created. Of course, to access the document, MacPaint is required.
Command $ (or Command, Shift, 4) and Command, Shift, Caps Lock, 4 have been reviewed previously on page 304. On some operating systems, the instruction Command ~ will cause the Mac to abort the application presently operating. Be certain you save any documents before using this option.
### Appendix A. ASCII Codes

In the following table, each of the ASCII codes recognized by the Mac is listed with its corresponding character. Since the Mac uses 8 bit bytes, 256 (0-255) characters are available. Characters 0-127 are relatively standard for most computers. The remaining characters are not consistently assigned for all fonts.

<table>
<thead>
<tr>
<th>Code</th>
<th>Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>NUL</td>
</tr>
<tr>
<td>1</td>
<td>SOH</td>
</tr>
<tr>
<td>2</td>
<td>STX</td>
</tr>
<tr>
<td>3</td>
<td>ETX</td>
</tr>
<tr>
<td>4</td>
<td>EOT</td>
</tr>
<tr>
<td>5</td>
<td>ENQ</td>
</tr>
<tr>
<td>6</td>
<td>ACK</td>
</tr>
<tr>
<td>7</td>
<td>BEL</td>
</tr>
<tr>
<td>8</td>
<td>BS</td>
</tr>
<tr>
<td>9</td>
<td>HT</td>
</tr>
<tr>
<td>10</td>
<td>LF</td>
</tr>
<tr>
<td>11</td>
<td>VT</td>
</tr>
<tr>
<td>12</td>
<td>FF</td>
</tr>
<tr>
<td>13</td>
<td>CR</td>
</tr>
<tr>
<td>14</td>
<td>SO</td>
</tr>
<tr>
<td>15</td>
<td>SI</td>
</tr>
<tr>
<td>16</td>
<td>DLE</td>
</tr>
<tr>
<td>17</td>
<td>DC1</td>
</tr>
<tr>
<td>18</td>
<td>DC2</td>
</tr>
<tr>
<td>19</td>
<td>DC3</td>
</tr>
<tr>
<td>20</td>
<td>DC4</td>
</tr>
<tr>
<td>21</td>
<td>NAK</td>
</tr>
<tr>
<td>22</td>
<td>SYN</td>
</tr>
<tr>
<td>23</td>
<td>ETB</td>
</tr>
<tr>
<td>24</td>
<td>CAN</td>
</tr>
<tr>
<td>25</td>
<td>EM</td>
</tr>
<tr>
<td>26</td>
<td>SUB</td>
</tr>
<tr>
<td>27</td>
<td>ESC</td>
</tr>
<tr>
<td>28</td>
<td>FS</td>
</tr>
<tr>
<td>29</td>
<td>GS</td>
</tr>
<tr>
<td>30</td>
<td>RS</td>
</tr>
<tr>
<td>31</td>
<td>US</td>
</tr>
<tr>
<td>32</td>
<td>SP</td>
</tr>
<tr>
<td>33</td>
<td>!</td>
</tr>
<tr>
<td>34</td>
<td>&quot;</td>
</tr>
<tr>
<td>35</td>
<td>#</td>
</tr>
<tr>
<td>36</td>
<td>$</td>
</tr>
<tr>
<td>37</td>
<td>%</td>
</tr>
<tr>
<td>38</td>
<td>&amp;</td>
</tr>
<tr>
<td>39</td>
<td>'</td>
</tr>
<tr>
<td>40</td>
<td>(</td>
</tr>
<tr>
<td>41</td>
<td>)</td>
</tr>
<tr>
<td>42</td>
<td>*</td>
</tr>
<tr>
<td>43</td>
<td>+</td>
</tr>
<tr>
<td>44</td>
<td>,</td>
</tr>
<tr>
<td>45</td>
<td>-</td>
</tr>
<tr>
<td>46</td>
<td>.</td>
</tr>
<tr>
<td>47</td>
<td>/</td>
</tr>
<tr>
<td>48</td>
<td>0</td>
</tr>
<tr>
<td>49</td>
<td>1</td>
</tr>
<tr>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>51</td>
<td>3</td>
</tr>
<tr>
<td>52</td>
<td>4</td>
</tr>
<tr>
<td>53</td>
<td>5</td>
</tr>
<tr>
<td>54</td>
<td>6</td>
</tr>
<tr>
<td>55</td>
<td>7</td>
</tr>
<tr>
<td>56</td>
<td>8</td>
</tr>
<tr>
<td>57</td>
<td>9</td>
</tr>
<tr>
<td>58</td>
<td>:</td>
</tr>
<tr>
<td>59</td>
<td>;</td>
</tr>
<tr>
<td>60</td>
<td>&lt;</td>
</tr>
<tr>
<td>61</td>
<td>=</td>
</tr>
<tr>
<td>62</td>
<td>&gt;</td>
</tr>
<tr>
<td>63</td>
<td>?</td>
</tr>
<tr>
<td>64</td>
<td>@</td>
</tr>
<tr>
<td>65</td>
<td>A</td>
</tr>
<tr>
<td>66</td>
<td>B</td>
</tr>
<tr>
<td>67</td>
<td>C</td>
</tr>
<tr>
<td>68</td>
<td>D</td>
</tr>
<tr>
<td>69</td>
<td>E</td>
</tr>
<tr>
<td>70</td>
<td>F</td>
</tr>
<tr>
<td>71</td>
<td>G</td>
</tr>
<tr>
<td>72</td>
<td>H</td>
</tr>
<tr>
<td>73</td>
<td>I</td>
</tr>
<tr>
<td>74</td>
<td>J</td>
</tr>
<tr>
<td>75</td>
<td>K</td>
</tr>
<tr>
<td>76</td>
<td>L</td>
</tr>
<tr>
<td>77</td>
<td>M</td>
</tr>
<tr>
<td>78</td>
<td>N</td>
</tr>
<tr>
<td>79</td>
<td>O</td>
</tr>
<tr>
<td>80</td>
<td>P</td>
</tr>
<tr>
<td>81</td>
<td>Q</td>
</tr>
<tr>
<td>82</td>
<td>R</td>
</tr>
<tr>
<td>83</td>
<td>S</td>
</tr>
<tr>
<td>84</td>
<td>T</td>
</tr>
<tr>
<td>85</td>
<td>U</td>
</tr>
<tr>
<td>86</td>
<td>V</td>
</tr>
<tr>
<td>87</td>
<td>W</td>
</tr>
<tr>
<td>88</td>
<td>X</td>
</tr>
<tr>
<td>89</td>
<td>Y</td>
</tr>
<tr>
<td>90</td>
<td>Z</td>
</tr>
<tr>
<td>91</td>
<td>I</td>
</tr>
<tr>
<td>92</td>
<td>\</td>
</tr>
<tr>
<td>93</td>
<td>]</td>
</tr>
<tr>
<td>94</td>
<td>^</td>
</tr>
<tr>
<td>95</td>
<td>_</td>
</tr>
<tr>
<td>96</td>
<td>`</td>
</tr>
<tr>
<td>97</td>
<td>a</td>
</tr>
<tr>
<td>98</td>
<td>b</td>
</tr>
<tr>
<td>99</td>
<td>c</td>
</tr>
<tr>
<td>100</td>
<td>d</td>
</tr>
<tr>
<td>101</td>
<td>e</td>
</tr>
<tr>
<td>102</td>
<td>f</td>
</tr>
<tr>
<td>103</td>
<td>g</td>
</tr>
<tr>
<td>104</td>
<td>h</td>
</tr>
<tr>
<td>105</td>
<td>i</td>
</tr>
<tr>
<td>106</td>
<td>j</td>
</tr>
<tr>
<td>107</td>
<td>k</td>
</tr>
<tr>
<td>108</td>
<td>l</td>
</tr>
<tr>
<td>109</td>
<td>m</td>
</tr>
<tr>
<td>110</td>
<td>n</td>
</tr>
<tr>
<td>111</td>
<td>o</td>
</tr>
<tr>
<td>112</td>
<td>p</td>
</tr>
<tr>
<td>113</td>
<td>q</td>
</tr>
<tr>
<td>114</td>
<td>r</td>
</tr>
<tr>
<td>115</td>
<td>s</td>
</tr>
<tr>
<td>116</td>
<td>t</td>
</tr>
<tr>
<td>117</td>
<td>u</td>
</tr>
<tr>
<td>118</td>
<td>v</td>
</tr>
<tr>
<td>119</td>
<td>w</td>
</tr>
<tr>
<td>120</td>
<td>x</td>
</tr>
<tr>
<td>121</td>
<td>y</td>
</tr>
<tr>
<td>122</td>
<td>z</td>
</tr>
<tr>
<td>123</td>
<td>{</td>
</tr>
<tr>
<td>124</td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>}</td>
</tr>
<tr>
<td>126</td>
<td>~</td>
</tr>
<tr>
<td>127</td>
<td>DEL</td>
</tr>
<tr>
<td>128</td>
<td>Ä</td>
</tr>
<tr>
<td>129</td>
<td>Å</td>
</tr>
<tr>
<td>130</td>
<td>Ç</td>
</tr>
<tr>
<td>131</td>
<td>Ð</td>
</tr>
<tr>
<td>132</td>
<td>Ñ</td>
</tr>
<tr>
<td>133</td>
<td>Ö</td>
</tr>
<tr>
<td>134</td>
<td>Ü</td>
</tr>
<tr>
<td>135</td>
<td>á</td>
</tr>
<tr>
<td>136</td>
<td>à</td>
</tr>
<tr>
<td>137</td>
<td>â</td>
</tr>
<tr>
<td>138</td>
<td>a</td>
</tr>
<tr>
<td>139</td>
<td>à</td>
</tr>
<tr>
<td>140</td>
<td>á</td>
</tr>
<tr>
<td>141</td>
<td>ç</td>
</tr>
<tr>
<td>142</td>
<td>é</td>
</tr>
<tr>
<td>143</td>
<td>è</td>
</tr>
<tr>
<td>144</td>
<td>è</td>
</tr>
<tr>
<td>145</td>
<td>ë</td>
</tr>
<tr>
<td>146</td>
<td>í</td>
</tr>
<tr>
<td>147</td>
<td>ì</td>
</tr>
<tr>
<td>148</td>
<td>ñ</td>
</tr>
<tr>
<td>149</td>
<td>ñ</td>
</tr>
<tr>
<td>150</td>
<td>ñ</td>
</tr>
<tr>
<td>151</td>
<td>ó</td>
</tr>
<tr>
<td>152</td>
<td>ò</td>
</tr>
<tr>
<td>153</td>
<td>ô</td>
</tr>
<tr>
<td>154</td>
<td>õ</td>
</tr>
<tr>
<td>155</td>
<td>ò</td>
</tr>
<tr>
<td>156</td>
<td>ú</td>
</tr>
<tr>
<td>157</td>
<td>û</td>
</tr>
<tr>
<td>158</td>
<td>û</td>
</tr>
<tr>
<td>159</td>
<td>ú</td>
</tr>
</tbody>
</table>
Appendix B. Warning Boxes

Introduction

This appendix reviews some of the warning boxes which might occur during normal operation. Each example features a caption explaining the condition which might cause the warning.

File Opening Warnings

Those items can't all be opened at once.

Cause: Trying to open too many icons at once. The Mac can only perform one function at a time.

Can't open any more windows.

Cause: Attempting to open too many windows on the Desktop.
An application can't be found to open this file.

OK

Cause: Attempting to open a document for which there is no application present.

Disk File Copy Warnings

Replace items with the same names with the selected items?

OK  Cancel

Cause: Attempt to place a file on a disk which already has a file of that name.

That folder can't hold the selected item(s).

OK

Cause: Attempt to place a folder within a folder of the same name.
The disk is full.

OK

Cause: Attempt to place a file upon a disk with insufficient free storage space.

The disk copy didn't work. Try copying to a different disk.

OK

Cause: Data transfer error during disk copy.

The disk is so full that the folder changes couldn't be recorded.

OK

Cause: Insufficient disk space to properly record disk file copy. Does not indicate a file copy error has occurred.
Disk Manipulation Warnings

Repairing this disk. All folders were lost; their contents have moved back to the disk window.

Cause: Software error on a newly inserted disk.

A disk can only be moved by itself.

Cause: Attempting to move multiple disk icons simultaneously.

That name is too long. Use a name shorter than 64 characters (27 for applications and disk names).

Cause: Attempt to name a disk (or any other icon) with a name which is too long.
Internal Memory Warnings

There is not enough memory to work with another disk.

Causes: Attempting to place too many disk icons on the Desktop.

There is not enough memory to eject the system disk. Please dispose of a dimmed disk and try again.

Causes: Ejecting the System disk with internal memory nearly full.

There is not enough memory to remember this disk. Its image will disappear from the desktop.

Causes: Ejecting an Alternate disk with internal memory nearly full.
Warnings Involving Erasure or the Trash Icon

Are you sure you want to throw away a system file?

OK  Cancel

Cause: Attempt to move a system file to the Trash icon.

That item is locked or in use, and can't be removed.

OK

Cause: Attempting to discard an item which is locked or in use.

That is the startup disk; it can't be erased.

OK

Cause: Attempting to erase the System disk.
Index

A
Acoustic Modem see Modem
Active window see Window
Active window lines see Window
Alarm Clock see Desk accessories
Alternate disk see Disk
Apple menu see Menus
Apple modem see Modem
Apple Lisa 15, 22
Application 16
   Disk Copy 105-106
   Font Mover 107-110
   MacPaint 161-254
   MacTerminal 262-292
   MacWrite 123-160
Application disk see Disk
Application file 27
Artistic example 252-254
ASCII 263, 265, 273

B
Backspace see Keys
Backup disk 103
Bar graph 231-238
BASIC 27, 28
Baud 26, 260
Bit 18

C
C (programming language) 27
Calculator see Desk accessories
Caps Lock see Keys
Clicking 56
Clipboard 83, 84
Close box see Window
Command see Keys
Communications 26
Constraints 203-207
Control Panel see Desk accessories
Controlling Slot 114
CP/M 12
CPU 18
CRT 19, 31, 297
Cursor 266
Cut sheet see Paper

D
Data base 288-290
Data disk see Disk
Desk accessories
   Alarm Clock 93
   Calculator 96
   Control Panel 97-98
   Note Pad 95
   Puzzle 99
Desktop 46
Dimensional illustration 238-246
Direct connect modem see Modem
Directory 55
Disk 20, 298
* alternate disk 113
* data disk 110
* application disk 113
Disk Copy see Application
Disk drive 20
Document 27, 28
* MacWrite 124-141
* MacPaint 162-187
* MacTerminal 263-270
Dot inversion technique 174
Double-clicking 56
Dragging 54
Drawing surface 165

E
Edit menu see Menus
Eject 49
Electrical circuit 246
Emulator 259
Enter see Keys

F
File menu see Menus
Finder 13, 43-99
Fonts see Menus
Font Mover see Application
Format see Menus
Formatting 103
FORTRAN 27
Friction feed system 38

G
Goodies menu see Menus
Grid coordinate 190

H
Handshake 271

I
IBM PC 13-15
IBM PC XT 290-292
Icon 46, 50-57
Trash 45
Imagewriter 16, 24-25, 36-39, 303
Initialization 103-104
Insertion point 57, 81, 126, 143-144, 266
Installation 32-42

K
Keyboard 16, 22, 33-34, 47-48, 302
Keys
* Backspace 146
* Caps Lock 47
* Command 22, 47, 143
* W/ MacTerminal 287
Enter 22, 47
* W/ MacTerminal 287
* Option 22, 47
Keyword search 290

L
Lisa see Apple Lisa
Literate operating system 12
Lockup 112

M
MacPaint see Document, see also Menus
MacTerminal see Document, see also Menus
MacWrite see Document, see also Menus
Main console 33
Menus
* Apple 68, 154
* Commands 281
* Edit
* System 80-87
* MacWrite 154-155
* MacPaint 188
* MacTerminal 279
File
  System 49, 69-79
  MacWrite 154
  MacPaint 201
  MacTerminal 283
Fonts 158
Format 157
Goodies 190
Keypad 285
Phone 276
Search 155
Settings 265
Special 91
Styles 158-160
View 88-91
Microprocessor 18-19
Modem 16
  Acoustic 256
  Apple 40-42, 260, 277-278
  Direct Connect 257
  Hayes 260-262
Modulation 262
Motorola 68000 see microprocessor
Mouse 16, 23, 34-35, 302
MS-DOS 12

N
Note Pad see Desk accessories
Numeric key pad 16, 26, 40

O
Operating system 12 see also Finder
Operations disk 110
Option see Keys
Optional disk drive 25, 40, 112-113
Organizational chart 214-220

P
Palo Alto Research Center 15
Paper 37-38, 152
Pascal 27, 28
Pie chart 220-231
Pin feed see Paper
Pixel 19
Printer see Imagewriter
Puzzle see Desk accessories

R
RAM 19
Random access 21
Read/write head 20
Ribbon 36-37
ROM 19

S
Scrapbook 92
Scroll bars see Window
Search menu see Menus
Select 81, 144-146
Sequential access 20
Size box see Window
Special functions 207-211
Special menu see Menus
Startup diskettes 43
Styles menu see Menus
System disk 16, 43, 113
System file 27
System unit 16-22 see also Main console

T
Tab Ruler 275
Tone Modulation 256
Trash see Icon

V
View menu see Menus
Visual operating system 13 see also Finder

W
Winchester disk drive 21-22
Window 55, 58-67
  active window 58
  changing 59-61
  active window lines 58
  close box 56
  moving 62
  scroll bars 59
  scrolling 62-67
  size box 59, 62
Write protect hole 115
X

Xerox Star 15
XModem 273
ABOUT WEBER SYSTEMS, INC.

In 1982, Weber Systems Inc., a software and systems consulting firm based in Cleveland, Ohio, started a publishing division specializing in books about personal computers. Weber Systems initially published three books. Within a year, their list included eighteen titles. Over twenty more titles are scheduled for publication this year.

The books in the USER'S HANDBOOK series provide clearly presented and immediately useful information about microcomputer hardware and software products. They are created by an editorial staff with extensive experience in computer science, technical writing, and the practical uses of personal computers. The basic tenets of the Weber Systems publishing philosophy are quality, timeliness, and maintenance.
Other Books in This Series
Published by Ballantine Books:

APPLE IIe USER'S HANDBOOK
COLECO ADAM USER'S HANDBOOK
COMMODORE 64 USER'S HANDBOOK
COMPAQ USER'S HANDBOOK
EPSON PRINTER USER'S HANDBOOK
IBM BASIC USER'S HANDBOOK
IBM PC & XT USER'S HANDBOOK
IBM PCjr USER'S HANDBOOK
KAYPRO USER'S HANDBOOK
LOTUS 1-2-3 USER'S HANDBOOK
VIC-20 USER'S HANDBOOK
APPLE MACINTOSH' USER'S HANDBOOK

The design of Apple Computer's new Macintosh is based on years of research into how people really work with computers. The Macintosh's dramatic technological innovations and powerful applications software put truly exciting and useful computing into the hands of the general public for the first time.

The APPLE MACINTOSH USER'S HANDBOOK provides clear, concise, and complete instructions so that even novice users will feel comfortable using this sophisticated and powerful microcomputer. The book also contains a wealth of advanced information and documentation that will appeal to the most experienced users.

The HANDBOOK is a complete guide to the operation of the Macintosh and the most popular software packages that have been designed to work with it. The following topics are covered in detail:

- Hooking up and beginning to operate the Macintosh
- Disk Handling
- Word Processing with MacWrite
- MacPaint Graphics
- and MacTerminal Communications
- Installing and operating the Imagewriter printer

The APPLE MACINTOSH USER'S HANDBOOK is a valuable reference tool and workbook for every owner or potential user of the Macintosh personal computer.

Computers/Machine Specific